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1

Product comparison
HP Color LaserJet CM4730 MFP

The HP Color LaserJet CM4730 MFP is the base model, and comes standard with the following items:
●

100-sheet multipurpose input tray (tray 1)

●

Three 500-sheet input trays

●

Automatic document feeder (ADF) that holds up to 50 pages

●

HP Jetdirect embedded print server for connecting to a 10/100Base-TX network

●

256 megabytes (MB) of random access memory (RAM)

●

Duplexer

●

Hard drive

HP Color LaserJet CM4730f MFP

2
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The HP Color LaserJet CM4730f MFP has the same features as the base model and includes an analog
fax accessory.

HP Color LaserJet CM4730fsk MFP

The HP Color LaserJet CM4730fsk MFP has the same features as the base model and includes the
following items:
●

Analog fax accessory

●

Output accessory bridge

●

Stapler/stacker accessory

HP Color LaserJet CM4730fm MFP

ENWW
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3

The HP Color LaserJet CM4730fm MFP has the same features as the base model and includes the
following items:

4

●

Analog fax accessory

●

Output accessory bridge

●

3-bin mailbox accessory

Chapter 1 Product basics
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Product features
Functions
●

Two-sided copying (duplexing)

●

Color digital sending

●

Color access control

●

Network printing

Speed and throughput
●

31 pages per minute (ppm) when copying and printing on letter-size paper; 30 ppm when copying
and printing on A4-size paper

●

25% to 400% scalability when using the scanner glass

●

25% to 200% scalability when using the ADF

●

Less than 10 seconds to print the first page

●

Transmit Once, Raster Image Processing (RIP) ONCE technology

●

Recommended maximum monthly print volume of 85,000 pages

●

A 533 megahertz (MHz) microprocessor

Resolution
●

600 dots per inch (dpi) with Resolution Enhancement technology (REt)

●

The product features HP FastRes and HP Resolution Enhancement technology (REt) for 1200 x
1200 effective dpi at full engine speed.

●

256 MB of random-access memory (RAM), expandable to 512 MB by using industry standard 100pin double data rate dual inline memory modules (DDR DIMMs)

●

Memory Enhancement technology (MEt) that automatically compresses data to use RAM more
efficiently

Memory

User interface

ENWW

●

HP Easy Select Control Panel

●

An embedded Web server to gain access to support and order supplies (for network-connected
products)

●

HP Easy Printer Care software (a Web-based status and troubleshooting tool)

●

Internet-enabled supply-ordering capabilities through HP Easy Printer Care software

Product features

5

Languages and fonts
●

HP Printer Command Language (PCL) 6

●

HP PCL 5

●

Printer Management Language

●

XHTML

●

80 scalable TrueType typefaces

●

HP PostScript® 3 emulation (PS)

Copying and sending
●

Modes for text, graphics, and mixed text and graphics formats

●

Job-interrupt feature (at copy boundaries)

●

Multiple pages per sheet

●

Operator attendance animations (for example, jam recovery)

●

Scan and send to e-mail
●

Local address book for e-mail and fax

●

LDAP addressing

●

Send to folder

●

Automatic duplex (two-sided) scanning

Print cartridges (4)
●

Print up to 12,000 pages at 5% coverage

●

No-shake cartridge design

●

Authentic HP print cartridge detection

●

Automatic toner strip remover

Paper-handling
●

6

Input
●

Tray 1 (multipurpose tray): A multipurpose tray for paper, transparencies, labels, and
envelopes. Holds up to 100 sheets of paper or 20 envelopes.

●

Tray 2, 3, and 4: 500-sheet trays. These trays automatically detect standard paper sizes up
to legal and allow printing on custom-size paper.

●

Automatic document feeder (ADF): Holds up to 50 sheets of paper.

Chapter 1 Product basics
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●

●

Duplex printing and copying: Provides two-sided printing and copying (printing on both
sides of the paper).

●

ADF duplex scanning: The ADF has an automatic duplexer for scanning two-sided
documents.

Output
●

Standard output bin: The standard output bin is located on the left side of the MFP. This bin
can hold up to 500 sheets of paper.

●

ADF output bin: The ADF output bin is underneath the ADF input tray. The bin holds up to
50 sheets of paper, and the MFP automatically stops when this bin is full.

●

Optional stapler/stacker (standard on the CM4730fm MFP): The stapler/stacker staples
up to a 30 sheet document and stacks up to 500 sheets.

●

Optional 3-bin mailbox (standard on the CM4730fsk MFP): One bin stacks up to
500 sheets, and two bins stack up to 100 sheets each for a total capacity of 700 sheets.

Connectivity
●

IEEE 1284C-compliant parallel connection

●

A Foreign Interface Harness (FIH) connection (AUX) for connecting other devices

●

Local area network (LAN) connector (RJ-45) for the embedded HP Jetdirect print server

●

Optional analog fax card (standard on the CM4730f, CM4730fm, and CM4730fsk MFP models)

●

Optional HP Digital Sending Software (DSS)

●

Optional enhanced input/output (EIO) cards

●

USB 2.0

●

ACC port (accessory port with USB host capabilities)

●

Accessory port (for connecting third-party devices)

Environmental features
●

Sleep setting saves energy (meets ENERGY STAR® guidelines, Version 1.0).

Security features

ENWW

●

FIH

●

Secure Disk Erase

●

Security lock

●

Job retention

●

DSS authentication

●

Windows user authentication

●

LDAP authentication

Product features
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8

●

Group PIN authentication (Group 1 and Group 2)

●

User PIN authentication
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Product walkaround
Front view

ENWW

1

ADF top cover

2

Automatic document feeder (ADF) input tray for copy/scan/fax originals

3

Control-panel status lights

4

Control-panel display with touch-screen functionality

5

Control-panel keypad

6

Right-side covers (provides access to the print cartridges and other consumables)

7

Tray 2, 3, and 4

8

Paper-level indicators

9

On/Off switch

10

Output bin

11

Scanner lock

Product walkaround

9

Back view

10

1

Output bin

2

Interface ports

3

On/off switch

4

Power connection
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Interface ports
The MFP has five ports for connecting to a computer or a network. The ports are at the left, rear corner
of the MFP.

1

Foreign interface harness (FIH)

2

USB 2.0

3

ACC (accessory port uses host USB protocol)

4

Fax connection (for connecting to an optional analog fax accessory)

5

Parallel port

6

EIO interface expansion slot

7

Access port for Kensington lock

8

Network connection (embedded HP Jetdirect print server)

9

AUX port

Serial number and model number location
The model number and serial number are listed on identification labels located on the rear of the printer.
The serial number contains information about the country/region of origin, the printer version, production
code, and the production number of the printer.

ENWW

Product walkaround

11

serial number
Figure 1-1 Sample model and serial number label
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Model name

Model number

HP Color LaserJet CM4730 MFP

CB480A

HP Color LaserJet CM4730f MFP

CB481A

HP Color LaserJet CM4730fsk MFP

CB482A

HP Color LaserJet CM4730fm MFP

CB483A
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ENWW

2

ENWW

Control panel

●

Use the control panel

●

Navigate the Administration menu

●

Information menu

●

Default Job Options menu

●

Time/Scheduling menu

●

Management menu

●

Initial Setup menu

●

Device Behavior menu

●

Print Quality menu

●

Troubleshooting menu

●

Resets menu

●

Service menu
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Use the control panel
The control panel has a VGA touchscreen that provides access to all device functions. Use the buttons
and numeric keypad to control jobs and the device status. The LEDs indicate overall device status.

Control-panel layout
The control panel includes a touchscreen graphical display, job-control buttons, a numeric keypad, and
three light-emitting diode (LED) status lights.
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1

Attention light

The Attention light indicates that the device has a condition that requires
intervention. Examples include an empty paper tray or an error message
on the touchscreen.

2

Data light

The Data light indicates that the device is receiving data.

3

Ready light

The Ready light indicates that the device is ready to begin processing any
job.

4

Brightness-adjustment dial

Turn the dial to control the brightness of the touchscreen.

5

Touchscreen graphical display

Use the touchscreen to open and set up all device functions.

6

Numeric keypad

Allows you to type numeric values for number of copies required and other
numeric values.

7

Sleep button

If the device is inactive for a long period of time, it automatically enters a
sleep mode. To place the device into sleep mode or to reactivate the device,
press the Sleep button.

8

Reset button

Resets the job settings to factory or user-defined default values.

9

Stop button

Stops the active job. While stopped, the control panel shows the options for
the stopped job (for example, if you press the Stop button while the device
is processing a print job, the control panel message prompts you to cancel
or resume the print job).

10

Start button

Begins a copy job, starts digital sending, or continues a job that has been
interrupted.

Chapter 2 Control panel
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Home screen
The home screen provides access to the device features, and it indicates the current status of the device.
NOTE Depending on how the device has been configured, the features that appear on the home
screen can vary.

1
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Features

Depending on how the system administrator has configured the device, the features that appear
in this area can include any of the following items:
●

Copy

●

Fax

●

E-mail

●

Secondary E-mail

●

Network Folder

●

Job Storage

●

Workflow

●

Supplies Status

●

Administration

2

Device status line

The status line provides information about the overall device status. Various buttons appear in
this area, depending on the current status. For a description of each button that can appear in
the status line, see Buttons on the touchscreen.

3

Copy count

The copy count box indicates the number of copies that the device is set to make.

4

Help button

Touch the Help button to open the embedded help system.

5

Scroll bar

Touch the up or down arrows on the scroll bar to see the complete list of available features.

6

Sign Out

Touch Sign Out to sign out of the device if you have signed in for access to restricted features.
After you sign out, the device restores all options to the default settings.

7

Network Address

Touch Network Address to find information about the network connection.

8

Date and time

The current date and time appear here. The system administrator can select the format that
the device uses to show the date and time, for example 12-hour format or 24-hour format.

Use the control panel
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Buttons on the touchscreen
The status line on the touchscreen provides information about the status of the device. Various buttons
can appear in this area. The following table describes each button.
Home button. Touch the home button to go to the Home screen from any other screen.

Start button. Touch the Start button to begin the action for the feature that you are using.
NOTE The name of this button changes for each feature. For example, in the Copy feature, the
button is named Start Copy.
Stop button. If the device is processing a print or fax job, the Stop button appears instead of the Start
button. Touch the Stop button to halt the current job. The device prompts you to cancel the job or to resume
it.
Error button. The error button appears whenever the device has an error that requires attention before
it can continue. Touch the error button to see a message that describes the error. The message also has
instructions for solving the problem.
Warning button. The warning button appears when the device has a problem but can continue
functioning. Touch the warning button to see a message that describes the problem. The message also
has instructions for solving the problem.
Help button. Touch the help button to open the built-in online Help system. For more information, see
Control-panel help system.

Control-panel help system
The device has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help button ( ) in the upper-right corner of the screen.
For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.
For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.
If the device alerts you of an error or warning, touch the error ( ) or warning ( ) button to open a
message that describes the problem. The message also contains instructions to help solve the problem.
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Navigate the Administration menu
From the Home screen, touch Administration to open the menu structure. You might need to scroll to
the bottom of the Home screen to see this feature.
The Administration menu has several sub-menus, which are listed on the left side of the screen. Touch
the name of a menu to expand the structure. A plus sign (+) next to a menu name means that it contains
sub-menus. Continue opening the structure until you reach the option that you want to configure. To
return to the previous level, touch Back.
To exit the Administration menu, touch the Home button (

) in the upper-left corner of the screen.

The device has built-in Help that explains each of the features that are available through the menus.
Help is available for many menus on the right-hand side of the touchscreen. Or, to open the global Help
system, touch the Help button ( ) in the upper-right corner of the screen.
The tables in the sections that follow indicate the overall structure of each menu under the Administration
menu.

ENWW

Navigate the Administration menu
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Information menu
Administration > Information
Use this menu to print information pages and reports that are stored internally on the device.
Table 2-1 Information menu
Menu item

Sub-menu item

Configuration/Status
Pages

Fax Reports

Values

Description

Administration Menu
Map

Print

Shows the basic structure of the
Administration menu and current
administration settings.

Configuration/status
Pages

Print

A set of configuration pages that show the
current device settings.

Supplies Status
Page

Print

Shows the status of supplies such as
cartridges, maintenance kits, and staples.

Usage Page

Print

Shows information about the number of
pages that have been printed on each paper
type and size.

File Directory

Print

A directory page that contains information for
any mass-storage devices, such as flash
drives, memory cards, or hard disks, that are
installed in this device.

Color Usage Job Log

Print

A directory page that contains job-by-job
color usage information. Page content
includes the user name, application name,
and number of black-only pages and color
pages.

Fax Activity Log

Print

Contains a list of the faxes that have been
sent from or received by this device.

Fax Call Report

Print

A detailed report of the last fax operation,
either sent or received.

Thumbnail on Report

Yes

Choose whether or not to include a thumbnail
of the first page of the fax on the report.

Fax Call Report

Sub-menu item

No (default)
When to Print Report

Never auto print
Print after any fax job
Print after fax send jobs
Print after any fax error (default)
Print after send errors only
Print after receive errors only
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Billing Codes Report

Print

A list of billing codes that have been used for
outgoing faxes. This report shows how many
sent faxes were billed to each code.

Blocked Fax List

Print

A list of phone numbers that are blocked from
sending faxes to this device.

Speed Dial List

Print

Shows the speed dials that have been set up
for this device.

Chapter 2 Control panel
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Table 2-1 Information menu (continued)
Menu item

Sub-menu item

Sample Pages/Fonts

ENWW

Sub-menu item

Values

Description

Demonstration Page

Print

A demonstration page that displays the
highest print quality possible for this MFP.

RGB Samples

Print

Printout of color samples for different RGB
values. The samples act as a guide for color
matching.

CMYK Samples

Print

Printout of color samples for different CMYK
values. The samples act as a guide for color
matching.

PCL Font List

Print

A list of printer control language (PCL) fonts
that are currently available on the device.

PS Font List

Print

A list of PostScript (PS) fonts that are
currently available on the device.

Information menu
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Default Job Options menu
Administration > Default Job Options
Use this menu to define the default job options for each function. These are used if the user does not
specify other options when creating the job.
The Default Job Options menu contains the following sub-menus:
●

Default Options for Originals

●

Image adjustment

●

Default Copy Options

●

Default Fax Options

●

Default E-mail Options

●

Default Send to Folder Options

●

Default Print Options

Default Options for Originals
Administration > Default Job Options > Default Options For Originals
Table 2-2 Default Options for Originals menu
Menu item

Values

Description

Paper Size

Select a paper size from the list.

Select the paper size that is most often used for copy or scan
originals.

Number of Sides

1

Select whether copy or scan originals are most often single-sided or
double-sided.

2
Orientation

Portrait
Landscape

Optimize Text/Picture

Manually Adjust
Text
Printed Picture

Select the orientation that is most often used for copy or scan
originals. Select Portrait if the short edge is at the top or select
Landscape if the long edge is at the top.
Optimize the output for a particular type of original: text, pictures, or
a mixture of both.
If you select Manually Adjust, specify the mix of text and pictures that
is used most often.

Photograph
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Image adjustment
Administration > Default Job Options > Image Adjustment
Table 2-3 Image Adjustment menu
Menu item

Values

Description

Darkness

Select a value.

Select the level of density (darkness) for the output.

Background Cleanup

Adjust the value within the range.

Increase the Background Removal setting to remove faint images
from the background or to remove a light background color.

Sharpness

Adjust the value within the range. Adjust the Sharpness setting to clarify or soften the image.

ENWW

Default Job Options menu
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Default Copy Options
Administration > Default Job Options > Default Copy Options
Table 2-4 Default Copy Options menu
Menu item

Sub-menu item

Values

Description

Number of Copies

Type the number of
copies. The factory
default setting is 1.

Set the default number of copies for a copy job.

Number of Sides

1

Set the default number of sides for copies.

2
Color/Black

Color (default)

Choose whether the default copy mode is color or
black.

Black
Auto Include Margins

Off (default)

This feature automatically reduces the image size
during scanning so the margins are included.

On
Staple/Collate

Staple

Collate

None (default)

Set up options for stapling and collating sets of copies.

One left angled

If Collate is selected, the device prints a complete copy
before starting on the next copy. Otherwise, the device
prints the first page of all copies before printing the
second page, and so on.

Off
On (default)

Output Bin

<Binname>

Select the default output bin for copies.

Edge-To-Edge

Normal (recommended)
(default)

If the original document is printed close to the edges,
use the Edge-To-Edge feature to avoid shadows along
the edges. Combine this feature with the Reduce/
Enlarge feature to ensure that the entire page appears
on the copies.

Edge-To-Edge Output
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Default Fax Options
Administration > Default Job Options > Default Fax Options
Table 2-5 Fax Send menu
Menu item

Sub-menu item

Resolution

Values

Description

Standard (100x200dpi)
(default)

Set the resolution for sent documents. Higher
resolution images have more dots per inch (dpi), so
they show more detail. Lower resolution images have
fewer dots per inch and show less detail, but the file
size is smaller.

Fine (200x200dpi)
Superfine (300x300dpi)
Fax Header

Prepend (default)

Select the position of the fax header on the page.

(default)

Select Prepend to print the fax header above the fax
content and move the fax content down on the page.
Select Overlay to print the fax header over the top of
the fax contents without moving the contents down.
Using this option could prevent a single-page fax from
flowing onto another page.

Overlay

Table 2-6 Fax Receive menu
Menu item

Values

Description

Forward Fax

Fax Forwarding

To forward received faxes to another fax device, select Fax
Forwarding and Custom. Then type the number of the other fax
device into the Fax Forwarding Number field. When you select this
menu item for the first time, you are prompted to set up a PIN. Type
that PIN every time you use this menu. This is the same PIN that is
used to access the Fax Printing menu.

Change PIN

Stamp Received Faxes

Enabled

Add the date, time, senders phone number, and page number to each
page of the faxes that this device receives.

Disabled (default)
Fit to Page

Enabled (default)
Disabled

Shrink faxes that are larger than Letter-size or A4-size so that they
can fit onto a Letter-size or A4-size page. If it this feature set to
Disabled, faxes larger than Letter or A4 will flow across multiple
pages.

Fax Paper Tray

Select from the list of trays.

Select the tray that holds the size and type of paper that you want to
use for incoming faxes.

Output Bin

<Binname>

Select the default output bin, if applicable, to use for faxes.

ENWW
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Default E-mail Options
Administration > Default Job Options > Default E-mail Options
Menu item

Values

Description

Document File Type

PDF (default)

Select the file format for the e-mail.

JPEG
TIFF
M-TIFF
Output Quality

High (large file)

Selecting higher quality for output increases the size of the
output file.

Medium (default)
Low (small file)
Resolution

300 DPI

Select the resolution. Use a lower setting to create smaller
files.

200 DPI
150 DPI (default)
75 DPI
Color/Black

Color scan (default)

Specify whether the e-mail will be in black or in color.

Black/white scan
TIFF Version

TIFF 6.0 (default)

Specify the TIFF version to use when saving scanned files.

TIFF (Post 6.0)
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Default Send to Folder Options
Administration > Default Job Options > Default Send To Folder Options
Menu item

Values

Description

Color/Black

Color scan

Specify whether the file will be in black or in color.

Black/white scan (default)
Document File Type

PDF (default)

Select the file format for the file.

M-TIFF
TIFF
JPEG
TIFF version

TIFF 6.0 (default)

Specify the TIFF version to use when saving scanned files.

TIFF (post 6.0)
Output Quality

High (large file)

Selecting higher quality for output increases the size of the
output file.

Medium (default)
Low (small file)
Resolution

75 DPI

Select the resolution. Use a lower setting to create smaller
files.

150 DPI (default)
200 DPI
300 DPI
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Default Print Options
Administration > Default Job Options > Default Print Options
Table 2-7 Default Print Options menu
Menu item

Values

Description

Copies Per Job

Type a value.

Set the default number of copies for print jobs.

Default Paper Size

(List of supported sizes)

Select a paper size.

Millimeters

Configure the default paper size that is used when the
user selects Custom as the paper size for a print job.

Default Custom Paper
Size

Sub-menu item

Unit of measure

Inches
X Dimension

Configure the width measurement for the Default
Custom Paper Size.

Y Dimension

Configure the height measurement for the Default
Custom Paper Size.

Output Bin

<binname>

Select the default output bin for print jobs. If optional
trays are installed, output bin options vary.

Print Sides

1-sided

Select whether print jobs are single-sided or doublesided by default.

2-sided
2-Sided Format

Book style
Flip style
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Use this feature to configure the default style for 2sided print jobs. If Book style is selected, the placement
of the back side of the page is the same as the front.
This option is for print jobs that are bound along the left
edge. If Flip style is selected, the back side of the page
is printed upside-down. This option is for print jobs that
are bound along the top edge.
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Time/Scheduling menu
Administration > Time/Scheduling
Use this menu to set options for setting the time and for setting the device to enter and exit sleep mode.
NOTE Values shown with "(default)" are the factory-default values. Some menu items have no
default.
Table 2-8 Time/Scheduling menu
Menu item

Sub-menu item

Date/Time

Date Format

Sub-menu item

Values

Description

YYYY/MMM/DD
(default)

Use this feature to set the current date and
time, and to set the date format and time
format that are used to time-stamp outgoing
faxes.

MMM/DD/YYYY
DD/MMM/YYYY
Date

Month
Day
Year

Time Format

12 hour (AM/PM)
(default)
24 hour

Time

Hour
Minute
AM
PM

Sleep Delay

1 Minute
20 minutes

Use this feature to select the time interval that
the device should remain inactive before
entering Sleep Mode.

30 minutes (default)
45 minutes
1 hour (60 minutes)
90 minutes
2 hours
4 hours
Wake Time

Monday

Off (default)

Tuesday

Custom

Wednesday
Thursday

Select Custom to set a wake time for each
day of the week. The device exits sleep mode
according to this schedule. Using a sleep
schedule helps conserve energy and
prepares the device for use so that users do
not have to wait for it to warm up.

Friday

ENWW
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Table 2-8 Time/Scheduling menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Store all received
faxes

If you have concerns about the security of
private faxes, use this feature to store faxes
rather than having them automatically print by
creating a printing schedule.

Saturday
Sunday
Fax Printing

Fax Printing Mode

Print all received
faxes (default)
Use Fax Printing
Schedule
Change PIN
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For the fax printing schedule, the control
panel prompts you to select days and times
to print faxes.
Select Change PIN to change the PIN
number that users must provide to print faxes.
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Management menu
Administration > Management
Use this menu to set up global device-management options.
NOTE Values shown with "(default)" are the factory-default values. Some menu items have no
default.
Table 2-9 Management menu
Menu item

Sub-menu item

Values

Description

Stored Job Management

Quick Copy Job Storage
Limit

Select the maximum
number of jobs to store

Use this menu to view and manage any jobs that are
stored on the device.

Quick Copy Job Held
Timeout

Off
1 Hour
4 Hours
1 Day
1 Week

Sleep mode

Disable

Use this feature to customize the sleep mode settings
for this device.

Use Sleep Delay (default)
Select Use Sleep Delay to set the device to enter sleep
mode after the delay that is specified in the Time/
Scheduling menu.
Manage Supplies

Replace Supplies

Stop at low
Stop at out (default)
Override at out

Supply Low/Order
Threshold

Select a value in the
range.

Use this menu to carry out administrative supply
management tasks such as changing the threshold
when supplies should be ordered.

Color Supply Out

Auto-continue black

This menu sets the MFP behavior when a color supply
is empty. When Auto-continue black is selected, the
MFP will continue printing using black toner only.

Stop
Restrict Color Use

This menu sets the MFP behavior for when a print
cartridge, fuser kit, or tranfer kit is low. Choose Stop at
low to stop printing when a supply reaches a low
condition. Choose Stop at out to allow the MFP to
continue printing until a color print cartridge is empty.
Choose Override at out to allow printing to continue
when a color print cartridge is out; however, a controlpanel warning will state that override is in use and that
a color supply must be replaced.

Color printing access

Enable Color (default)
Color If Allowed
Disable Color

Color copying access

Enable Color (default)

This item allows the administrator to disable or restrict
color printing. To use the Color If Allowed setting, set
up user permissions and/or application permissions in
the embedded Web server, HP Easy Printer Care, or
Web Jetadmin.
This item allows the administrator to disable or restrict
color copying.

Disable Color
Color/Black Mix

Auto (default)
Mostly color pages

ENWW

This item controls how the engine switches from color
mode to monochrome mode for maximum
performance and print cartridge life.

Management menu
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Table 2-9 Management menu (continued)
Menu item

Sub-menu item

Values

Description

Mostly black pages

Choose Auto to reset the MFP to the factory default
setting.
Choose Mostly color pages if nearly all of your print
jobs are color with high page coverage.
Choose Mostly black pages if you print mostly
monochrome jobs or a combination of color and
monochrome jobs.
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Initial Setup menu
Administration > Initial Setup
The Initial Setup menu contains the sub-menus shown:
●

Networking and I/O menu

●

Fax Setup menu

●

E-mail Setup menu
NOTE Values shown with "(default)" are the factory-default values. Some menu items have no
default.

Networking and I/O
Administration > Initial Setup > Networking and I/O
Table 2-10 Networking and I/O
Menu item

Sub-menu item

I/O Timeout

Parallel Input
NOTE This
item appears
only if an EIO
accessory is
installed.
Embedded Jetdirect

Values

Description

Select a value in the
I/O timeout refers to the elapsed time before a print job
range. The factory default fails. If the stream of data that the device receives for
setting is 15 seconds.
a print job gets interrupted, this setting indicates how
long the device will wait before it reports that the job
has failed.
High Speed

No

Use the High Speed setting to configure the speed that
the parallel port uses to communicate with the host.

Yes (default)
Advanced Functions

Enabled (default)

Use the Advanced Functions setting to enable or
disable bidirectional parallel communication.

Disabled

See Table 2-11 Jetdirect menus for the list of options.

EIO <X> Jetdirect

Table 2-11 Jetdirect menus
Menu item

Sub-menu item

TCP/IP

Enable

Sub-menu item

Values and Description
Off: Disable the TCP/IP protocol.
On (default): Enable the TCP/IP protocol.

Host Name

IPV4 Settings

ENWW

An alphanumeric string, up to 32 characters, used to
identify the device. This name is listed on the
HP Jetdirect configuration page. The default host name
is NPIxxxxxx, where xxxxxx is the last six digits of the
LAN hardware (MAC) address.
Config Method

Specifies the method that TCP/IPv4 parameters will be
configured on the HP Jetdirect print server.

Initial Setup menu
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Values and Description
Bootp: Use BootP (Bootstrap Protocol) for automatic
configuration from a BootP server.
DHCP: Use DHCP (Dynamic Host Configuration
Protocol) for automatic configuration from a DHCPv4
server. If selected and a DHCP lease exists, DHCP
Release and DHCP Renew menus are available to set
DHCP lease options.
Auto IP: Use automatic link-local IPv4 addressing. An
address in the form 169.254.x.x is assigned
automatically.
Manual: Use the Manual Settings menu to configure
TCP/IPv4 parameters.

Default IP

Specify the IP address to default to when the print
server is unable to obtain an IP address from the
network during a forced TCP/IP reconfiguration (for
example, when manually configured to use BootP or
DHCP).
Auto IP: A link-local IP address 169.254.x.x is set.
Legacy: The address 192.0.0.192 is set, consistent
with older HP Jetdirect devices.

DHCP Release

This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.
No (default): The current DHCP lease is saved.
Yes: The current DHCP lease and the leased IP
address are released.

DHCP Renew

This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.
No (default): The print server does not request to renew
the DHCP lease.
Yes: The print server requests to renew the current
DHCP lease.

Manual Settings

(Available only if Config Method is set to Manual)
Configure parameters directly from the printer control
panel:
IP Address: The unique IP address of the printer
(n.n.n.n), where n is a value from 0 to 255.
Subnet Mask: The subnet mask for the printer
(m.m.m.m), where m is a value from 0 to 255.
Syslog Server: The IP address of the syslog server
used to receive and log syslog messages.
Default Gateway: The IP address of the gateway or
router used for communications with other networks.
Idle Timeout: The time period, in seconds, after which
an idle TCP print data connection is closed (default is
270 seconds, 0 disables the timeout).
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

IPV6 Settings

Sub-menu item

Values and Description

Primary DNS

Specify the IP address (n.n.n.n) of a Primary DNS
Server.

Secondary DNS

Specify the IP address (n.n.n.n) of a Secondary
Domain Name System (DNS) Server.

Enable

Use this item to enable or disable IPv6 operation on the
print server.
Off (default): IPv6 is disabled.
On: IPv6 is enabled.

Address

Manual Settings: Use this item to manually set IPv6
addresses on the print server.
Enable: Select this item and choose On to enable
manual configuration, or Off to disable manual
configuration.
Address: Use this item to type a 32 hexadecimal digit
IPv6 node address that uses the colon hexadecimal
syntax.

DHCPV6 Policy

Router Specified: The stateful auto-configuration
method to be used by the print server is determined by
a router. The router specifies whether the print server
obtains its address, its configuration information, or
both from a DHCPv6 server.
Router Unavailable: If a router is not available, the print
server should attempt to obtain its stateful
configuration from a DHCPv6 server.
Always: Whether or not a router is available, the print
server always attempts to obtain its stateful
configuration from a DHCPv6 server.

Proxy Server

Primary DNS

Use this item to specify an IPv6 address for a primary
DNS server that the print server should use.

Secondary DNS

Use this item to specify an IPv6 address for a
secondary DNS server that the print server should use.
Specifies the proxy server to be used by embedded
applications in the device. A proxy server is typically
used by network clients for Internet access. It caches
Web pages, and provides a degree of Internet security,
for those clients.
To specify a proxy server, enter its IPv4 address or
fully-qualified domain name. The name can be up to
255 octets.
For some networks, you may need to contact your
Independent Service Provider (ISP) for the proxy
server address.

Proxy Port
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Type the port number used by the proxy server for
client support. The port number identifies the port
reserved for proxy activity on your network, and can be
a value from 0 to 65535.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

IPX/SPX

Enable

Sub-menu item

Values and Description
Off: Disable the IPX/SPX protocol.
On (default): Enable the IPX/SPX protocol.

Frame Type

Selects the frame-type setting for your network.
Auto: Automatically sets and limits the frame type to
the first one detected.
EN_8023, EN_II, EN_8022, and EN_SNAP: Frametype selections for Ethernet networks.

AppleTalk

Enable

Off: Disable the AppleTalk protocol.
On (default): Enable the AppleTalk protocol.

DLC/LLC

Enable

Off: Disable the DLC/LLC protocol.
On (default): Enable the DLC/LLC protocol.

Security

Print Sec Page

Yes (default): Prints a page that contains the current
security settings on the HP Jetdirect print server.
No: A security settings page is not printed.

Secure Web

For configuration management, specify whether the
embedded Web server will accept communications
using HTTPS (Secure HTTP) only, or both HTTP and
HTTPS.
HTTPS Required: For secure, encrypted
communications, only HTTPS access is accepted. The
print server will appear as a secure site.
HTTP/HTTPS optional: Access using either HTTP or
HTTPS is permitted.

Firewall

Specify the Firewall status on the print server.
Keep: Firewall status remains the same as currently
configured.
Disable: Firewall operation on the print server is
disabled.

Reset Security

Specify whether the current security settings on the
print server will be saved or reset to factory defaults.
No*: The current security settings are maintained.
Yes: Security settings are reset to factory defaults.

Diagnostics

Embedded Tests

This menu provides tests to help diagnose network
hardware or TCP/IP network connection problems.
Embedded tests help to identify whether a network fault
is internal or external to the device. Use an embedded
test to check hardware and communication paths on
the print server. After you select and enable a test and
set the execution time, you must select Execute to
initiate the test.
Depending on the execution time, a selected test runs
continuously until either the device is turned off, or an
error occurs and a diagnostic page is printed.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item
LAN HW Test

Values and Description
CAUTION Running this embedded test will
erase your TCP/IP configuration.
This test performs an internal loopback test. An internal
loopback test will send and receive packets only on the
internal network hardware. There are no external
transmissions on your network.
Select Yes to choose this test, or No to not choose it.

HTTP Test

This test checks operation of HTTP by retrieving
predefined pages from the device, and tests the
embedded Web server.
Select Yes to choose this test, or No to not choose it.

SNMP Test

This test checks operation of SNMP communications
by accessing predefined SNMP objects on the device.
Select Yes to choose this test, or No to not choose it.

Data Path Test

This test helps to identify data path and corruption
problems on an HP postscript level 3 emulation device.
It sends a predefined PS file to the device, However,
the test is paperless; the file will not print.
Select Yes to choose this test, or No to not choose it.

Select All Tests

Use this item to select all available embedded tests.
Select Yesto choose all tests. Select No to select
individual tests.

Execution Time [H]

Use this item to specify the length of time (in hours) that
an embedded test will be run. You can select a value
from 1 to 60 hours. If you select zero (0), the test runs
indefinitely until an error occurs or device is turned off.
Data gathered from the HTTP, SNMP, and Data Path
tests is printed after the tests have completed.

Execute

No*: Do not initiate the selected tests.
Yes: Initiate the selected tests.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Ping Test
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Values and Description
This test is used to check network communications.
This test sends link-level packets to a remote network
host, then waits for an appropriate response. To run a
ping test, set the following items:

Dest Type

Specify whether the target device is an IPv4 or IPv6
node.

Dest IP4

IPV4: Type the IPv4 address.

Dest IP6

IPV6: Type the IPv6 address.

Packet Size

Specify the size of each packet, in bytes, to be sent to
the remote host. The minimum is 64 (default) and the
maximum is 2048.

Timeout

Specify the length of time, in seconds, to wait for a
response from the remote host. The default is 1 and
the maximum is 100.

Count

Specify the number of ping test packets to send for this
test. Select a value from 1 to 100. To configure the test
to run continuously, select 0.

Print Results

If the ping test was not set for continuous operation,
you can choose to print the test results. Select Yes to
print results. If you select No (default), results are not
printed.

Execute

Specify whether to initiate the ping test. Select Yes to
initiate the test, or No to not run the test.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Ping Results

Link Speed

Values and Description
Use this item to view the ping test status and results
using the control panel display. You can select the
following items:

Packets Sent

Shows the number of packets (0 - 65535) sent to the
remote host since the most recent test was initiated or
completed.

Packets Received

Shows the number of packets (0 - 65535) received from
the remote host since the most recent test was initiated
or completed.

Percent Lost

Shows the percent of ping test packets that were sent
with no response from the remote host since the most
recent test was initiated or completed.

RTT Min

Shows the minimum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Max

Shows the maximum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Average

Shows the average round-trip-time (RTT), from 0 to
4096 milliseconds, for packet transmission and
response.

Ping In Progress

Shows whether a ping test is in progress. Yes indicates
a test in progress, and No indicates that a test
completed or was not run.

Refresh

When viewing the ping test results, this item updates
the ping test data with current results. Select Yes to
update the data, or No to maintain the existing data.
However, a refresh automatically occurs when the
menu times out or you manually return to the main
menu.
The link speed and communication mode of the print
server must match the network. The available settings
depend on the device and installed print server. Select
one of the following link configuration settings:
CAUTION If you change the link setting,
network communications with the print server
and network device might be lost.
Auto (default): The print server uses auto-negotiation
to configure itself with the highest link speed and
communication mode allowed. If auto-negotiation fails,
either 100TX HALF or 10TX HALF is set depending on
the detected link speed of the hub/switch port. (A
1000T half-duplex selection is not supported.)
10T Half: 10 Mbps, half-duplex operation.
10T Full: 10 Mbps, Full-duplex operation.
100TX Half: 100 Mbps, half-duplex operation.
100TX Full: 100 Mbps, full-duplex operation.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Values and Description
100TX Auto: Limits auto-negotiation to a maximum link
speed of 100 Mbps.
1000TX Full: 1000 Mbps, full-duplex operation.

Print Protocols
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Use this item to print a page that lists the configuration
of the following protocols: IPX/SPX, Novell NetWare,
AppleTalk, DLC/LLC.
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Fax Setup
Administration > Initial Setup > Fax Setup
Table 2-12 Fax Setup menu
Menu item

Sub-menu item

Required Settings

Country/Region

Sub-menu item

Values

Description

(Countries/regions
listed)

Configure the settings that are legally
required for outgoing faxes.

Disabled

Use this feature to enable or disable PC Fax
Send. PC Fax Send enables users to send
faxes through the device from their
computers if they have the Send Fax driver
installed.

Date/Time
Fax Header
Information

Phone Number
Company Name

PC Fax Send

Enabled (default)
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Table 2-12 Fax Setup menu (continued)
Menu item

Sub-menu item

Fax Send Settings

Fax Dial Volume

Sub-menu item

Values

Description

Off

Use this feature to set the volume of the tones
that you hear while the device dials the fax
number.

Low (default)
High
Error Correction
Mode

Enabled (default)
Disabled

JBIG Compression

Enabled (default)
Disabled

When Error Correction Mode is enabled and
an error occurs during fax transmission, the
device sends or receives the error portion
again.
JBIG compression reduces fax-transmission
time, which can result in lower phone
charges. However, using JBIG compression
sometimes causes compatibility problems
with older fax machines. If this occurs, turn off
JBIG compression.

Maximum Baud Rate

Select a value from
the list. The default is
33.6K.

Use this feature to set the maximum baud
rate for receiving faxes. This can be used as
a diagnostic tool for troubleshooting fax
problems.

TCF T.30 Delay
Timer

Default (default)

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

Custom

TCF Extend

Default (default)
Custom

Dialing Mode

Tone (default)

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.
Select whether the device should use tone or
pulse dialing.

Pulse
Redial On Busy

The range is between
0 and 9. The factory
default is 3 times.

Type the number of times the device should
attempt to redial if the line is busy.

Redial On No Answer

Never (default)

Use this feature to specify the number of
times the device should attempt to dial if the
recipient fax number does not answer.

Once
Twice
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NOTE Twice is available in
locations other than the United
States and Canada.
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Table 2-12 Fax Setup menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Redial Interval

The range is between
1 and 5 minutes. The
factory default is 5
minutes.

Use this feature to specify the number of
minutes between dialing attempts if the
recipient number is busy or not answering.

Detect Dial Tone

Enabled

Use this feature to specify whether the device
should check for a dial tone before sending a
fax.

Disabled (default)
Dialing Prefix

Off (default)
Custom

Billing Codes

Off (default)
Custom

Use this feature to specify a prefix number
that must be dialed when sending faxes from
the device.
When billing codes are enabled, a prompt
appears that asks the user to enter the billing
code for an outgoing fax.
The range is between 1 and 16 digits. The
default is 1 digit.

Fax Receive Settings

Rings To Answer

The range varies by
location. The factory
default is 2 rings.

Use this feature to specify the number of rings
that must occur before the fax modem
answers.

Ring Interval

Default (default)

This setting is used to adjust for some PBX
ring signals. Change this setting only when
directed by an HP technical support agent.

Custom
Ring Frequency

Default (default)

Ringer Volume

Custom

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

Off

Set the volume for the fax ring-tone.

Low (default)
High
Blocked Fax
Numbers

Add Blocked
Numbers

Type the fax number
to add.

Remove Blocked
Numbers

Select a fax number
to remove.

Clear All Blocked
Numbers

No (default)

Use this feature to add or delete numbers
from the blocked fax list. The blocked fax list
can contain up to 30 numbers. When the
device receives a call from one of the blocked
fax numbers, it deletes the incoming fax. It
also logs the blocked fax in the activity log
along with job-accounting information.

Yes
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E-mail Setup
Administration > Initial Setup > E-mail Setup
Use this menu to enable the e-mail feature and to configure basic e-mail settings.
NOTE To configure advanced e-mail settings, use the embedded Web server. For more
information, see Embedded Web server.
Table 2-13 E-mail Setup menu
Menu item

Values

Description

Address Validation

On (default)

This option enables the device to check e-mail syntax when you type
an e-mail address. Valid e-mail addresses require the "@" sign and
a ".".

Off
Find Send Gateways
SMTP Gateway

Search the network for SMTP gateways that the device can use to
send e-mail.
Enter a value.

Test Send Gateway

Specify the IP address of the SMTP gateway that is used to send email from the device.
Test the configured SMTP gateway to see if it is functional.

Send Setup menu
Administration > Initial Setup > Send Setup
Table 2-14 Send Setup menu
Menu item

Values

Description

Replicate MFP

Enter a value (IP Address).

Copy the local Send settings from one device to another.

Allow Transfer to New DSS

Off

Use this feature to allow the transfer of the device from one HP Digital
Sending Software (DSS) server to another.

On (default)
HP DSS is a software package that handles digital sending tasks such
as faxing, e-mail, and sending a scanned document to a network
folder.
Allow Use of Digital Send Service Off

This feature allows you to configure the device for use with an
HP Digital Sending Software (DSS) server.

On (default)
Fax Number Confirmation

Disable (default)

When fax number confirmation is enabled, you are prompted to enter
the fax number twice to verify that it has been typed correctly.

Enable
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Device Behavior menu
Administration > Device Behavior
Table 2-15 Device Behavior menu
Menu item

Sub-menu item

Sub-menu item

Values

Description

Language

Select the language
from the list.

Select a different language for control-panel
messages. When you select a new language,
the keyboard layout might also change.

Key Press Sound

On (default)

Use this feature to specify whether you hear
a sound when you touch the screen or press
buttons on the control panel.

Off
Inactivity Timeout

Warning/Error
Behavior

Clearable Warnings

Type a value
between 10 and 300
seconds. The factory
default is 60
seconds.

Specify the amount of time that elapses
between any activity on the control panel and
the device resetting to the default settings.

On

Set the amount of time that a clearable
warning appears on the control panel.

Job (default)
Continuable Events

Auto continue (10
seconds) (default)

Configure the device behavior when the
device encounters certain errors.

Touch OK to
continue
Jam Recovery

Auto (default)

Configure how the device handles pages that
are lost during a jam.

Off
On
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Tray Behavior

Use Requested Tray

Sub-menu item

Values

Description

Exclusively (default)

Control how the device handles jobs that
have specified a specific input tray.

First
Manually Feed
Prompt

Always (default)
Unless Loaded

PS Defer Media

Enabled (default)

Specify how a prompt should appear when
the type or size for a job does not match the
specified tray and the device pulls from the
multipurpose tray instead.
Select either the PostScript (PS) or HP paperhandling model.

Disabled
Use Another Tray

Enabled (default)
Disabled

Size/Type Prompt

Display (default)
(default)

Turn on or off the control-panel prompt to
select another tray when the specified tray is
empty.
Control whether the tray configuration
message appears whenever a tray is opened
or closed.

Do not display
Duplex Blank Pages

Auto (default)

Control how the device handles two-sided
jobs (duplexing).

Yes
Image Rotation

Standard (default)
Alternate

Image rotation allows users to put paper in
the input tray using the same orientation
regardless of whether there is a finisher
installed.
Select Standard to match the loading
orientation of other devices that have a
finisher.
Select Alternate to use a different loading
orientation that might work better with
preprinted forms that are used on legacy
products.

Stapler/Stacker

Staple

None
One

Staples Out

If the optional stapler/stacker is installed, use
this feature to set stapling characteristics for
the device.

Continue (default)
Stop

MBM-3
Configuration

Operation Mode

Function Separator

Configure the optional 3–bin mailbox
accessory.

Mailbox
Stacker
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

General Copy
Behavior

Scan Ahead

Sub-menu item

Values

Description

Enabled (default)

Turn on no-wait scanning. With Scan Ahead
enabled, the pages in the original document
are scanned to disk and held until the device
becomes available.

Disabled
Auto Print Interrupt

Enabled
Disabled (default)

When this feature is enabled, copy jobs can
interrupt print jobs that are set to print multiple
copies.
The copy job is inserted into the print queue
at the end of one copy of the print job. After
the copy job is complete, the device
continues printing the remaining copies of the
print job.

Copy Interrupt

Enabled
Disabled (default)

First Copy Speed

When this feature is enabled, a copy job that
is currently printing can be interrupted when
a new copy job is started. You are prompted
to confirm that you want to interrupt the
current job.

No early warm up
(default)
Early warm up

Alternative
Letterhead Mode

No (default)
Yes
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

General Printing
Behavior

Override A4/Letter

Sub-menu item

Values

Description

No

When this feature is enabled, the job prints on
letter-size paper when an A4 job is sent but
no A4-size paper is loaded in the device (or
prints on A4 paper when a letter-size job is
sent but no letter-size paper is loaded). This
option also overrides A3 with ledger-size
paper and ledger with A3-size paper.

Yes (default)

Manual Feed

Enabled
Disabled (default)

Courier Font

Regular (default)

When this feature is enabled, the user can
select manual feed from the control panel as
the paper source for a job.
Select which version of the Courier font you
want to use.

Dark
Wide A4

Enabled
Disabled (default)

Print PS Errors

Enabled
Disabled (default)

Print PDF Errors

Enabled

Change the printable area of A4-size paper.
If you enable this option, eighty 10-pitch
characters can be printed on a single line of
A4 paper.
Select whether a PostScript (PS) error page
is printed when the device encounters a PS
error.
Select whether a PDF error page is printed
when the device encounters a PDF error.

Disabled (default)
Personality

Auto (default)

Select the printer language that the device
should use.

PCL
PDF
PS
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Normally, you should not change the
language. If you change the setting to a
specific language, the device does not
automatically switch from one language to
another unless specific software commands
are sent to the device.
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

PCL

Form Length

Type a value
between 5 and 128
lines. The factory
default is 60 lines.

PCL is a set of printer commands that
Hewlett-Packard developed to provide
access to printer features.

Orientation

Portrait (default)
Landscape

Select the orientation that is most often used
for print jobs. Select Portrait if the short edge
is at the top or Landscape if the long edge is
at the top.

Font Source

Select the source
from the list.

Select the font source for the user-soft default
font.

Font Number

Type the font
number. The range is
between 0 and 999.
The factory default is
0.

Specify the font number for the user soft
default font by using the source that is
specified in the Font Source menu item. The
device assigns a number to each font and
lists it on the PCL font list (available from the
Administration menu).

Font Pitch

Type a value
between 0.44 and
99.99. The factory
default is 10.00.

If Font Source and Font Number indicate a
contour font, use this feature to select a
default pitch (for a fixed-spaced font).

Font Point Size

Type a value
between 4.00 and
999.75. The factory
default is 12.00.

If Font Source and Font Number indicate a
contour font, use this feature to select a
default point size (for a proportional-spaced
font).

Symbol Set

PC-8 (default)

Select any one of several available symbol
sets from the control panel. A symbol set is a
unique grouping of all the characters in a font.

(50 additional symbol
sets from which to
choose)
Append CR to LF

No (default)
Yes

Suppress Blank
Pages

No (default)
Yes

Media Source
Mapping

Standard (default)
Classic
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Configure whether a carriage return (CR) is
appended to each line feed (LF) encountered
in backwards-compatible PCL jobs (pure text,
no job control).
This option is for users who are generating
their own PCL, which could include extra form
feeds that cause blank pages to be printed.
When Yes is selected, form feeds are ignored
if the page is blank.
Select and maintain input trays by number
when you are not using the device driver, or
when the software program has no option for
tray selection.
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Print Quality menu
Administration > Print Quality
Table 2-16 Print Quality menu
Menu item

Sub-menu item

Values

Description

Adjust Color

Highlights

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of highlights on a
printed page. Lower values represent lighter highlights
on a printed page, and higher values represent darker
highlights on a printed page.

+5 to –5. Default is 0.
Midtones

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of midtones on a
printed page. Lower values represent lighter midtones
on a printed page, and higher values represent darker
midtones on a printed page.

+5 to –5. Default is 0.
Shadows

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of shadows on a
printed page. Lower values represent lighter shadows
on a printed page, and higher values represent darker
shadows on a printed page.

+5 to –5. Default is 0.
Set Registration

Test Page

Print

Shift the margin alignment to center the image on the
page from top to bottom and from left to right. You can
also align the image on the front with the image printed
on the back.
Print a test page for setting the registration.

Source

All trays

Select the source input tray for printing the Set
Registration page.

Tray <X>: <contents>
(choose a tray)
Adjust Tray <X>

Shift from -20 to 20 along
the X or Y axes. 0 is the
default.

Perform the alignment procedure for each tray.
When it creates an image, the device scans across the
page from side to side as the sheet feeds from top to
bottom into the device.
The scan direction is referred to as X. X1 is the scan
direction for the first side of a 2-sided page. X2 is the
scan direction for the second side of a 2-sided page.
The feed direction is referred to as Y.

Print Modes

<Paper Type>

Auto Sense Mode

Tray 1 Autosense

Configure which mode is associated with which paper
type.
Full Sensing (default)
Expanded Sensing
Transparency Only

Tray 2–4 Sensing

Expanded Sensing
Transparency Only
(default)
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When Expanded Sensing is selected, the device
recognizes normal paper, overhead transparencies,
glossy paper, and tough paper. When Transparency
Only is selected, the device recognizes only overhead
transparency and non-overhead transparency types.
When Expanded Sensing is selected, the device
recognizes normal paper, overhead transparencies,
glossy paper, and tough paper. When Transparency
Only is selected, the device recognizes only overhead
transparency and non-overhead transparency types.
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Table 2-16 Print Quality menu (continued)
Menu item

Sub-menu item

Optimize

CACO3

Values

Description
In countries/regions where paper is expensive, this
compound is added to paper to make it less expensive
to produce. This compound makes the paper dusty,
which affects print quality.

Background1
Background2
Registration
Long Paper
Pre-rotation
Re-transfer
Tray 1
Belt Contact
Restore Optimize
Color REt

Enabled (default)
Disabled

Calibration/Cleaning

Auto Cleaning

Enabled
Disabled (default)

Cleaning Interval

1000
(default)

Enable or disable Resolution Enhancement
technology (REt), which produces print output with
smooth angles, curves, and edges.
When auto-cleaning is on, the device prints a cleaning
page when the page count reaches the value that is set
in Cleaning Interval.
Set the interval when the cleaning page should be
printed. The interval is measured by the number of
pages printed.

2000
5000
10000
20000
Auto Cleaning Size

Letter

Select the size of paper to use for the cleaning page.

A4
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Process Cleaning Page

Process

Use this feature to create and process a cleaning page
for cleaning excess toner off the pressure roller in the
fuser. The process takes up to 2.5 minutes.

Quick Calibration

Calibrate

Performs partial MFP calibrations.

Full Calibration

Calibrate

Performs all MFP calibrations.

Print Quality menu
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Troubleshooting menu
Administration > Troubleshooting
NOTE Many of the menu items under the Troubleshooting menu are for advanced
troubleshooting purposes.
Table 2-17 Troubleshooting menu
Menu item

Sub-menu item

Sub-menu item

Values

Description

Event Log

Print

This shows the event codes and their
corresponding engine cycles on the controlpanel display.

Calibrate Scanner

Calibrate

Use this feature to compensate for offsets in
the scanner imaging system (carriage head)
for ADF and flatbed scans.
You might need to calibrate the scanner if it
is not capturing the correct sections of
scanned documents.

PQ Troubleshooting
Fax T.30 Trace

Print
Print T.30 Report
When to Print Report

Never auto print
(default)

Print various diagnostic pages that help solve
print-quality problems.
Print or configure the fax T.30 trace report. T.
30 is the standard that specifies
handshaking, protocols, and error correction
between fax machines.

Print after any fax job
Print after fax send
jobs
Print after any fax
error
Print after send
errors only
Print after receive
errors only
Fax Transmit Signal
Loss

A value between 0
and 30. The default is
0.

Set loss levels to compensate for phone-line
signal loss. Do not modify this setting unless
requested to do so by an HP service
representative because it could cause the fax
to stop functioning.

Fax V.34

Normal (default)

Disable V.34 modulations if several fax
failures have occurred or if phone line
conditions require it.

Off
Fax Speaker Mode

Normal (default)
Diagnostic

Paper Path Sensors
Diagnostic Page
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A technician can use this feature technician
to evaluate and diagnose fax issues by
listening to the sounds of fax modulations.
Initiate a test of the paper-path sensors.

Print

Print a diagnostic page that includes color
swatches and the EP parameters table.
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Disable Cartridge
Check

Paper Path Test

Description
Use this item to enter a mode where a
cartridge (or color pair of cartridge and drum)
can be removed to determine which particular
color is the source of a problem. In this mode,
all consumable-related errors are ignored.

Test Page

Print

Generate a test page for testing the paperhandling features. Define the path for the test
in order to test specific paper paths.

Source

All trays

Specify whether the test page is printed from
all trays or from a specific tray.

Tray 1
Tray 2
(Additional trays are
shown, if applicable.)
Destination

All bins
Stacker Bin

Select the output option for the test page.
Send the test page to all output bins or only
to a specific bin.

Standard Output Bin
Duplex

Off (default)

Select whether the duplexer should be
included in the test.

On
Copies
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Range: 2-30,
Default=2

Select how many pages should be sent from
the specified source as part of the test.
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Finishing Paper Path
Test

Staples

Finishing Options

Choose from a list of
available options.

Test the paper-handling features on the
finisher.
Select the option that you want to test.

Media Size

Letter

Select the paper size for the test.

Legal
A4
Executive (JIS)
8.5 x 13
Media Type

Select from a list of
types.

Select the paper type for the test.

Copies

Range: 2-30,
Default=2

Select the number of copies to include in the
test.

Duplex

Off

Select whether to use the duplexer in the test.

On

Stack

Test Page

Print

Print a test page to use for the test.

Media Size

Letter

Select the options that you want to use to test
the stacker.

Legal
A4
Executive (JIS)
8.5 x 13
Media Type

Select from a list of
types.

Select the type of media to use for the
Finishing Paper Path Test.

Copies

1

Select the number of copies to include in the
Finishing Paper Path Test.

10
50
100
500
Duplex

Off

Select whether to use the duplexer in the
Finishing Paper Path Test.

On
Test Page

Print

Print a test page to use for the Finishing
Paper Path Test.

Manual Sensor Test
1

This item performs tests to determine
whether the paper-path sensors are
operating correctly.

Manual Sensor Test
2

This item performs tests to determine
whether the paper-path sensors are
operating correctly.
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Component Test

Exercise individual parts independently to
isolate noise, leaking, or other issues. To start
the test, select one of the components. The
test runs the number of times specified in the
Repeat option. You might be prompted to
remove parts from the device during the test.
Press the Stop button to abort the test.

Print/Stop Test

Color Band Test

Test Page
Copies

Scanner Tests

Control Panel

Description

Continuous value
from 0 to 60,000
milliseconds.
Default: 0

Isolate faults by stopping the device during
the print cycle and observing where in the
process the image degrades. To run the test,
specify a stop time. The next job that is sent
to the device stops at the specified time in the
process.

Print

Prints a page that helps identify arcing in the
high-voltage power supplies.
Specify the number of copies to print for the
Color Band test
A service technician can use this menu item
to diagnose potential problems with the
device scanner.

LEDs
Display

Verify that the components of the control
panel are functioning correctly.

Buttons
Touchscreen
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Resets menu
Administration > Resets
Table 2-18 Resets menu
Menu item

Values

Description

Clear Local Address Book

Clear

Use this feature to clear all addresses from the address books that
are stored on the device.

Clear Fax Activity Log

Yes

Use this feature to clear all events from the Fax Activity Log.

No (default)
Restore Factory Telecom Setting Restore

Use this option to restore the following settings to their factory default
settings: Transmit Signal Loss, V34, Maximum Baud Rate, Speaker
Mode.

Restore Factory Settings

Restore

Use this feature to restore all device settings to their factory defaults.

Clear Document Feeder
Message

Clear

Use this feature to clear the Order Document Feeder Kit and Replace
Document Feeder Kit warning messages.

Reset Supplies

New Document Feeder Kit (Yes/
No)

Notify the device that a new document-feeder kit has been
installed.
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Service menu
Administration > Service
The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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Service menu
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Supported Windows versions

●

Install the printing-system software

●

Supported printer drivers

●

Remove software for Windows

●

Select the correct printer driver

●

Priority for print settings

●

Open the printer drivers
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Supported Windows versions
Software

Windows 2000R/XPR/Server 2003R/VistaTM

Windows Installer

x

PCL 5 driver software1

x

PCL 6 driver software (black only)

x

PCL 6 driver software

x

PostScript emulation

x

HP Easy Printer Care1

x

HP Web Jetadmin1

x

Universal Print Driver

x

1

Available only on the World Wide Web.

You can also purchase the optional HP Digital Sending Software, which provides the following advanced
functionality:
●

LAN fax

●

Internet fax

●

Windows fax

●

Workflow with OCR

●

Compatibility with Novell environments (authentication, folder access, etc.)

●

User authentication

For more information about HP Digital Sending Software and a free trial version, go to
http://www.hp.com/go/digitalsending.
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Install the printing-system software
The MFP comes with a CD that contains printer driver and installation software for Windows and
Macintosh operating systems. Install the printing system software to take full advantage of the MFP
features.
If you do not have access to a CD-ROM drive, download the printing-system software from the Internet
at http://www.hp.com/support/ljcm4730mfp.

Install Windows printing-system software for direct connections (USB or
parallel)
This section explains how to install the printing-system software for the following Microsoft operating
systems:
●

Windows 2000

●

Windows Server 2003

●

Windows XP

●

Windows Vista
NOTE Do not connect the parallel or USB cable until the software prompts you to do so. If the
parallel or USB cable was connected before the software installation, see Install the software
after the parallel or USB cable has been connected.

1.

Close all software programs that are open or running.

2.

Insert the MFP CD into the CD-ROM drive. If the welcome screen does not open, use the following
procedure:
●

On the Start menu, click Run.

●

Type X:\setup (where X is the letter of the CD-ROM drive).

●

Click OK.

3.

When prompted, click Install and follow the instructions on the computer screen.

4.

Click Finish when the installation is complete. You might need to restart the computer.

5.

Print a Test Page or a page from any software program to make sure that the software is correctly
installed.

If installation fails, reinstall the software. If this fails, check the installation notes and Readme files on
the MFP CD or go to http://www.hp.com/support/ljcm4730mfp for help or more information.

Install Windows printing-system software for networks
The software on the MFP CD supports Microsoft network installation. For information about network
installation on other operating systems, go to http://www.hp.com/support/ljcm4730mfp.
The HP Jetdirect embedded print server includes a 10/100 Base-TX network port. If you need an
HP Jetdirect print server with another type of network port, go to http://www.hp.com/support/
ljcm4730mfp.
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The installer does not support MFP installation or MFP object creation on Novell servers. To install your
MFP and create objects on a Novell server, use an HP utility (such as HP Web Jetadmin) or a Novell
utility (such as NWAdmin).
You must have administrator privileges to install software in Windows 2000, Windows Server 2003,
Windows XP, or Windows Vista.
1.

Before installation, print a configuration page (see Information pages). On the last page, locate the
MFP IP address. You will need this address to complete the network installation.

2.

Quit all unnecessary software programs.

3.

Insert the MFP CD into the CD-ROM drive. If the welcome screen does not open, use the following
procedure:
●

On the Start menu, click Run.

●

Type X:\setup (where X is the letter of the CD-ROM drive).

●

Click OK.

4.

When prompted, click Install and follow the onscreen instructions. Click Finish when installation
has completed. You might need to restart the computer.

5.

Print a test page or a page from any software program to make sure that the software is correctly
installed. If installation fails, reinstall the software. If this fails, check the installation notes and
Readme files on the MFP CD or the flyer that came in the MFP box, or go to http://www.hp.com/
support/ljcm4730mfp.

Use Windows-sharing on a network
If the computer will print directly to the MFP, you can share the MFP on the network so that other network
users can print to it. See your Microsoft Windows documentation to enable Windows-sharing. Then
install the MFP software on all computers that share the MFP.

Install the software after the parallel or USB cable has been connected
If you have already connected a parallel or USB cable to a Windows computer, the New Hardware
Found dialog box appears when you turn on the computer.
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1.

In the New Hardware Found dialog box, click Search.

2.

On the Locate Driver Files screen, select the Specify a Location check box, clear all other check
boxes, and then click Next.

3.

Type the letter for the root directory. For example, X:\ (where "X" is the letter of the root directory
on the CD-ROM drive).

4.

Click Next.

5.

Follow the instructions on the computer screen.

6.

Click Finish when installation is complete.

7.

Select a language and follow the instructions on the computer screen.

8.

Print a test page or a page from any software program to make sure that the software is correctly
installed.
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If installation fails, reinstall the software. If this fails, check the installation notes and readme files
on the MFP CD or the flyer that came in the MFP box, or go to http://www.hp.com/support/
ljcm4730mfp.
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Supported printer drivers
Operating system

PCL 5

PCL 6

PS level 3 emulation

Windows
Mac OS X V10.2 and later
Linux1

For Linux, download the postscript level 3 emulation driver from www.hp.com/go/linuxprinting.
The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.
1
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Remove software for Windows

ENWW

1.

Click the Windows Start menu, and then click Settings and Control Panel.

2.

Double-click Add or Remove Programs.

3.

Click the software you want to remove.

4.

Click Remove.

5.

Follow any on-screen instructions to complete the uninstallation.

Remove software for Windows
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Select the correct printer driver
Printer drivers provide access to the device features and allow the computer to communicate with the
MFP by using a printer language.
●

HP PCL 5 driver. Recommended for general office Windows monochrome and color printing.
Backward compatible with previous PCL versions or older LaserJet printers. Best choice for thirdparty/custom solutions (forms, fonts, SAP programs) or mixed environments (UNIX, Linux,
mainframe).

●

HP PCL 6 driver. Recommended for printing in all-Windows environments. Provides the overall
best performance, print quality, and printer-feature support for most users. Developed to align with
Windows Graphic Device Interface (GDI) for best performance in Windows environments. May not
be fully compatible with third-party and custom solutions based on PCL 5. A monochrome (blackonly) version of the HP PCL 6 driver is also available.

●

HP PostScript driver. Recommended for printing with Adobe applications or other highly graphicsintensive applications. Best for PS level 3 needs and PS font support. Slight performance benefit
over PCL 6 when using Adobe applications.

The printer drivers include online Help that has instructions for common printing tasks and describes
the buttons, checkboxes, and drop-down lists that the driver contains.

Universal printer drivers
The HP Universal Print Driver Series for Windows includes separate HP postscript level 3 emulation
and HP PCL 5 versions of a single driver that provides access to almost any HP device while providing
system administrator with tools to manage devices more effectively. The Universal Print Driver is
included on the device CD, under the Optional Software section. For more information, go to
www.hp.com/go/universalprintdriver.

Driver Autoconfiguration
The HP LaserJet PCL 5, PCL 6, and PS level 3 emulation drivers for Windows 2000, Windows XP, and
Microsoft Vista feature automatic discovery and driver configuration for device accessories at the time
of installation. Some accessories that the Driver Autoconfiguration supports are the duplexing unit,
optional paper trays, and dual inline memory modules (DIMMs).
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Automatic Configuration
If you have modified the device configuration since installation, the driver can be automatically updated
with the new configuration. In the Properties dialog box (see Open the printer drivers), on the Device
Settings tab, select the Update Now option from the drop-down box to update the driver.
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Select the correct printer driver
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:
NOTE The names of commands and dialog boxes might vary depending on your software
program.
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●

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

●

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

●

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

●

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

●

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.
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Open the printer drivers
Operating System

To change the settings for all
print jobs until the software
program is closed

To change the default settings To change the device
for all print jobs
configuration settings

Windows 2000, XP,
Server 2003, and
Vista

1.

On the File menu in the
software program, click
Print.

1.

2.

Select the driver, and then
click Properties or
Preferences.

The steps can vary; this
procedure is most common.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).

1.

For Windows Vista, click
Start, click Control Panel,
and then click Printer.
2.

Mac OS X V10.2.8,
V10.3, V10.4 and
later

Right-click the driver icon,
and then select Printing
Preferences.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).
For Windows Vista, click
Start, click Control Panel,
and then click Printer.

2.

Right-click the driver icon,
and then select
Properties.

3.

Click the Device Settings
tab.

1.

On the File menu, click
Print.

1.

On the File menu, click
Print.

1.

In the Finder, on the Go
menu, click Applications.

2.

Change the settings that
you want on the various
pop-up menus.

2.

Change the settings that
you want on the various
pop-up menus.

2.

3.

On the Presets pop-up
menu, click Save as and
type a name for the preset.

Open Utilities, and then
open Print Center (Mac OS
X V10.2) Printer Setup
Utility (Mac OS X V10.3 or
Mac OS X V10.4).

3.

Click on the print queue.

4.

On the Printers menu, click
Show Info.

5.

Click the Installable
Options menu.

These settings are saved in the
Presets menu. To use the new
settings, you must select the
saved preset option every time
you open a program and print.

NOTE Configuration
settings might not be
available in Classic
mode.
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Software for Macintosh

●

Software for Macintosh computers

●

Remove software from Macintosh operating systems
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Software for Macintosh computers
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.
For network connections, use the embedded Web server (EWS) to configure the device. See
Embedded Web server.
The printing system software includes the following components:
●

PostScript Printer Description (PPD) files
The PPDs, in combination with the Apple PostScript printer drivers, provide access to device
features. Use the Apple PostScript printer driver that comes with the computer.

●

HP Printer Utility
Use the HP Printer Utility to set up device features that are not available in the printer driver:
●

Name the device.

●

Assign the device to a zone on the network.

●

Assign an internet protocol (IP) address to the device.

●

Download files and fonts.

●

Configure the device for IP or AppleTalk printing.

You can use the HP Printer Utility when your device uses a universal serial bus (USB) cable or is
connected to a TCP/IP-based network. For more information, see HP Printer Utility for
Macintosh.
NOTE The HP Printer Utility is supported for Mac OSX V10.2 or later.
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Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

ENWW

Remove software from Macintosh operating systems
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Software for other operating systems

●

HP Web Jetadmin

●

UNIX
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HP Web Jetadmin
Use HP Web Jetadmin to manage HP Jetdirect-connected printers within your intranet. HP Web
Jetadmin is a browser-based management tool that can be installed on the following systems:
●

Fedora Core and SuSE Linux

●

Windows 2000 Professional, Server, and Advanced Server

●

Windows Server 2003

●

Windows XP Professional

When installed on a host server, any client can access HP Web Jetadmin through a supported Web
browser, such as Microsoft Internet Explorer 5.5 and 6.0 or Netscape Navigator 7.0.
HP Web Jetadmin has the following features:
●

The task-oriented user interface provides configurable views, saving network managers significant
time.

●

The customizable user profiles let network administrators include only the function viewed or used.

●

Instant e-mail notification of hardware failure, low supplies, and other MFP problems.

●

Installation and management can be conducted from anywhere through a standard Web browser.

●

Advanced autodiscovery locates peripherals on the network, without manually entering each printer
into a database.

●

Integration into enterprise management packages is easy.

●

Quickly find peripherals based on parameters such as IP address, color capability, and model
name.

●

Easily organize peripherals into logical groups, with virtual office maps for easy navigation.

●

Manage and configure multiple printers simultaneously.

To download a current version of HP Web Jetadmin and to see the latest list of supported host systems,
visit HP Customer Care Online at http://www.hp.com/go/webjetadmin.
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UNIX
The HP Jetdirect Printer Installer for UNIX is a simple printer installation utility for HP-UX and Solaris
networks. It is available for download from HP Customer Care Online at http://www.hp.com/support/
net_printing.
NOTE Sample model scripts for UNIX (HP-UX, Sun Solaris) are available at http://www.hp.com/
go/unixmodelscripts. Sample model scripts for Linux networks are available at
http://linuxprinting.org.
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Parallel connection
Establish a parallel connection by connecting the MFP to the computer with a bidirectional parallel cable
(IEEE-1284C compliant) that has a c-connector. The cable can be a maximum of 10 meters (30 feet)
long.

Figure 6-1 Parallel port connection
1

C-connector

2

Parallel port

NOTE To use the enhanced capabilities of the bidirectional parallel interface, ensure that the
most recent printer driver is installed.
Factory settings support automatic switching between the parallel port and one or more network
connections on the MFP.
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USB connection
This MFP supports USB 2.0 device and host USB connections. The USB ports are located on the back
of the MFP. You must use an A-to-B type USB cable that is no longer than 2 meters (6.56 feet)

Figure 6-2 USB connection
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1

USB connector

2

USB port

USB connection
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Auxiliary connection
This MFP supports an auxiliary connection for paper handling input devices. The port is located on the
back of the MFP.
NOTE This connector cannot be used by the 3-bin mailbox or stapler/stacker accessories.

Figure 6-3 Auxiliary connection
1
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Auxiliary connection port (Jetlink)
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Network configuration
You might need to configure certain network parameters on the device. You can configure these
parameters in the following locations:
●

Installation software

●

Device control panel

●

Embedded Web server

●

Management software (HP Web Jetadmin or HP LaserJet Utility for Macintosh)
NOTE For more information about using the embedded Web server, see
Embedded Web server

For more information on supported networks and network configuration tools, see the HP Jetdirect Print
Server Administrator’s Guide. The guide comes with printers in which an HP Jetdirect print server is
installed.
This section contains the following information about configuring network parameters:
●

Configure TCP/IPv4 parameters

●

Configure TCP/IPv6 parameters

●

Disable network protocols (optional)

●

HP Jetdirect EIO print servers

Configure TCP/IPv4 parameters
If your network doesn't provide automatic IP addressing through DHCP, BOOTP, RARP, or another
method, you might need to enter the following parameters manually before you can print over the
network:
●

IP address (4 bytes)

●

Subnet mask (4 bytes)

●

Default gateway (4 bytes)

Change the IP address
You can view the current IP address of the device from the control-panel Home screen by touching
Network Address.
Use the following procedure to change the IP address manually.
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1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch TCP/IP.

Network configuration
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6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch IP Address.
12. Touch the IP Address text box.
13. Use the touchscreen keypad to type the IP address.
14. Touch OK.
15. Touch Save.

Set the subnet mask
1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch TCP/IP.

6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch Subnet Mask.
12. Touch the Subnet Mask text box.
13. Use the touchscreen keypad to type the subnet mask.
14. Touch OK.
15. Touch Save.

Set the default gateway
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1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.
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5.

Touch TCP/IP.

6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch Default Gateway.
12. Touch the Default Gateway text box.
13. Use the touchscreen keyboard to type the default gateway.
14. Touch OK.
15. Touch Save.

Configure TCP/IPv6 parameters
For information about configuring the device for a TCP/IPv6 network, see the HP Jetdirect Print Server
Administrator's Guide.

Disable network protocols (optional)
By factory default, all supported network protocols are enabled. Disabling unused protocols has the
following benefits:
●

It decreases device-generated network traffic.

●

It prevents unauthorized users from printing to the device.

●

It provides only pertinent information on the configuration page.

●

It allows the device control panel to display protocol-specific error and warning messages.

Disable IPX/SPX
NOTE Do not disable this protocol in Windows-based systems that print to the printer through
IPX/SPX.
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1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch IPX/SPX.

6.

Touch Enable.

Network configuration
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7.

Touch Off.

8.

Touch Save.

Disable AppleTalk
1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch AppleTalk.

6.

Touch Enable.

7.

Touch Off.

8.

Touch Save.

Disable DLC/LLC
1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch DLC/LLC.

6.

Touch Enable.

7.

Touch Off.

8.

Touch Save.

HP Jetdirect EIO print servers
HP Jetdirect print servers (network cards) can be installed in the EIO slot. Supported networking features
depend on the print server model. For available HP Jetdirect EIO print server models, go to
http://www.hp.com/go/jetdirect.
NOTE Configure the card through the control panel, the printer installation software, or HP Web
Jetadmin. Refer to the HP Jetdirect print server documentation for more information.
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Network utilities
The device is equipped with several utilities that make it easy to monitor and manage the device on a
network.

HP Web Jetadmin
HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be installed only on the network administrator’s computer.
To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.
When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later)
by navigating to the HP Web Jetadmin host.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.
The embedded Web server resides on the device. It is not loaded on a network server.
The embedded Web server provides an interface to the device that anyone who has a networkconnected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages.)
For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server.
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HP Easy Printer Care software
The HP Easy Printer Care software is a program that you can use for the following tasks:
●

Discovering printers on the network and checking the status of each device

●

Setting and viewing device and supplies alerts for multiple printers at the same time

●

Shopping online for supplies

●

Using HP online troubleshooting and maintenance tools

You can use the HP Easy Printer Care software when the device is directly connected to your computer
or a network running Windows. Macintosh is not supported. To download the HP Easy Printer Care
software, go to www.hp.com/go/easyprintercare.

Other components and utilities
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Windows

Macintosh OS

●

Software installer — automates the printing system
installation

●

●

Online Web registration

Chapter 6 Connectivity

The HP Printer Utility — change device settings, view
status, and set up printer-event notification from a Mac.
This utility is supported for Mac OS X V10.2 and later.
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:
●

Poor print quality

●

Increased jams

●

Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laserjets or multiuse. Do not
use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the
use of other brands of media because HP cannot control their quality.
It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.
CAUTION Using paper or print media that does not meet Hewlett-Packard's specifications
might cause problems for the product, requiring repair. This repair is not covered by the HewlettPackard warranty or service agreements.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.
NOTE To obtain best print results, select the appropriate paper size and type in your print driver
before printing.
Table 7-1 Supported paper and print media sizes
Size

Dimensions

Letter

216 x 279 mm (8.5 x 11 in.)

Legal

216 x 356 mm (8.5 x 14 in.)

A4

210 x 297 mm (8.27 x 11.69 in.)

Executive

184 x 267 mm (7.24 x 10.51 in.)

Executive
(JIS)

216 x 330 mm (8.5 x 13 in.)

A3

297 x 420 mm (11.69 x 16.54 in.)

A5

148 x 210 mm (5.83 x 8.27 in.)

A6

105 x 148 mm (4.13 x 5.83 in.)

Statement

140 x 216 mm (5.5 x 8.5 in.)

11 x 17

279 x 432 mm (11 x 17 in.)

12 x 18

305 x 457 mm (12 x 18 in.)

B4 (ISO)

250 x 353 mm (9.84 x 13.90 in.)

B4 (JIS)

257 x 364 mm (10.12 x 14.33 in.)

RA3

305 x 430 mm (12.01 x 16.93 in.)

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in.)

B5 (ISO)

176 x 250 mm (6.93 x 9.84 in.)

8k

270 x390 mm (10.63 x 15.35 in.)

16k

197 x 273 mm (7.75 x 10.75 in.)

Tray 1, mailbox,
stacker

Trays 2, 3, 4

Stapler

Tray 1, mailbox,
stacker

Trays 2, 3, 4

Stapler

Table 7-2 Supported envelopes and postcards
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Size

Dimensions

Envelope #10

105 x 241 mm (4.13 x 9.49 in.)

Envelope DL

110 x 220 mm (4.33 x 8.66 in.)

Envelope C5

162 x 229 mm (6.93 x 9.84 in.)

Envelope B5

176 x 250 mm (6.7 x 9.8 in.)

Envelope
Monarch

98 x 191 mm (3.9 x 7.5 in.)

Supported paper and print media sizes
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Table 7-2 Supported envelopes and postcards (continued)
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Size

Dimensions

Post Card

100 x 148 mm (3.94 x 5.83 in.)

Double Post
Card

148 x 200 mm (5.83 x 7.87 in.)

Postcard (US)

88.9 x 139.7 mm (3.5 x 5.5 in.)

Postcard
(European)

105 x 148 mm (4.13 x 5.83 in.)

Chapter 7 Paper and print media

Tray 1, mailbox,
stacker

Trays 2, 3, 4

Stapler
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Custom paper sizes
This product supports a variety of custom paper sizes. Supported custom sizes are sizes that are within
the minimum- and maximum-size guidelines for the product but are not listed in the supported paper
sizes table. When using a supported custom size, specify the custom size in the print driver, and load
the paper in a tray that supports custom sizes.
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Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.
CAUTION HP LaserJet printers use fusers to bond dry toner particles to the paper in very
precise dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not
designed for this technology could damage your printer.
Media type

Do

Envelopes

●

Store envelopes flat.

●

Use envelopes where the seam
extends all the way to the corner of
the envelope.
●

●

Use peel-off adhesive strips that
are approved for use in laser
printers.

●

Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.
Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

●

Do not use self-stick adhesives or
other synthetic materials.

●

Use only labels that have no
exposed backing between them.

●

Do not use labels that have wrinkles
or bubbles, or are damaged.

●

Use Labels that lie flat.

●

Do not print partial sheets of labels.

●

Use only full sheets of labels.

●

Use only transparencies that are
approved for use in laser printers.

●

Do not use transparent print media
not approved for laser printers.

●

Place transparencies on a flat
surface after removing them from
the product.

Letterhead or preprinted forms

●

Use only letterhead or forms
approved for use in laser printers.

●

Do not use raised or metallic
letterhead.

Heavy paper

●

Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

●

Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper

●

Use only glossy or coated paper
that is approved for use in laser
printers.

●

Do not use glossy or coated paper
designed for use in inkjet products.

Labels

Transparencies
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Load paper and print media
You can load different media in the trays and then request media by type or size by using the control
panel.

Load tray 1
CAUTION

To avoid jams, never add or remove media from tray 1 during printing.

1.

Open tray 1.

2.

Set the side guides to the desired width.

3.

Load media in the tray with the side to be printed on face down and the top of the media or nonpostage end facing you.

4.

Make sure the stack fits under the tabs on the guides and does not exceed the load-level indicators.

5.

Adjust the side guides so that they lightly touch the media stack but do not bend it.

If your software does not automatically format an envelope, specify Landscape for page orientation in
your software program or printer driver. Use the following guidelines to set margins for return and
destination addresses on Commercial #10 or DL envelopes:
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Address type

Left margin

Top margin

Return

15 mm (0.6 inches)

15 mm (0.6 inches)

Destination

102 mm (4 inches)

51 mm (2 inches)

For envelopes of other sizes, adjust the margin settings appropriately.

Load trays 2, 3, or 4
Trays 2, 3, and 4 each hold up to 500 sheets of standard paper or a 50.8 mm (2-inch) stack of labels.
Tray 2 stacks above the other 500-sheet trays.

Load standard-sized media into tray 2, 3, or 4
The MFP automatically detects the following standard sizes of media in these 500-sheet trays: letter,
legal, executive, A4, A5, and (JIS) B5.
The following undetectable standard-size media sizes are not marked in the trays but are listed in the
Size menu for each tray: 8.5 x 13, Executive (JIS), double Japan postcard, and custom.
CAUTION Do not print cardstock, envelopes, heavy or extra heavy paper, or unsupported sizes
of media from the 500-sheet trays. Print on these types of media only from tray 1. Do not overfill
the input tray or open it while it is in use. Doing so can cause jams in the MFP.
1.
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Slide the tray from the MFP.
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2.

Adjust the rear media-length guide by squeezing the guide adjustment latch and sliding the back
of the tray to the length of the media you are using.

3.

Slide the media-width guides open to the size for the media you are using.

Load paper and print media
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4.

Load media into the tray face up.

NOTE For best performance, fill the tray completely without splitting the ream of paper.
Splitting the ream can cause a multifeed problem. The capacity of the paper tray can vary.
For example, if you are using 75 g/m2 (20 lb) paper, the tray holds a full ream of 500 sheets.
If the media is heavier, the tray will not hold a full ream. Do not overfill the tray.
NOTE If the tray is not adjusted correctly, an error message might appear or the media
might jam.
5.

Slide the tray into the MFP. The MFP control panel shows the tray’s media type and size. If the
configuration is not correct, touch OK on the control panel. If the configuration is correct, touch
Exit.

Loading undetectable standard-sized media into tray 2, 3, and 4
The following undetectable standard-sized media is supported in the 500-sheet trays:
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●

Executive (JIS)

●

8.5 x 13

●

Double Japan postcard

●

16K
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CAUTION Do not print cardstock, envelopes, heavy or extra heavy paper, or unsupported sizes
of media from the 500-sheet trays. Print on these types of media only from tray 1. Do not overfill
the input tray or open it while it is in use. Doing so can cause paper jams.

Load custom-size media into tray 2
To use custom media, change the size setting on the control panel to Custom and set the unit of
measure, X dimension, and Y dimension. See Configure a tray to match print job settings for more
information.

ENWW

1.

Slide open the tray from the MFP.

2.

Continue loading the print media as described in steps 2 through 4 of the “Load detectable
(standard-size) media into tray 2, 3, or 4” section. Then proceed to step 3 in this procedure.

3.

Slide the tray into the MFP. The MFP control panel shows the tray type and size configuration. To
specify specific custom dimensions, or if the type is not correct, touch OK when the MFP prompts
to change the size or type.

4.

If the configuration is correct, touch Exit.

Load paper and print media
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Configure trays
The MFP automatically prompts you to configure a tray for type and size in the following situations:
●

When you load paper into the tray

●

When you specify a particular tray or media type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

The following message appears on the control panel:Tray <X> [type] [size] To change size or type,
touch “Modify”. To accept, touch “OK”..
NOTE The prompt does not appear if you are printing from tray 1 and tray 1 is configured for
Any Size and Any Type.
NOTE If you have used other HP LaserJet printer models, you might be accustomed to
configuring tray 1 to First mode or Cassette mode. On HP Color LaserJet CM4730 MFP series,
setting tray 1 size and type to Any Size is equivalent to First mode. Setting size or type for tray 1
to a setting other than Any Size is equivalent to Cassette mode.

Configure a tray when loading paper
1.

Load paper in the tray. Close the tray if you are using tray 2, 3, or 4.

2.

The tray configuration message appears.

3.

Touch OK to accept the detected size, or touch Modify to choose a different paper size.

4.

If modifying the tray configuration, select the size.
NOTE The MFP automatically detects most media sizes in trays 2, 3, and 4.

5.

If modifying the tray configuration, select the paper type.

6.

Touch Exit.

Configure a tray to match print job settings
1.

In the software program, specify the source tray, the paper size, and the paper type.

2.

Send the job to the MFP.
If the tray needs to be configured, the LOAD TRAY X: message appears.
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3.

If the highlighted size is not correct, touch X MILLIMETERS. Then use the numeric keypad to set
the X and Y dimensions.

4.

If the highlighted paper type is not correct, touch Paper Handling and select the paper type.

5.

Touch OK.

6.

Touch Exit.

Chapter 7 Paper and print media

ENWW

Configure a tray by using the Supplies Status menu
You can also configure the trays for type and size without a prompt from the MFP.
1.

Scroll to and touch Supplies Status.

2.

Touch the desired tray.

3.

Touch Modify.

4.

Select the size and type. If you select a custom type, use the numeric keypad to set the X dimension
and the Y dimension, and then touch OK.

5.

Touch OK.

6.

Touch OK again.

Automatic media type sensing (auto sense mode)
The automatic media type sensor functions only when that tray is configured to Any Type. Configuring
a tray to any other type, such as Bond or Glossy, deactivates the media sensor in that tray.
The HP Color LaserJet CM4730 Series printers can automatically classify media into one of the following
categories:
●

Plain

●

Transparency

●

Glossy

●

Extra-heavy glossy

●

Glossy film

●

Heavy

●

Light

Tray 1 sensing
Full sensing (default)
●

The printer stops at each page to sense media type. This is the best mode for using mixed media
in a single print job.

Expanded sensing
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●

Each time the printer begins a print job, it stops the first page to sense the type.

●

The printer assumes that the second and all subsequent pages are of the same media type as the
first page.

●

This is the second-fastest mode, and is useful for using stacks of the same media type.

Configure trays
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Transparency
●

The printer does not stop any pages for sensing but distinguishes between transparencies
(Transparency mode) and paper (Normal mode).

●

This is the fastest mode and is useful for high-volume printing in Normal mode.

Tray 2–4 sensing
Expanded sensing
●

The printer stops the first five pages fed from each paper tray to sense the type and averages the
five results.

●

The printer assumes that the sixth and all subsequent pages are of the same media type, until the
printer is turned off or goes into sleep mode, or until the tray is opened.

Transparency only (default)
●

The printer does not stop any pages for sensing but distinguishes between transparencies
(Transparency mode) and paper (Normal mode).

●

This is the fastest mode and is useful for high-volume printing in Normal mode.

Select the media by source, type, or size
In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull media
when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print, or Print
Properties dialog boxes in most software programs. Unless you change these settings, the MFP
automatically selects a tray using the default settings.

Source
To print by Source select a specific tray from MFP to pull from. The MFP tries to print from this tray, no
matter what type or size is loaded. If you select a tray that is configured for a type or size that does not
match your print job, the MFP does not print automatically. Instead, it waits for you to load the tray with
the type or size of print media for your print job. If you load the tray, the MFP begins printing.

Type and Size
Printing by Type or Size means that you want the MFP to pull from the tray that is loaded with the correct
type and size of media. Selecting media by type rather than source is similar to locking out trays and
helps protect special media from accidental use. For example, if a tray is configured for letterhead and
you select plain paper, the MFP will not pull the letterhead from that tray. Instead, it will pull from a tray
that has plain paper loaded and is configured for plain paper on the MFP control panel. Selecting media
by Type and Size results in significantly better print quality for heavy paper, glossy paper, and
transparencies. Using the wrong setting might result in unsatisfactory print quality. Always print by Type
for special print media, such as labels or transparencies. Print by Size for envelopes, if possible.
●

To print by Type or Size, select the Type or Size from the Page Setup dialog box, the Print dialog
box, or the Print Properties dialog box, depending on the software program.

●

If you often print on a certain type or size of media, configure a tray for that type or size. Then,
when you select that type or size as you print a job, the MFP pulls media from the tray that is
configured for that type or size.
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Select the output bin
Standard output bins
The MFP has an ADF output bin and the standard output bin for printed pages.

1

Standard output bin

2

ADF output bin (for copy originals)

When you scan or copy documents by using the ADF, the originals are automatically delivered to the
ADF output bin. Copies made from the scanner glass are delivered to the standard output bin or the
output bin(s) on the stapler/stacker or the 3-bin mailbox.
When you send print jobs to the MFP from a computer, the output is to the standard output bin or the
output bin(s) on the stapler/stacker or the 3-bin mailbox.

3-bin mailbox output bins
If you are using the 3-bin mailbox, three output bins are available. Configure these bins as individual
mailboxes, or combine them to function as a single bin to stack documents.
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1

3–bin mailbox output bins

2

ADF output bin (for copy originals)

The top two bins each hold up to 100 sheets of paper. A sensor stops the MFP when a bin is full. MFP
operation continues when you empty or reduce the amount of media in the bin.
The lower bin holds up to 500 sheets of paper.

Select an output location
If possible, select an output location (bin) through your program or driver. Where and how you make
selections depends on your program or driver. If you cannot select an output location from the program
or driver, set the default output location on the MFP control panel.
1.

Scroll to and touch Administration.

2.

Touch Default Job Options.

3.

Touch Default Copy Options or Default Print Options.

4.

Touch Output Bin.

5.

Touch the desired output bin.

Configure the 3-bin mailbox
Configure the printer driver to recognize the 3-bin mailbox in Windows
1.

Open the Printers folder.

2.

Select HP Color LaserJet CM4730 MFP.

3.

On the File menu, click on Properties.

102 Chapter 7 Paper and print media

ENWW

4.

Select the Device Settings tab.

5.

Use either of the following methods to select the stapler/stacker.
●

Scroll down to Automatic Configuration, select Update Now, and click Apply.

●

Scroll down to Accessory Output Bin, select HP 500 sheet stapler/stacker or HP 700 Sheet
3-bin Mailbox, and click Apply.

Configure the printer driver to recognize the 3-bin mailbox in Macintosh
1.

Open the Printer Center utility.

2.

Select HP Color LaserJet CM4730.

3.

On the File menu, click on Show Info (command, i).

4.

Select the Installable Options tab.

5.

Scroll to Accessory Output Bins and select HP 500 sheet stapler/stacker or HP 700 Sheet 3bin Mailbox.

6.

Click Apply Changes.

Select the 3-bin mailbox operating mode at the control panel
1.

Scroll to and touch Administration.

2.

Touch Device Behavior.

3.

Touch MBM–3 Configuration.

4.

Touch Operation Mode.

5.

Select the operation mode that you want to use.

Select the 3-bin mailbox operating mode in the printer driver
1.

Click the Start button, point to Settings, and then click Printers (for Windows 2000) or Printers
and Faxes (for Windows XP).

2.

Right-click the HP product icon, and then click Properties or Printing Preferences.

3.

Click the Device Settings tab.

4.

Perform one of the following actions:
For automatic configuration: under Installable Options, click Update Now in the Automatic
Configuration list.
-orFor manual configuration: under Installable Options, select the appropriate operation mode in the
Accessory Output Bin list.

5.
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Click OK to save the settings.
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Select the operating mode in the printer driver (Mac OS X)
1.

In the Apple menu, click System Preferences.

2.

In the System Preferences box, click Print and Fax.

3.

Click Set Up Printers. A Printer List displays.

4.

Select the HP product, and then click Show Info on the Printers menu.

5.

Select the Installable Options panel.

6.

In the Accessory Output Bins list, select HP 3-Bin Mailbox.

7.

In the Mailbox Mode list, select the appropriate operational mode, and then click Apply
Changes.
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Use product features

●

Economy settings

●

Job storage features
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Economy settings
Sleep and wake
Set the sleep delay
Use the sleep-delay feature to set the period of time that the MFP must be idle before it enters the sleep
mode. The default setting is 45 minutes.
1.

Scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Sleep Delay.

4.

Touch the sleep-delay setting that you want.

Set the wake time
Use the wake time feature to wake the MFP at a set time each day.
1.

Scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Wake Time.

4.

Touch the day of the week for the wake time.

5.

Touch Custom.

6.

Touch Save.

7.

Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

8.

If you want to wake the MFP at the same time each day, on the APPLY TO ALL DAYS screen,
touch Yes. If you want to set the time for individual days, touch No, and repeat the procedure for
each day.
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Job storage features
The following job-storage features are available for print jobs:
●

Proof and hold jobs: This feature provides a quick and easy way to print and proof one copy of
a job and then print the additional copies.

●

Personal jobs: When you send a private job to the device, the job does not print until you provide
the required personal identification number (PIN) at the control panel.

●

QuickCopy jobs: You can print the requested number of copies of a job and then store a copy of
the job on the device hard disk. Storing the job allows you to print additional copies of the job later.

●

Stored jobs: You can store a job such as a personnel form, time sheet, or calendar on the device
and allow other users to print the job at any time. Stored jobs also can be protected by a PIN.

Follow the instructions in this section to gain access to the job storage features at the computer. See
the specific section for the type of job that you want to create.
CAUTION
deleted.

If you turn off the device, all QuickCopy, proof and hold, and personal jobs are

Gain access to the job storage features
For Windows
1.

On the File menu, click Print.

2.

Click Properties, and then click the Job Storage tab.

3.

Select the job storage mode that you want.

For Macintosh
In newer drivers: Select Job Storage in the pull-down menu in the Print dialog box. In older drivers,
select Printer Specific Options.
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Use the proof and hold feature
The proof and hold feature provides a quick and easy way to print and proof one copy of a job and then
to print the additional copies.
To permanently store the job and prevent the device from deleting it when space is needed for something
else, select the Stored Job option in the driver.

Create a proof and hold job
CAUTION If the device needs additional space to store newer proof and hold jobs, the device
deletes other stored proof and hold jobs, starting with the oldest job. To permanently store a job
and prevent the device from deleting it when space is needed, select the Stored Job option in
the driver instead of the Proof and Hold option.
In the driver, select the Proof and Hold option and type a user name and job name.
The device prints one copy of the job for you to proof.

Print the remaining copies of a proof and hold job
At the device control panel, use the following procedure to print the remaining copies of a job held on
the hard disk.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to print.

5.

Touch the Copies field to change the number of copies to print. Touch Retrieve Stored Job ( ) to
print the document.

Delete a proof and hold job
When you send a proof and hold job, the device automatically deletes your previous proof and hold job.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to delete.

5.

Touch Delete.

6.

Touch Yes.
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Use the personal job feature
Use the personal printing feature to specify that a job is not printed until you release it. First, set a 4digit PIN by typing the PIN in the printer driver. The PIN is sent to the device as part of the print job.
After you have sent the print job to the device, you must use the PIN to print the job.

Create a personal job
To specify that a job is personal, in the driver, select the Personal Job option, type a user name and job
name, and then type a four-digit PIN into the Make Job Private field. The job will not print until you enter
the PIN at the device control panel.

Print a personal job
You can print a personal job at the control panel after the job has been sent to the device.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the personal job.

4.

Scroll to and touch the personal job that you want to print.
NOTE A personal job will have a

[lock symbol] next to it.

5.

Touch the PIN field.

6.

Use the numeric keypad to type the PIN, and then touch OK.

7.

Touch the Copies field to change the number of copies to print.

8.

Touch Retrieve Stored Job ( ) to print the document.

Delete a personal job
A personal job is automatically deleted from the device hard disk after you release it for printing. If you
want to delete the job without printing it, use this procedure.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the personal job.

4.

Scroll to and touch the personal job that you want to delete.
NOTE A personal job will have a
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[lock symbol] next to it.)

5.

Touch the PIN field.

6.

Use the numeric keypad to type the PIN, and then touch OK.

7.

Touch Delete.
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Use the QuickCopy feature
The QuickCopy feature prints the requested number of copies of a job and stores a copy on the device
hard disk. Additional copies of the job can be printed later. This feature can be turned off in the printer
driver.
The default number of different QuickCopy jobs that can be stored on the device is 32. At the control
panel, you can set a different default number. See Navigate the Administration menu.

Create a QuickCopy job
CAUTION If the device needs additional space to store newer QuickCopy jobs, the device
deletes other stored QuickCopy jobs, starting with the oldest job. To permanently store a job and
prevent the device from deleting it when space is needed, select the Job Storage option in the
driver instead of the QuickCopy option.
In the driver, select the QuickCopy option, and then type a user name and a job name.
When you send the job to print, the device prints the number of copies that you set in the driver. To print
more quick copies at the device control panel, see Print additional copies of a QuickCopy job.

Print additional copies of a QuickCopy job
This section describes how to print additional copies of a job stored on the device hard disk at the control
panel.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to print.

5.

Touch the Copies field to change the number of copies to print.

6.

Touch Retrieve Stored Job ( ) to print the document.

Delete a QuickCopy job
Delete a QuickCopy job at the device control panel when you no longer need it. If the device requires
additional space to store new QuickCopy jobs, the device automatically deletes other stored QuickCopy
jobs, starting with the oldest job.
NOTE Stored QuickCopy jobs can be deleted at the control panel or in HP Web Jetadmin.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to delete.

5.

Touch Delete.

6.

Touch Yes.
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Use the stored job feature
You can save a print job to the device hard disk without printing it. You can then print the job at any time
at the device control panel. For example, you might want to download a personnel form, calendar, time
sheet, or accounting form that other users can print when they need it.
You also can create a stored copy job at the device control panel that can be printed at a later time.

Create a stored copy job
1.

Place the original document face-down on the glass or face-up in the ADF.

2.

From the Home screen, touch Job Storage.

3.

Touch the Create tab.

4.

Specify the name for the stored job in one of these ways:
●

Select an existing folder from the list. Touch New Job and type a job name.

●

Touch the box below the existing Folder Name: or Job Name: on the right-hand side of the
screen, and then edit the text.

5.

A private stored job has a lock icon next to the name, and it requires that you specify a PIN to
retrieve it. To make the job private, select Make Job Private and then type the PIN for the job. Touch
OK.

6.

Touch More Options to view and change other job storage options.

7.

After all the options are set, touch Create Stored Job ( ) in the upper-left corner of the screen to
scan the document and store the job. The job is saved on the device until you delete it, so you can
print it as often as necessary.
For information about printing the job, see Print a stored job.

Create a stored print job
In the driver, select the Stored Job option, and then type a user name and job name. The job does not
print until someone requests it at the device control panel. See Print a stored job.

Print a stored job
At the control panel, you can print a job that is stored on the device hard disk.
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1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the stored job.

4.

Scroll to and touch the stored job that you want to print.

5.

Touch Retrieve Stored Job ( ) to print the document.

6.

Touch the Copies field to change the number of copies to print.

7.

Touch Retrieve Stored Job ( ) to print the document.
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If the file has
job feature.

(lock symbol) next to it, the job is a private job and requires a PIN. See Use the personal

Delete a stored job
Jobs stored on the device hard disk can be deleted at the control panel.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the stored job.

4.

Scroll to and touch the stored job that you want to delete.

5.

Touch Delete.

6.

Touch Yes.

If the file has
feature.

(lock symbol) next to it, the job requires a PIN to delete it. See Use the personal job
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●

Media type and tray loading

●

Windows printer-driver features

●

Macintosh printer-driver features

●

Staple documents

●

Cancel a print job
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Media type and tray loading
Minimum media dimensions are 76 x 127 mm (3 x 5 inches).
Maximum media dimensions are 216 x 356 mm (8.5 x 14 inches).
Table 9-1 Tray 1 media information
Media type

Media
specifications

Media quantity

Driver settings

Paper orientation

Paper and
cardstock,
standard sizes

Range:

Maximum stack
height: 10 mm (0.6
inch)

Plain or
unspecified

N/A

60 g/m2 (16 lb)
bond to 220 g/m2
(60 lb) bond

Equivalent to 100
sheets of 75 g/m2
(20 lb) bond.

Envelopes

Less than 60 g/m2
(16 lb) bond to 90
g/m2 (24 lb) bond

Up to 20 envelopes

Envelope

Short edge
leading, flap on
right side facing up

Labels

Maximum 0.23 mm
(0.009 in.) thick

Maximum stack
height: 10 mm (0.6
inch)

Labels

Side to be printed
on facing up

Transparencies

Minimum 0.13 mm
(0.005 in.) thick

Maximum stack
height: 10 mm (0.6
inch)

Transparencies

Side to be printed
on facing up

Heavy

0.13 mm (0.005
in.) thick

Maximum stack
height: 10 mm (0.6
in.)

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up

Glossy

Range:

Maximum stack
height: 10 mm (0.6
in.)

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up

75 g/m2 (20 lb)
bond to 220 g/m2
(60 lb) bond

Output

Table 9-2 Tray 2, tray 3, and tray 4 media information
Media type

Media
specifications

Media quantity

Driver settings

Paper orientation

Paper and
cardstock,
standard sizes

Range:

Equivalent to 530
sheets of 75 g/m2
(20 lb) bond.

Plain or
unspecified

N/A

60 g/m2 (16 lb)
bond to 120 g/m2
(32 lb) bond

Labels

Maximum 0.13 mm
(0.005 in.) thick

Maximum stack
height: 56 mm (2.2
inch)

Labels

Side to be printed
on facing up

Transparencies

Minimum 0.13 mm
(0.005 in.) thick

Maximum stack
height: 56 mm (2.2
inch)

Transparencies

Side to be printed
on facing up
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Table 9-2 Tray 2, tray 3, and tray 4 media information (continued)
Media type

Media
specifications

Media quantity

Driver settings

Paper orientation

Heavy

0.13 mm (0.005
in.) thick

Maximum stack
height: 56 mm (2.2
in.)

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up

Glossy

Range:

Maximum stack
height: 56 mm (2.2
in.)

Light glossy,
glossy, or heavy
glossy

Side to be printed
on facing up

75 g/m2 (20 lb)
bond to 120 g/m2
(32 lb) bond
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Windows printer-driver features
Create and use printing shortcuts in Windows
Use printing shortcuts to save the current driver settings for reuse. Shortcuts are available on most
printer-driver tabs. You can save up to 25 printing shortcuts.
Create a printing shortcut
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Select the print settings that you want to use. Click Save As.

4.

In the Printing Shortcuts box, type a name for the shortcut.

5.

Click OK.

Use printing shortcuts
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Select the shortcut that you want to use from the Printing Shortcuts box.

4.

Click OK.
NOTE To use printer-driver default settings, select Factory Default.

Set a custom paper size
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, click Custom.

4.

On the Custom Paper Size window, type the name of the custom paper size.

5.

Type the paper-size length and width. If you type a size that is too small or too large, the driver
adjusts the size to the minimum or maximum size that is allowed.

6.

If necessary, click the button to change the unit of measure between millimeters and inches.

7.

Click Save.

8.

Click OK. The name that you saved appears in the paper-size list for future use.

Use different paper and print covers
Follow these instructions for printing a first page that is different from other pages in the print job.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.
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3.

Click the Paper/Quality tab.

4.

In the Special pages list box, click Print pages on different paper.

5.

Click Settings.

6.

Select the settings that you want to use to print specific pages on different paper. Click Add.

7.

Click OK to return to the Paper/Quality tab.

8.

Click OK.
NOTE The paper size must be the same for all pages of the print job.

Print a blank first page
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Paper/Quality tab.

4.

In the Special pages list box, click Covers.

5.

Click Settings.

6.

Select the settings that you want to use to add blank or preprinted covers. Click Add.

7.

Click OK to return to the Paper/Quality tab.

8.

Click OK.

Use watermarks
A watermark is a notice, such as "Confidential," that is printed in the background of each page of a
document.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

From the Effects tab, click the Watermarks drop-down list.

4.

Click the watermark that you want to use. To create a new watermark, click Edit.

5.

If you want the watermark to appear only on the first page of the document, click First Page
Only.

6.

Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.

Resize documents
Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.
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Reduce or enlarge a document
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Effects tab, next to % of Actual Size, type the percentage by which you want to reduce or
enlarge your document.
You can also use the scroll bar to adjust the percentage.

4.

Click OK.

Print a document onto a different paper size
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Effects tab, click Print Document On.

4.

Select the paper size to print on.

5.

To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6.

Click OK.

Print multiple pages on one sheet of paper in Windows
You can print more than one page on a single sheet of paper.

1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Finishing tab.

4.

In the section for Document Options, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5.

If the number of pages is greater than 1, select the correct options for Print Page Borders and
Page Order.
●

6.

If you need to change the page orientation, click Portrait or Landscape.

Click OK. The product is now set to print the number of pages per sheet that you have selected.

118 Chapter 9 Print tasks

ENWW

Print on both sides of the page (duplex printing)
Automatic two-sided (duplex) printing
Specify two-sided printing options in your software program or in the printer driver. If you cannot see
this option, use the following information to make the duplex printing options available.
●

Verify that the printer driver is configured to show the two-sided printing options: automatic and
manual. To change or verify the configuration, click the Start button, choose Settings, and click
Printers and Faxes. Then right-click on the printer and select Properties. On the Device
Settings tab, verify that the duplexer is shown as installed and that the Allow Manual
Duplexing option is enabled.

●

After the two-sided printing option appears, select the appropriate settings in the printer-driver
software, including the page and binding orientation.

●

Automatic two-sided printing is not supported for certain media types:
●

Transparencies

●

Envelopes

●

Labels

●

Heavy, extra heavy, cardstock, and HP Tough paper

The maximum weight paper for automatic duplex printing is 120 g/m2 (32 lb) bond.
●

ENWW

Automatic two-sided printing only supports the following media sizes:
●

Letter

●

Legal

●

B5

●

Executive

●

8.5 x 13

●

A4

●

Manual two-sided printing can support all sizes and more types of media, excluding transparencies,
envelopes, and labels

●

If both automatic and manual two-sided printing are enabled, the MFP will automatically print on
two sides if the duplexer supports the selected size and type. Otherwise, manual duplex will be
enabled.

●

For best results, avoid using rough-textured, heavyweight media when duplexing.

●

When using special media such as letterhead or forms, place the media face down in tray 2, 3, or
4, with the logo to the left. Place special media face down in tray 1, with the logo feeding into the
MFP last.
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Enable or disable automatic two-sided printing from the control panel
If you cannot adjust two-sided printing settings in your software program or printer driver, adjust them
on the control panel. The factory default setting is 1-sided.
CAUTION Do not use two-sided printing when printing on labels. Serious damage can result.
NOTE Changing settings for two-sided printing on the MFP control panel affects all print jobs.
Whenever possible, change settings for two-sided printing through your software program or
printer driver.
NOTE Any changes made in the printer driver override settings made on the MFP control panel.
1.

Scroll to and touch Administration.

2.

Touch Default Job Options.

3.

Touch Default Print Options

4.

Touch Print Sides.

5.

Touch 2-sided.

6.

Touch Save.

Enable or disable automatic two-sided printing in the printer driver
CAUTION Do not use two-sided printing when printing on labels. Serious damage can result.
NOTE In the printer driver, Print on Both Sides (manually) is available only when the duplex
printing accessory does not support the type of print media being used.
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Enable or disable automatic two-sided printing in the Windows printer driver
1.

Insert enough paper into one of the trays to accommodate the print job.
CAUTION Do not load media that is heavier than 105 g/m2 (28 lb bond). This can jam the
MFP.

2.

Open the printer driver.

3.

On the Finishing tab, click Print on Both Sides.

4.

Click OK.

Layout options for printing on both sides
The following are the four duplex orientation options. To select option 1 or 4, select Flip Pages Up in
the printer driver.

1

2

3

4

1. Long-edge landscape

This layout is often used in accounting, data processing, and
spreadsheet programs. Every other printed image is oriented
upside-down. Facing pages are read continuously from top to
bottom.

2. Short-edge landscape

Each printed image is oriented right-side-up. Facing pages are
read from top to bottom on the left page, and then from top to
bottom on the right page.

3. Long-edge portrait

This is the default setting, and the most common layout used,
with every printed image oriented right-side-up. Facing pages
are read from top to bottom on the first page, and then from
top to bottom on the second page.

4. Short-edge portrait

This layout is often used with clipboards. Every other printed
image is oriented upside-down. Facing pages are read
continuously from top to bottom.

Options for binding two-sided printing jobs
Before printing a two-sided document, use the printer driver to select the binding. Long-edge or book
binding is the conventional layout used in book binding. Short-edge or tablet binding is the typical
calendar binding.
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NOTE The default binding setting is to bind on the long edge when the page is set up for portrait
orientation. To change to long-edge binding, click the Flip Pages Up check box.
Printing booklets
Some versions of the printer driver offer booklet-printing settings. Select binding on the left or right side
on letter, legal, or A4 paper size. Windows 2000 and XP support booklet printing for all paper sizes.

Manual two-sided (duplex) printing
If you want to print on two sides (duplex) on paper other than the supported sizes or weights (for example,
paper heavier than 120 g/m2 (32 lb) or very thin paper), you will have to go to the MFP and reinsert the
paper manually after the first side has printed.
CAUTION Do not use two-sided printing when printing on labels. Serious damage can result.
1.

Click the Windows Start button, point to Settings, and then click Printers and Faxes.

2.

Right-click the printer and select Properties.

3.

Click the Device Settings tab.

4.

Select Allow Manual Duplex.

5.

Select the appropriate size and type.

6.

On the Finishing tab, click Print on Both Sides or Print on Both Sides (Manually).

7.

The default binding option is to bind on the long edge of the paper in portrait layout. To change the
setting, click the Finishing tab and select the Flip pages up check box.

8.

Click OK. The Print on Both Sides instructions appear. Follow the instructions to finish printing
your document.
NOTE If the total number of sheets to be duplexed exceeds the tray 1 capacity for manual
duplex jobs, feed the top 100 sheets and press Menu. When prompted, feed the next 100 sheets
and press Menu. Repeat as necessary until all the sheets from the output stack have been loaded
into tray 1.

Layout options for printing on both sides
The four duplex orientation options are shown here. To select option 1 or 4, select Flip Pages Up in the
printer driver.
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1

3

2

4

1. Long-edge landscape

Every other printed image is oriented upside-down. Facing pages are read
continuously from top to bottom.

2. Short-edge landscape

Every printed image is oriented right-side-up. Facing pages are read from top to
bottom.

3. Long-edge portrait

This is the default setting, and the most common layout used. Every printed image
is oriented right-side-up. Facing pages are read from top to bottom.

4. Short-edge portrait

Every other printed image is oriented upside-down. Facing pages are read
continuously from top to bottom.

Create booklets
You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Finishing tab.

4.

Select Print On Both Sides.

5.

In the drop-down box for Booklet Layout, select either Left Edge Binding or Right Edge
Binding. The Pages per Sheet setting automatically changes to 2 pages per sheet.

6.

Click OK.

Set the stapling options
Select the stapler in the printer driver
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1.

Click Start, point to Settings, and then click Printers (for Windows 2000) or Printers and
Faxes (for Windows XP and Vista).

2.

Right-click the HP product icon, and then click Properties or Printer Preferences.
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3.

Click the Device Settings tab.

4.

On the Output tab, click the drop-down list under Staple, and click One-edge.

Configure the printer driver to recognize the optional stapler stacker
1.

Open the Printers folder.

2.

Select HP Color LaserJet CM4730 MFP.

3.

On the File menu, click Properties.

4.

Select the Device Settings tab.

5.

Use either of the following methods to select the stapler/stacker:
Scroll to Automatic Configuration, select Update Now, and then click Apply.
-orScroll to Accessory Output Bin, select HP 500-sheet stapler/stacker or HP 3-bin mailbox
mailbox-mode or HP 3-bin mailbox stacker-mode or HP 3-bin mailbox function-separator,
and click Apply.

Setting the color options
Options on the Color tab control how colors are interpreted and printed from software programs. You
can choose either Automatic or Manual color options. For more information, see Manage printer color
options on Windows computers.
●

Select Automatic to optimize the color and halftone settings for text, graphics, and photographs.
The Automatic setting provides additional color options for programs and operating systems that
support color-management systems. This setting is recommended for printing all color documents.

●

Select Manual to adjust the color and halftone settings for text, graphics, and photographs. If you
are using a PCL driver, you can adjust the RGB data. If you are using the PS driver, you can adjust
RGB or CMYK data.

To set the color options
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Color tab.

4.

In the Color Options area, select the option that you want to use.

5.

If you selected Manual, click Settings to open the Color Settings dialog box. Adjust the individual
settings for text, graphics, and photographs. You can also adjust the general printing settings. Click
OK.

6.

In the Color Themes area, select the RGB Color option that you want to use.

7.

Click OK.
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Use the Services tab
If the product is connected to a network, use the Services tab to obtain product and supply-status
information. Click the Device and Supplies status icon to open the Device Status page of the
HP Embedded Web Server. This page shows the current status of the product, the percentage of life
remaining for each supply, and information for ordering supplies. For more information, see
Embedded Web server.
In the Internet Services area, select an option from the list to go to various support Web sites for this
device. Click Go!.

Using the HP Digital Imaging Options dialog box
Use HP Digital Imaging Options to print better-quality photos and images.
NOTE HP Digital Imaging Options are available for Windows 2000, Windows XP, Windows
Server 2003, and Vista.
The following options are available on the HP Digital Imaging Options dialog box:
●

Contrast Enhancement: Enhance colors and contrast for washed-out photos. Click Automatic
to allow the printer software to brighten areas of photos that need adjustment.

●

Digital Flash: Adjust the exposure in dark areas of photos to bring out detail. Click Automatic to
allow the printer software to balance lightness and darkness.

●

SmartFocus: Enhance the image quality and clarity of low resolution images such as those
downloaded from the Internet. Click On to allow the printer software to sharpen details in the image.

●

Sharpness: Adjust the image sharpness to your preference. Click Automatic to allow the printer
software to set the level of sharpening for the image.

●

Smoothing: Soften an image. Click Automatic to allow the printer software to set the level of
smoothing for the image.

Opening the HP Digital Imaging Options dialog box
1.

Open the Printer Properties dialog box.

2.

Click the Paper/Quality tab, and then click the HP Digital Imaging button.
NOTE If you installed the HP Image Zone software, you can use it to edit and further enhance
digital photos.
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Macintosh printer-driver features
Create and use printing shortcuts in Macintosh
Use printing shortcuts to save the current printer driver settings for reuse.
Create a printing shortcut
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Select the print settings.

4.

In the Printing Shortcuts box, click Save As..., and type a name for the shortcut.

5.

Click OK.

Use printing shortcuts
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

In the Printing Shortcuts box, select the printing shortcut that you want to use.
NOTE To use printer-driver default settings, select Factory Default.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1.

On the File menu, click Print.

2.

Open the Paper Handling menu.

3.

In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4.

If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Cover Page or Paper/Quality tab, select whether to print the cover page Before
Document or After Document.

4.

In the Cover Page Type pop-up menu, select the message that you want to print on the cover
page.
NOTE To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.
1.

On the File menu, click Print.

2.

Open the Watermarks menu.

3.

Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4.

Next to Pages, select whether to print the watermark on all pages or on the first page only.

5.

Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6.

Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Layout pop-up menu.

4.

Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5.

Next to Layout Direction, select the order and placement of the pages on the sheet.

6.

Next to Borders, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing)
Automatic duplex printing
Specify two-sided printing options in your software program or in the printer driver. If you cannot see
this option, use the following information to make the duplex printing options available
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To use two-sided printing:
●

Verify that the printer driver is configured to show the two-sided printing options: automatic and
manual.

●

After the two-sided printing option appears, select the appropriate settings in the printer-driver
software, including the page and binding orientation.

●

Automatic two-sided printing is not supported for certain media types:
●

Transparencies

●

Envelopes

●

Labels

●

Heavy, extra heavy, cardstock, and HP Tough paper

The maximum weight paper for automatic duplex printing is 120 g/m2 (32 lb) bond.
●

Automatic two-sided printing only supports the following media sizes:
●

Letter

●

Legal

●

B5

●

Executive

●

8.5 x 13

●

A4

●

Manual two-sided printing can support all sizes and more types of media, excluding transparencies,
envelopes, and labels

●

If both automatic and manual two-sided printing are enabled, the MFP will automatically print on
two sides if the duplexer supports the selected size and type. Otherwise, manual duplex will be
enabled.

●

For best results, avoid using rough-textured, heavyweight media when duplexing.

●

When using special media such as letterhead or forms, place the media face down in tray 2, 3, or
4, with the logo to the left. Place special media face down in tray 1, with the logo feeding into the
MFP last.
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Enable or disable automatic two-sided printing from the control panel
If you cannot adjust two-sided printing settings in your software program or printer driver, adjust them
on the control panel. The factory default setting is 1-sided.
CAUTION

Do not use two-sided printing when printing on labels. Serious damage can result.

NOTE Changing settings for two-sided printing on the MFP control panel affects all print jobs.
Whenever possible, change settings for two-sided printing through your software program or
printer driver.
NOTE Any changes made in the printer driver override settings made on the MFP control panel.
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1.

Scroll to and touch Administration.

2.

Touch Default Job Options.

3.

Touch Default Print Options

4.

Touch Print Sides.

5.

Touch 2-sided.

6.

Touch Save.
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Enable or disable automatic two-sided printing in the Macintosh printer driver
Use automatic duplex printing
1.

Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:
●

For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

●

For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

2.

Open the printer driver (see Open the printer drivers).

3.

Open the Layout pop-up menu.

4.

Next to Two Sided Printing, select either Long-Edge Binding or Short-Edge Binding.

5.

Click Print.

Layout options for printing on both sides
The following are the four duplex orientation options. To select option 1 or 4, select Flip Pages Up in
the printer driver.

1

2

3

4

1. Long-edge landscape

This layout is often used in accounting, data processing, and
spreadsheet programs. Every other printed image is oriented
upside-down. Facing pages are read continuously from top to
bottom.

2. Short-edge landscape

Each printed image is oriented right-side-up. Facing pages are
read from top to bottom on the left page, and then from top to
bottom on the right page.

3. Long-edge portrait

This is the default setting, and the most common layout used,
with every printed image oriented right-side-up. Facing pages
are read from top to bottom on the first page, and then from
top to bottom on the second page.

4. Short-edge portrait

This layout is often used with clipboards. Every other printed
image is oriented upside-down. Facing pages are read
continuously from top to bottom.
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Options for binding two-sided printing jobs
Before printing a two-sided document, use the printer driver to select the binding. Long-edge or book
binding is the conventional layout used in book binding. Short-edge or tablet binding is the typical
calendar binding.
NOTE The default binding setting is to bind on the long edge when the page is set up for portrait
orientation. To change to long-edge binding, click the Flip Pages Up check box.

Manual duplex printing
Print on both sides manually
1.

Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:
●

For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

●

For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.
CAUTION To avoid jams, do not load paper that is heavier than 105 g/m2 (28-lb bond).

2.

Open the printer driver (see Open the printer drivers).

3.

On the Finishing pop-up menu, select the Manual Duplex option.
NOTE If the Manual Duplex option is not enabled, select Manually Print on 2nd Side.

4.

Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

5.

Go to the printer, and remove any blank paper that is in tray 1.

6.

Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

7.

If prompted, press the appropriate control-panel button to continue.

Set the stapling options
Select the stapler in the printer driver
1.

Open a document and then click Print on the File menu.

2.

Select the appropriate stapling option.

3.

In the Presets pop-up menu, click Save As, and then type a name for the preset.

Configure the printer driver to recognize the optional stapler/stacker
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1.

Open the Printer Center utility.

2.

Select HP Color LaserJet CM4730.

3.

On the File menu, click Show Info.
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4.

Select the Installable Options tab.

5.

Scroll to Accessory Output Bins and select HP 500 sheet stapler/stacker or HP 700 sheet 3bin Mailbox.

6.

Click Apply Changes.

Set the color options
Use the Color Options pop-up menu to control how colors are interpreted and printed from software
programs.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Open the Color Options pop-up menu.

4.

If you are using Mac OS X, click Show Advanced Options.

5.

Adjust the individual settings for text, graphics, and photographs.

Use the Services menu
If the device is connected to a network, use the Services menu to obtain device and supply-status
information.
1.

On the File menu, click Print.

2.

Open the Services menu.

3.

Select a maintenance task from the drop-down list, and then click Launch. The embedded Web
server opens to the page that provides the information for the task that you selected.

4.

To go to various support Web sites for this device, select an Internet Services option from the dropdown list, and then click Go!.

132 Chapter 9 Print tasks

ENWW

Staple documents
The optional stapler/stacker has the following specifications:
●

It can staple jobs of up to 30 sheets of 75 g/m2 (20 lb) paper.

●

It can staple letter-size, A4-size, legal-size paper, Executive (JIS), and 8.5 x 13.

●

It can stack up to 500 sheets of paper.

●

Paper weight can range from 60 to 120 g/m2 (16 to 32 lb).

●

If the job consists of only one sheet or more than 30 sheets, the MFP will print the job to the bin,
but will not staple the job.

●

It supports paper only. Do not try to staple other media, such as transparencies or labels. The
stapler staples a maximum of 20 sheets of glossy paper, cardstock, and HP Tough paper.

The printer driver must first be configured to recognize the optional stapler/stacker. When you want to
use the stapler, you must select the stapling option in the software program, the printer driver, or the
MFP control panel.

Set the stapler at the control panel for printed jobs
1.

Scroll to and touch Administration.

2.

Touch Default Job Options.

3.

Touch Default Copy Options.

4.

Touch Staple/Collate.

5.

Touch Staple.

6.

Touch the staple option you want to use.
NOTE Selecting the stapler at the printer control panel changes the default setting to Staple. It
is possible that all print jobs will be stapled. However, settings that are changed in the printer
driver override settings that are changed at the control panel.

Set the stapler at the control panel for all copy jobs
NOTE The following procedure changes the default setting for all copy jobs.
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1.

Scroll to and touch Administration.

2.

Touch Default Job Options.

3.

Touch Default Copy Options.

4.

Touch Staple/Collate.

5.

Touch Staple.

6.

Touch the staple option you want to use.
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Set the stapler at the control panel for a single copy job
NOTE The following procedure sets the stapling option for only the current copy job.
1.

Scroll to and touch Copy.

2.

Touch Staple/Collate.

3.

Touch the staple option you want to use.

Configure the device to stop or continue when the staple cartridge is empty
You can specify whether the MFP stops printing when the staple cartridge is empty or if it continues
printing but does not staple the jobs.
1.

Scroll to and touch Administration.

2.

Scroll to and touch Device Behavior.

3.

Scroll to and touch Stapler/Stacker.

4.

Touch Staples Out.

5.

Touch the option that you want to use:
●

Select Stop to stop all printing until the staple cartridge is replaced.

●

Select Continue to continue printing jobs without stapling them.

Load staples
Load staples if the MFP control-panel display prompts you with a Stapler Low On Staples message
(the stapler has fewer than 20 usable staples left) or a Replace Stapler Cartridge message (the stapler
is empty, or the remaining staples cannot be used). To order a replacement stapler cartridge, see Part
numbers.
The stapler accepts print jobs if it is out of staples, but it does not staple the pages. The printer driver
can be configured to disable the staple option when the stapler cartridge is empty.
Use the following procedure to load staples.
1.

Press and hold the release button on the top of the stapler/stacker. Pull the stapler/stacker away
from the MFP.
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2.

Open the staple-cartridge cover.

3.

Grasp the green staple-cartridge handle and pull the old staple cartridge out of the stapler unit.

4.

Insert the new staple cartridge into the stapler unit and push down on the green handle until the
unit snaps into place.

5.

Close the staple-cartridge cover, and slide the stapler/stacker into the MFP.
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Cancel a print job
You can stop a print request by using the control panel or by using the software program. For instructions
about how to stop a print request from a computer on a network, see the online Help for the specific
network software.
NOTE It can take some time for all printing to clear after you have canceled a print job.

Stop the current print job from the control panel
1.

Press Stop on the control panel.

2.

On the touchscreen, on the Device Has Been Paused screen, touch Cancel current job.
NOTE If the print job is too far into the printing process, you might not have the option to
cancel it.

Stop the current print job from the software program
A dialog box will appear briefly on the screen, giving you the option to cancel the print job.
If several requests have been sent to the device through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.
If a print job is waiting in a print queue (computer memory) or print spooler (Windows 2000 or XP), delete
the print job there.
Click Start and then click Printers. Double-click the device icon to open the print spooler. Select the
print job that you want to cancel, and then press Delete. If the print job is not cancelled, you might need
to shut down and restart the computer.
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10 Using color

The HP Color LaserJet CM4730 MFP series offers great color printing as soon as you set up the MFP.
It provides a combination of automatic color features to generate excellent color results for the general
office user, plus sophisticated tools for the professional who has experience printing in color.
The HP Color LaserJet CM4730 MFP series provides carefully designed and tested color tables to
provide a smooth, accurate color rendition of all printable colors.
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Manage printer color options on Macintosh computers
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HP ImageREt 3600
HP ImageREt 3600 print technology is a system of innovative technologies developed exclusively by
HP to deliver superior print quality. The HP ImageREt system sets itself apart from the industry by
integrating technology advancements and optimizing each element of the print system. Several
categories of HP ImageREt have been developed for a variety of user needs.
The system uses key color-laser technologies, including image enhancements, smart supplies, and
high-resolution imaging, to provide superior images for general office documents and marketing
collateral. Optimized for printing on HP color laser high-gloss papers, HP Image REt 3600 provides
superior results on all supported media, and under a variety of environmental conditions.
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Restrict color use
The HP Color LaserJet CM4730 MFP Series includes a Restrict Color setting. A network administrator
can use the setting to restrict user access to the color printing and copying features in order to conserve
color toner. If you are unable to print in color, see your network administrator.

Restrict color printing
1.

Scroll to and touch Administration.

2.

Touch Management.

3.

Touch Restrict Color Use.

4.

Touch Color printing access.

5.

Select one of the following options:

6.

●

Disable Color. This setting denies color-printing capabilities to all users.

●

Enable Color (default). This setting allows color-printing capabilities for all users.

●

Color If Allowed. The setting allows the network administrator to allow color use for select
users and/or applications. Use the embedded Web server to designate which users and/or
applications can print in color.

Touch Save.

For more information about restricting and reporting color usage, go to http://www.hp.com/go/
coloraccess.

Restrict color copying
1.

Scroll to and touch Administration.

2.

Touch Management.

3.

Touch Restrict Color Use.

4.

Touch Color copying access.

5.

Select one of the following options:

6.

●

Enable Color (default). This setting allows color-copying capabilities for all users.

●

Disable Color. This setting denies color-copying capabilities to all users.

Touch Save.

For more information about restricting and reporting color usage, go to http://www.hp.com/go/
coloraccess.
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Paper selection
For the best color and image quality, it is important to select the appropriate media type from the MFP
menu or from the front panel.
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Color options
Color options enable optimal color output automatically for diverse types of documents.
Color options use object tagging, which allows optimal color and halftone settings to be used for different
objects (text, graphics, and photos) on a page. The printer driver determines which objects are used on
a page and uses halftone and color settings that provide the best print quality for each object. Object
tagging, combined with optimized default settings, produces great color out of the box.
In the Windows environment, the Automatic and Manual color options are on the Color tab in the printer
driver.
For more information, see Select the correct printer driver.
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sRGB
Standard red-green-blue (sRGB) is a worldwide color standard originally developed by HP and Microsoft
as a common color language for monitors, input devices (scanners, digital cameras), and output devices
(MFPs, printers, plotters). It is the default color space used for HP products, Microsoft operating systems,
the Web, and most office software sold today. sRGB is representative of the typical Windows computer
monitor today and the convergence standard for high-definition television.
NOTE Factors such as the type of monitor you use and the room’s lighting can affect the
appearance of colors on your screen. For more information, see Color matching.
The latest versions of Adobe PhotoShop, CorelDRAW™, Microsoft Office, and many other software
programs use sRGB to communicate color. Most importantly, as the default color space in Microsoft
operating systems, sRGB has gained broad adoption as a means to exchange color information between
software programs and devices using a common definition that assures typical users will experience
greatly improved color matching. sRGB improves your ability to match colors between the MFP, the
computer monitor, and other input devices (scanner, digital camera) automatically, without the need to
become a color expert.
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Print in four colors — CMYK
Cyan, magenta, yellow, and black (CMYK) are the inks used by a printing press. The process is often
called four-color printing. CMYK data files are typically used by and originate from graphic arts (printing
and publishing) environments. The MFP will accept CMYK colors through the PS printer driver. The
MFP color-rendering of CMYK is designed to provide rich, saturated colors for text and graphics.
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CMYK ink set emulation (PostScript only)
The MFP color rendering of CMYK can be made to emulate several standard offset press ink sets. In
some situations, the CMYK color values in an image or document might not be suited to the MFP. For
example, a document might be optimized for another printer. For best results, the CMYK values should
be adapted to the HP Color LaserJet CM4730 MFP. Select the appropriate color input profile from the
printer driver.
●

Default CMYK+. HP CMYK+ technology produces optimal printing results for most printing jobs.

●

Specification for Web Offset Publications (SWOP). Common ink standard in the United States
and other countries/regions.

●

Euroscale. Common ink standard in Europe and other countries/regions.

●

Dainippon Ink and Chemical (DIC). Common ink standard in Japan and other countries/regions.

●

Custom profile. Select this option to use a custom input profile to accurately control color output,
for example, to emulate another HP color LaserJet printer. Color profiles can be downloaded from
http://www.hp.com.
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Color matching
The process of matching MFP output color to your computer screen is quite complex because printers
and computer monitors use different methods of producing color. Monitors display colors by light pixels
using an RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan, magenta,
yellow, and black) process.
Several factors can influence your ability to match printed colors to those on your monitor. These factors
include:
●

Print media

●

Printer colorants (inks or toners for example)

●

Printing process (inkjet, press, or laser technology for example)

●

Overhead lighting

●

Personal differences in perception of color

●

Software programs

●

Printer drivers

●

Computer operating system

●

Monitors

●

Video cards and drivers

●

Operating environment (humidity for example)

Keep the above factors in mind when colors on your screen do not perfectly match your printed colors.
For most users, the best method for matching colors on your screen to your MFP is to print sRGB colors.

PANTONE® color matching
PANTONE® has multiple color matching systems. PANTONE® Matching System is very popular and
uses solid inks to generate a wide range of color hues and tints. See http://www.hp.com/support/
ljcm4730mfp for details on how to use PANTONE® Matching System with this MFP.
NOTE PANTONE® Colors generated may not match PANTONE-identified standards. Consult
current PANTONE Publications for accurate color. PANTONE® and other Pantone, Inc.
trademarks are the property of Pantone, Inc. © Pantone, Inc., 2000.

Sample book color matching
The process for matching MFP output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if the inks used to create
the sample book are cyan, magenta, yellow, and black. These are usually referred to as process color
sample books.
Some sample books are created from spot colors. Spot colors are specially created colorants. Many of
these spot colors are outside of the range of the MFP. Most spot color sample books have companion
process sample books that provide CMYK approximations to the spot color.
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Most process sample books will state which process standards were used to print the sample book. In
most cases they will be SWOP, EURO, or DIC. To get optimal color matching to the process sample
book, select the corresponding ink emulation from the MFP menu. If you cannot identify the process
standard, use SWOP ink emulation.

Printing color samples
To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in your software program to describe the object you wish to match. Colors may
vary depending on paper type and the software program used. For more details on how to use the color
samples, go to http://www.hp.com/support/ljcm4730mfp.
Use the following procedure to print color samples at the MFP using the control panel:
1.

Touch Information.

2.

Touch Sample Pages/Fonts.

3.

Touch CMYK Samples or RGB Samples. The pages will print.
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Manage printer color options on Windows computers
Setting color options to Automatic typically produces the best possible print quality for the most common
printing requirements. However, for some documents, setting the color options manually can enhance
the way the document appears. Examples of these documents include marketing brochures that contain
many images or documents that are printed on a media type that is not listed in the printer driver.
For Windows, you can print in grayscale or change the color options by using settings found on the
Color tab in the printer driver.

Print in grayscale
Select the Print in Grayscale option from the printer driver to print a document in black and white.

Setting the color options in Windows
Options on the Color tab control how colors are interpreted and printed from software programs. You
can choose either Automatic or Manual color options. For more information, see Manage printer color
options on Windows computers.
●

Select Automatic to optimize the color and halftone used for each element in a document (such
as text, graphics, and photographs). The Automatic setting provides additional color options for
software programs and operating systems that support color-management systems. This setting
is recommended for printing all color documents.

●

Select Manual to manually adjust the color and halftone modes for text, graphics, and photographs.
If you are using a PCL driver, you can adjust the RGB data. If you are using the PS driver, you can
adjust RGB or CMYK data.

To set the color options
1.

Open the printer driver.

2.

Click the Color tab.

3.

In the Color Options area, select the option that you want to use.

4.

If you selected Manual, click Settings to open the Color Settings dialog box. Adjust the individual
settings for text, graphics, and photographs. You can also adjust the general printing settings. Click
OK.

5.

In the Color Themes area, select the RGB Color option that you want to use.

6.

Click OK.

RGB Color (Color Themes)
Five values are available for the RGB Color setting:
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●

Select Default (sRGB) for most printing needs. This setting instructs the printer to interpret RGB
color as sRGB, which is the accepted standard of Microsoft and the World Wide Web Consortium
(W3C).

●

Select Image optimization (sRGB) to enhance documents in which the content is mainly bitmap
images, such as .GIF or .JPEG files. This setting instructs the printer to use the best color matching
for rendering sRGB, bitmap images. This setting has no effect on text or vector-based graphics.
Using glossy media in combination with this setting provides the maximum enhancement.
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●

Select AdobeRGB for documents that use the AdobeRGB color space rather than sRGB. For
example, some digital cameras capture images in AdobeRBG, and documents that are produced
with Adobe PhotoShop use the AdobeRGB color space. When printing from a professional software
program that uses AdobeRGB, it is important that you turn off the color management in the software
program and allow the printer software to manage the color space.

●

Select None to instruct the printer to print RGB data in raw device mode. To render documents
properly when this option is selected, you must manage color in the program in which you are
working or in the operating system.
CAUTION Use this option only if you are familiar with the procedures for managing color
in the software program or in the operating system.

●

Select Custom Profile when you want to duplicate the printed output from other printers. This
setting instructs the printer to use a custom input profile to more accurately predict and control color
output. You can download custom profiles from www.hp.com.

Automatic or manual color adjustment
The Automatic color adjustment option optimizes the neutral gray color treatment, halftones, and edge
enhancements that are used for each element in a document. For more information, see Select the
correct printer driver.
NOTE Automatic is the default setting and is recommended for printing most color documents.
The Manual color adjustment option allows you to adjust the neutral gray color treatment, halftones,
and edge enhancements for text, graphics, and photographs. To access the Manual color options, from
the Color tab, select Manual, and then select Settings.

Manual color options
You can manually adjust color options for Edge Control, Halftones, and Neutral Grays.
Edge Control
The Edge Control setting determines how edges are rendered. Edge control has three components:
adaptive halftoning, REt, and trapping. Adaptive halftoning increases the edge sharpness. Trapping
reduces the effect of incorrect color alignment by slightly overlapping the edges of adjacent objects. The
color REt option smoothes the edges.
NOTE If you notice white gaps between objects, or if you notice areas that have a slight shadow
of cyan, magenta, or yellow at the edge, choose an edge-control setting that increases the
trapping level.
Four levels of edge control are available:
●

Maximum is the most aggressive trapping setting. Adaptive halftoning and color REt settings are
on.

●

Normal is the default trapping setting. Trapping is at a medium level. Adaptive halftoning and color
REt settings are on.

●

Light sets trapping at a minimal level. Adaptive halftoning and color REt settings are on.

●

Off turns off trapping, adaptive halftoning, and color REt.
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Halftone options
Halftone options affect the resolution and clarity of your color output. You can select halftone settings
for text, graphics, and photographs independently. The two halftone options are Smooth and Detail.
●

The Smooth option provides better results for large, solid-filled print areas. It also enhances
photographs by smoothing out fine color gradations. Choose this option when uniform and smooth
area fills are top priority.

●

The Detail option is useful for text and graphics that require sharp distinctions among lines or
colors, or for images that contain a pattern or a high level of detail. Choose this option when sharp
edges and details are top priority.
NOTE Some software programs convert text or graphics to bitmap images. In these cases,
setting the color options for Photographs also affects how text and graphics appear.

Neutral Grays
The Neutral Grays setting determines the method used for creating gray colors that are used in text,
graphics, and photographs.
Two values are available for the Neutral Grays setting:
●

Black Only generates neutral colors (grays and black) using only black toner. This guarantees
neutral colors without a color cast.

●

4-Color generates neutral colors (grays and black) by combining all four toner colors. This method
produces smoother gradients and transitions to non-neutral colors, and it produces the darkest
black.
NOTE Some software programs convert text or graphics to raster images. In these cases,
setting the color options for Photographs also affects how text and graphics appear.

ENWW

Manage printer color options on Windows computers 149

Manage printer color options on Macintosh computers
Setting the color options to Automatic typically produces the best possible print quality for the most
common printing requirements. However, for some documents, setting the color options manually can
enhance the way the document appears. Examples of these documents include marketing brochures
that contain many images or documents that are printed on a media type that is not listed in the printer
driver.
Print color as gray or change the color options by using the Color Options pop-up menu in the Print
dialog box.
For more information about how to gain access to the printer drivers, see Select the correct printer
driver.

Print Color as Gray
Selecting the Print Color as Gray option from the printer driver prints a document in black and shades
of gray. This option is useful for previewing preliminary copies of slides and hardcopy output, or for
printing color documents that will be photocopied or faxed.

Setting the color options in Macintosh
Use the Color Options pop-up menu to control how colors are interpreted and printed from software
programs.
NOTE For more information about using the color options, see Manage printer color options on
Macintosh computers.
To set the color options
1.

Open the printer driver (see Select the correct printer driver).

2.

Open the Color Options pop-up menu.

3.

If you are using Mac OS X, click Show Advanced Options.

4.

Manually adjust the individual settings for text, graphics, and photographs.

Advanced color options for text, graphics, and photographs
Use manual color adjustment to adjust the Color (or Color Map) and Halftoning options for a print job.

Halftone options
Halftone options affect the resolution and clarity of your color output. You can select halftone settings
independently for text, graphics, and photographs. The two halftone options are Smooth and Detail.
●

The Smooth option provides better results for large, solid-filled print areas. It also enhances
photographs by smoothing out fine color gradations. Select this option when uniform and smooth
area fills are the top priority.

●

The Detail option is useful for text and graphics that require sharp distinctions among lines or
colors, or for images that contain a pattern or a high level of detail. Select this option when sharp
edges and details are the top priority.
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NOTE Some software programs convert text or graphics to raster images. In these cases, the
Photographs settings also control text and graphics.

Neutral Grays
The Neutral Grays setting determines the method that the printer uses to create gray colors in text,
graphics, and photographs.
Two values are available for the Neutral Grays setting:
●

Black Only generates neutral colors (grays and black) by using only black toner. This guarantees
neutral colors that do not have a color cast.

●

4-Color generates neutral colors (grays and black) by combining all four toner colors. This method
produces smoother gradients and transitions to non-neutral colors, and it produces the darkest
black.
NOTE Some software programs convert text or graphics to raster images. In these cases, the
Photographs settings also control text and graphics.

RGB Color
Five values are available for the RGB Color setting:
●

Select Default (sRGB) for most printing needs. This setting instructs the printer to interpret RGB
color as sRGB, which is the accepted standard of Microsoft and the World Wide Web Organization
(www).

●

Select Image optimization (sRGB) to enhance documents in which the content is mainly bitmap
images, such as .GIF or .JPEG files. This setting instructs the printer to use the best color matching
for rendering sRGB, bitmap images. This setting has no effect on text or vector-based graphics.
Using glossy media in combination with this setting provides the maximum enhancement.

●

Select AdobeRGB for documents that use the AdobeRGB color space rather than sRGB. For
example, some digital cameras capture images in AdobeRGB, and documents that are produced
with Adobe PhotoShop use the AdobeRGB color space. When printing from a professional software
program that uses AdobeRGB, it is important that you turn off the color management in the software
program and allow the printer software to manage the color space.

●

Select None to instruct the printer to print RGB data in raw device mode. To render documents
properly when this option is selected, you must manage color in the program that you are using or
in the operating system.
CAUTION Use this option only if you are familiar with the procedures for managing color
in the software program or in the operating system.

●

Select Custom Profile when you want to duplicate the printed output from other printers. This
setting instructs the printer to use a custom input profile to more accurately predict and control color
output. You can download custom profiles from http://www.hp.com.

Edge Control
The Edge Control setting determines how edges are rendered. Edge control has three components:
adaptive halftoning, Resolution Enhancement Technology (REt), and trapping. Adaptive halftoning
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increases the edge sharpness. Trapping reduces the effect of incorrect color alignment by slightly
overlapping the edges of adjacent objects. The color REt option smooths the edges.
NOTE If you notice white gaps between objects, or if you notice areas that have a slight shadow
of cyan, magenta, or yellow at the edge, choose an edge-control setting that increases the
trapping level.
Four levels of edge control are available:
●

Maximum is the most aggressive trapping setting. Adaptive halftoning and color REt settings are
on.

●

Normal is the default trapping setting. Trapping is at a medium level. Adaptive halftoning and color
REt settings are on.

●

Light sets trapping at a minimal level. Adaptive halftoning and color REt settings are on.

●

Off turns off trapping, adaptive halftoning, and color REt.
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11 Copy

This device can function as a standalone, walk-up copier. It is not necessary to install the printing system
software on the computer; you can adjust the copy settings at the control panel. You can also copy
originals by using either the document feeder or the scanner glass.
This chapter provides information about how to make copies and how to change copy settings, including
the following topics:
●

Use the Copy screen

●

Set the default copy options

●

Basic copy instructions

●

Adjust the copy settings

●

Copy two-sided documents

●

Copy mixed-size originals

●

Change the copy-collation setting

●

Copy photos and books

●

Combine copy jobs by using Job Build

●

Cancel a copy job

It is recommended that you review the basic control-panel information before using the device copying
functions. See Use the control panel for more information.
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Use the Copy screen
From the Home screen, touch Copy to view the Copy screen. Note that only the first six copy features
are immediately visible. In order to view additional copy features, touch More Options.

Figure 11-1 Copy screen
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Set the default copy options
You can use the administration menu to establish default settings that apply to all copy jobs. If necessary,
you can override most settings for an individual job. After that job is complete, the device returns to the
default settings.
1.

From the Home screen, scroll to and touch Administration.

2.

Touch Default Job Options, and then touch Default Copy Options.

3.

Several options are available. You can configure defaults for all options, or for only some options.
For information about each option, see Adjust the copy settings. The built-in Help system also
provides an explanation of each option. Touch the Help button ( ) in the upper-right corner of the
screen.

4.
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To exit the administration menu, touch the Home button (

) in the upper-left corner of the screen.
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Basic copy instructions
This section provides the basic instructions for copying.

Copy from the scanner glass
Use the scanner glass to make as many as 999 copies of small, lightweight media (less than 60 g/m2
or 16 lb) or heavy media (more than 105 g/m2 or 28 lb). This includes media such as receipts, newspaper
clippings, photographs, old documents, worn documents, and books.
Place original documents face-down on the glass. Align the corner of the original with the upper-left
corner of the glass.
To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy
settings.

Copy from the document feeder
Use the document feeder to make as many as 999 copies of a document that has up to 50 pages
(depending on the thickness of the pages). Place the document into the document feeder with the pages
facing up.
To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy
settings.
Before starting another copy job, retrieve the original document from the document-feeder output bin
that is under the document feeder input tray, and retrieve the copies from the appropriate output bin.
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Adjust the copy settings
The device offers several features so you can optimize copied output. These features are all available
on the Copy screen.
The Copy screen consists of several pages. From the first page, touch More Options to go to the next
page. Then touch the up or down arrow buttons to scroll to other pages.
For details about how to use an option, touch the option, and then touch the help ( ) button in the upperright corner of the screen. The following table provides an overview of the copy options.
NOTE Depending on how the system administrator has configured the device, some of these
options might not appear. The options in the table are listed in the order in which they can appear.
Option name

Description

Sides

Use this feature to indicate whether the original document is printed on one or both sides, and
whether the copies should be printed on one or both sides.

Reduce/Enlarge

Use this feature to reduce or enlarge the copied image on the page.

Color/Black

Use this feature to choose black printing or color printing.

Staple/Collate or Collate

If the optional HP Stapler/Stacker/Separator is attached, the Staple/Collate option is available.
Use this feature to set up options for stapling and assembling the pages in sets of copies.
If the optional HP Stapler/Stacker/Separator is not attached, the Collate option is available. Use
this feature to assemble each set of copied pages in the same order as the original document.
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Paper Selection

Use this feature to select the tray that holds the size and type of paper that you want to use.

Image Adjustment

Use this feature to improve the overall quality of the copy. For example, you can adjust the
darkness and sharpness, and you can use the Background Cleanup setting to remove faint
images from the background or to remove a light background color.

Content Orientation

Use this feature to specify the way the content of the original page is placed on the page: portrait
or landscape.

Output Bin

Use this feature to select an output bin for the copies.

Optimize Text/Picture

Use this feature to optimize the output for a particular type of content. You can optimize the
output for text or printed pictures, or you can manually adjust the values.

Pages per Sheet

Use this feature to copy multiple pages onto one sheet of paper.

Original Size

Use this feature to describe the page size of the original document.

Booklet Format

Use this feature to copy two or more pages onto one sheet of paper so you can fold the sheets
in the center to form a booklet.

Edge-To-Edge

Use this feature to avoid shadows that can appear along the edges of copies when the original
document is printed close to the edges. Combine this feature with the Reduce/Enlarge feature
to ensure that the entire page is printed on the copies.

Job Build

Use this feature to combine several sets of original documents into one copy job. Also use this
feature to copy an original document that has more pages than the document feeder can
accommodate at one time.

Adjust the copy settings 157

Copy two-sided documents
Two-sided documents can be copied manually or automatically.

Copying two-sided documents manually
Copies resulting from this procedure are printed on one side, and need to be hand-collated.
1.

Load the documents to be copied into the document feeder input tray with the first page facing up,
and with the top of the page leading into the document feeder.

2.

Touch Start Copy. The odd-numbered pages are copied and printed.

3.

Remove the stack from the document feeder output tray and reload the stack with the last page
facing up, and with the top of the page leading into the document feeder.

4.

Touch Start Copy. The even-numbered pages are copied and printed.

5.

Collate the odd- and even-numbered printed copies.

Copy two-sided documents automatically
The default copy setting is one-sided to one-sided. Use the following procedures to change the setting
so you can copy from or to documents that are two-sided.
Make two-sided copies from one-sided documents
1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.

4.

Touch 1-sided original, 2-sided output.

5.

Touch OK.

6.

Touch Start Copy.

Make two-sided copies from two-sided documents
1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.
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4.

Touch 2-sided original, 2-sided output.

5.

Touch OK.

6.

Touch Start Copy.

Make one-sided copies from two-sided documents
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1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.

4.

Touch 2-sided original, 1-sided output.

5.

Touch OK.

6.

Touch Start Copy.
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Copy mixed-size originals
You can copy original documents that are printed on different sizes of paper as long as the sheets of
paper have one common dimension. For example, you could combine letter and legal sizes, or you could
combine A4 and A5 sizes.
1.

Arrange the sheets in the original document so they all have the same width.

2.

Place the sheets face-up into the document feeder, and adjust both paper guides against the
document.

3.

From the Home screen, touch Copy.

4.

Touch Original Size.
NOTE If this option is not on the first screen, touch More Options until the option appears.

5.

Select Mixed Ltr/Lgl, and then touch OK.

6.

Touch Start Copy.
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Change the copy-collation setting
You can set the device to automatically collate multiple copies into sets. For example, if you are making
two copies of three pages and the automatic collation is on, the pages print in this order: 1,2,3,1,2,3. If
automatic collation is off, the pages print in this order: 1,1,2,2,3,3.
To use the automatic collation, the original document size must fit into the memory. If it does not, the
device makes only one copy and a message appears notifying you of the change. If that happens, use
one of the following methods to finish the job:
●

Split the job into smaller jobs that contain fewer pages.

●

Make only one copy of the document at a time.

●

Turn off the automatic collation.

The collation setting you select is in effect for all copies until you change the setting. The default setting
for automatic copy collation is On.
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1.

On the control panel, touch Copy.

2.

Touch Staple/Collate or Collate.

3.

Touch Off.

4.

Touch OK.
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Copy photos and books
Copy a photo
NOTE Photos should be copied from the flatbed scanner, not from the document feeder.
1.

Lift the lid and place the photo on the flatbed scanner with the picture-side down and the upperleft corner of the photo in the upper-left corner of the glass.

2.

Gently close the lid.

3.

Touch Start Copy.

Copy a book
1.

Lift the lid and place the book on the flatbed scanner with the page that you want to copy at the
upper-left corner of the glass.

2.

Gently close the lid.

3.

Gently press down on the lid to press the book to the flatbed scanner surface.

4.

Touch Start Copy.
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Combine copy jobs by using Job Build
Use the Job Build feature to build a single copy job from multiple scans. You can use either the document
feeder or the scanner glass. The settings for the first scan are used for subsequent scans.
1.

Touch Copy.

2.

Scroll to and touch Job Build.

3.

Touch Job Build On.

4.

Touch OK.

5.

If necessary, select the desired copy options.

6.

Touch Start Copy. After each page is scanned, the control panel prompts you for more pages.

7.

If the job contains more pages, load the next page, and then touch Start Copy.
If the job contains no more pages, touch Finished to print.
NOTE In Job Build, if you scan the first page of a document by using the document feeder, then
you must scan all of the pages in that document by using the document feeder. If you scan the
first page of a document by using the scanner glass, then you must scan all of the pages in that
document by using the scanner glass.
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Cancel a copy job
To cancel the copy job that is currently running, touch Stop on the control panel. This pauses the device.
Then touch Cancel Current Job.
NOTE If you cancel a copy job, clear the document from the flatbed scanner or from the
automatic document feeder.
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12 Scan and send to e-mail

The MFP offers color-scanning and digital-sending capabilities. By using the control panel, you can scan
black-and-white or color documents and send them to an e-mail address as an e-mail attachment. To
use digital sending, the device must be connected to a local area network (LAN).
NOTE The e-mail icon is not shown on the control panel if e-mail is not configured.
This chapter addresses the following topics:
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●

Configure e-mail settings

●

Use the Send E-mail screen

●

Perform basic e-mail functions

●

Use the address book

●

Change e-mail settings for the current job

●

Scan to a folder

●

Scan to a workflow destination
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Configure e-mail settings
Before you can send a document to e-mail, you must configure the device.
NOTE The instructions that follow are for configuring the device at the control panel. You can
also perform these procedures by using the embedded Web server. For more information, see
Embedded Web server.

Supported protocols
The HP LaserJet CM4730 MFP models support Simple Mail Transfer Protocol (SMTP) and Lightweight
Directory Access Protocol (LDAP).
SMTP
●

SMTP is a set of rules that define the interaction between programs that send and receive e-mail.
In order for the device to send documents to e-mail, it must be connected to a LAN that has access
to an e-mail server that supports SMTP. The SMTP server must also have Internet access.

●

If you are using a LAN connection, contact your system administrator to obtain the IP address or
host name for your SMTP server. If you are connecting through a DSL or cable connection, contact
the internet service provider to obtain the SMTP server IP address.

●

LDAP is used to gain access to a database of information. When the device uses LDAP, it searches
a global list of e-mail addresses. As you begin to type the e-mail address, LDAP uses an autocomplete feature that supplies a list of e-mail addresses that match the characters you type. As
you type additional characters, the list of matching e-mail addresses becomes smaller.

●

The device supports LDAP, but a connection to an LDAP server is not required in order for the
device to be able to send to e-mail.

LDAP

NOTE If you need to change the LDAP settings, you must change them by using the
embedded Web server. For more information, see Embedded Web server, or see the
Embedded Web Server User Guide on the device CD.

Configure e-mail server settings
Consult your system administrator or use the control panel to find the IP address for the SMTP server.
Then use the following procedures to manually configure and test the IP address.
Configure the SMTP gateway address
1.

From the Home screen, touch Administration.

2.

Touch Initial Setup.

3.

Touch E-mail Setup, and then touch SMTP Gateway.

4.

Type the SMTP gateway address, either as an IP address or as a fully qualified domain name. If
you do not know the IP address or domain name, contact the network administrator.

5.

Touch OK.
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Test the SMTP settings
1.

From the Home screen, touch Administration.

2.

Touch Initial Setup.

3.

Touch E-mail Setup, and then touch Test Send Gateways.
If the configuration is correct, Gateways OK appears on the control-panel display.

If the first test was successful, send an e-mail to yourself by using the digital-send feature. If you receive
the e-mail, you have successfully configured the digital-sending feature.
If you do not receive the e-mail, use these actions to resolve issues with the digital-sending software:
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●

Check the SMTP and address to make sure that you typed them correctly.

●

Print a configuration page. Verify that the SMTP gateway address is correct.

●

Make sure that the network is operating correctly. Send an e-mail to yourself from a computer. If
you receive the e-mail, the network is operating correctly. If you do not receive the e-mail, contact
your network administrator or Internet service provider (ISP).

●

Run the DISCOVER.EXE file. This program attempts to find the gateway. You can download the
file from the HP Web site at http://www.hp.com/support/ljcm4730mfp.
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Use the Send E-mail screen
Use the touchscreen to navigate through the options on the Send E-mail screen.

1

Send E-mail button

Touching this button scans the document and sends an e-mail file to the provided e-mail
addresses.

2

Home button

Touching this button opens the Home screen.

3

From: field

Touch this field to open the keyboard, and then type your e-mail address. If the system
administrator has configured the device to do so, this field might automatically insert a default
address.

4

To: field

Touch this field to open the keyboard, and then type the e-mail addresses of those whom you
want to receive the scanned document.

5

Subject: field

Touch this field to open the keyboard, and then type a subject title.

6

More Options button

Touch this button to change certain e-mail settings for the current scan job.

7

Scroll bar

Use the scroll bar to view and set up the CC:, BCC:, Message, and File Name fields. Touch any
of those fields to open the keyboard and add the necessary information.

8

Address book buttons

Touch these buttons to use the address book to populate the To:, CC:, or BCC: fields. For more
information, see Use the local address book.

9

Help button

Touch this button for control-panel help. For more information, see Use the control panel.

10

Error/warning button

This button appears only when there is an error or warning in the status line area. Touch it to open
a pop-up screen that will help you resolve the error or warning.
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Perform basic e-mail functions
The device e-mail feature offers the following benefits:
●

Sends documents to multiple e-mail addresses, saving time and delivery costs.

●

Delivers files in black-and-white or in color. Files can be sent in different file formats that the
recipient can manipulate.

With e-mail, documents are scanned into the device memory and sent to an e-mail address or multiple
addresses as an e-mail attachment. Digital documents can be sent in several graphics formats, such
as .TFF and .JPG, which allows recipients to manipulate the document file in various programs to meet
their specific needs. Documents arrive in near-original quality, and then can be printed, stored, or
forwarded.
In order to use the e-mail feature, the device needs to be connected to a valid SMTP local area network
that includes Internet access.

Load documents
You can scan a document by using either the glass or the ADF. The glass and ADF can accommodate
Letter-, Executive-, A4-, and A5-size originals. The ADF can also accommodate Legal-size originals.
Smaller originals, receipts, irregular and worn documents, stapled documents, previously folded
documents, and photographs should be scanned by using the glass. Multiple-page documents can be
scanned easily by using the ADF.

Send documents
The device scans both black-and-white and color originals. You can use default settings or change the
scanning preferences and file formats. The following are the default settings:
●

Color

●

PDF (requires the recipient to have an Adobe Acrobat viewer to view the e-mail attachment)

For information about changing the settings for the current job, see Change e-mail settings for the current
job.

Send a document
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1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch E-mail.

3.

If prompted, type your user name and password.

4.

Complete the From:, To:, and Subject: fields. Scroll down and complete the CC:, BCC:, and
Message fields if appropriate. Your user name or other default information might appear in the
From: field. If so, you might not be able to change it.

5.

(Optional) Touch More Options to change the settings for the document that you are sending (for
example, the document’s original size). If you are sending a two-sided document, you should select
Sides and an option with a two-sided original.

6.

Press Start to begin sending.

7.

When you are finished, remove the original document from the scanner glass or ADF.
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Use the auto-complete function
When you type characters into the To:, CC:, or From: fields on the Send E-mail screen, the autocomplete function is activated. As you type the required address or name by using the keyboard screen,
the device automatically searches the address book list and completes the address or name by using
the first match. You can then select that name by touching Enter, or continue typing the name until autocomplete finds the correct entry. If you type a character that does not match any entry in the list, the
auto-complete text is removed from the display to indicate that you are typing an address that is not in
the address book.
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Use the address book
You can send e-mail to a list of recipients by using the address book feature of the device. See your
system administrator for information about configuring address lists.
NOTE You can also use the embedded Web server (EWS) to create and manage the e-mail
address book. The EWS e-mail address book can be used to add, edit, or delete single e-mail
addresses or e-mail distribution lists. For more information, see Embedded Web server.

Create a recipient list
1.

From the Home screen, touch E-mail.

2.

Complete one of the following steps:
●

Touch To: to open the keyboard screen, and then type the recipients' e-mail addresses.
Separate multiple e-mail addresses with a semicolon or by touching Enter on the touchscreen.

●

Use the address book.
a.

On the Send E-mail screen, touch the address book button ( ) to open the address
book.

b.

Navigate the entries in the address book by using the scroll bar. Hold down the arrow to
scroll quickly through the list.

c.

Highlight the name to select a recipient, and then touch the add button ( ).
You can also select a distribution list by touching the drop-down list at the top of the
screen and then touching All, or add a recipient from a local list by touching Local in the
to add the name to
drop-down list. Highlight the appropriate names, and then touch
your list of recipients.
You can remove a recipient from your list by scrolling to highlight the recipient, and then
touching the remove button ( ).

3.

The names in the recipient list are placed in the text line of the keyboard screen. If you want, you
can add a recipient that is not found in the address book by typing the e-mail address on the
keyboard. After you are satisfied with your recipient list, touch OK.

4.

Touch OK.

5.

Finish typing information in the CC: and Subject: fields on the Send E-mail screen, if necessary.
You can check the list of recipients by touching the down arrow in the To: text line.

6.

Press Start.

Use the local address book
Use the local address book to store frequently-used e-mail addresses. The local address book can be
shared between devices that use the same server to gain access to the HP Digital Sending software.
You can use the address book when you type e-mail addresses in the From:, To:, CC:, or BCC: fields.
You can also add or delete addresses in the address book.
To open the address book, touch the address book button ( ).

ENWW

Use the address book 171

Add e-mail addresses to the local address book
1.

Touch Local.

2.

Touch

3.

(Optional) Touch the Name field, and in the keyboard that appears type a name for the new entry.
Touch OK.

.

The name is the alias for the e-mail address. If you do not type an alias name, the alias will be the
e-mail address itself.
4.

Touch the Address field, and in the keyboard that appears type the e-mail address for the new
entry. Touch OK.

Delete e-mail addresses from the local address book
You can delete e-mail addresses that you no longer use.
NOTE To change an e-mail address, you must first delete the address and then add the
corrected address as a new address in the local address book.
1.

Touch Local.

2.

Touch the e-mail address that you want to delete.

3.

Touch

.

The following confirmation message appears: Do you want to delete the selected address(es)?
4.

Touch Yes to delete the e-mail address(es) or touch No to return to the Address Book screen.
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Change e-mail settings for the current job
Use the More Options button to change the following e-mail settings for the current print job:
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Button

Description

Document File Type

Touch this button to change the type of file the device creates after scanning the document.

Output Quality

Touch this button to increase or decrease the print quality of the file being scanned. A higher quality
setting produces a larger file size.

Resolution

Touch this button to change the scan resolution. A higher resolution setting produces a larger file size.

Color/Black

Touch this button to determine whether you will scan the document in color or in black-and-white.

Original Sides

Touch this button to indicate if the original document is one-sided or two-sided.

Content Orientation

Touch this button to select either the portrait or landscape orientation for the original.

Original Size

Touch this button to select the size of the document: letter, A4, legal, or mixed letter/legal.

Optimize Text/
Picture

Touch this button to change the scanning procedure based on the type of document that you are
scanning.

Job Build

Touch this button to activate or deactivate the Job Build mode, which enables you to scan several small
scan jobs and send them as one file.

Image Adjustment

Touch this button to change the darkness and sharpness settings, or to clean up background clutter on
the original.
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Scan to a folder
If the system administrator has made the feature available, the device can scan a file and send it to a
folder on the network. Supported operating systems for folder destinations include Windows 2000,
Windows XP, and Windows Server 2003.
NOTE You might be required to supply a user name and password in order to use this option,
or to send to certain folders. See your system administrator for more information.
1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch Network Folder.

3.

In the Quick Access Folders list, select the folder in which you want to save the document.

4.

Touch the File Name field to open the keyboard pop-up screen, and then type the file name.

5.

Touch Send to Network Folder.
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Scan to a workflow destination
NOTE This device feature is provided by the optional Digital Sending Software.
If the system administrator has enabled the workflow functionality, you can scan a document and send
it to a custom workflow destination. A workflow destination gives you the ability to send additional
information, along with the scanned document, to a specified network or file transfer protocol (FTP)
location. Prompts for specific information appear on the control-panel display. The system administrator
can also designate a printer as a workflow destination, which allows you to scan a document and then
send it directly to a network printer for printing.
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1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch Workflow.

3.

Select the destination to which you want to scan.

4.

In the Text Field field, type the data that you want to accompany the file, and then touch Send
Workflow.
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13 Fax
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●

Analog fax

●

Digital fax
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Analog fax
When the analog fax accessory is installed, the MFP can function as a standalone fax machine.
The HP Color LaserJet CM4730f MFP, HP Color LaserJet CM4730fsk MFP, and HP Color LaserJet
CM4730fm MFP models come with a fax accessory already installed. For the HP Color LaserJet
CM4730 MFP (base model), you can order this accessory as an option. See Part numbers for
information about ordering the analog fax accessory. The Analog Fax Accessory 300 Fax Guide and
the Analog Fax Accessory 300 Send Fax Driver Guide are located on the MFP software CD or at
http://www.hp.com/go/mfpfaxaccessory300.

Connect the fax accessory to a phone line
When connecting the fax accessory to a phone line, ensure that the phone line being used for the fax
accessory is a dedicated line that is not used by any other devices. Also, this line should be an analog
line because the fax will not function correctly if it is connected to some digital PBX systems. If you are
not sure whether you have an analog or digital phone line, contact your telecom provider.
NOTE HP recommends using the phone cord that comes with the fax accessory to ensure that
the accessory functions correctly.
Follow these instructions to connect the fax accessory to a phone jack.
1.

Locate the phone cord that is included with the fax accessory kit. Connect one end of the phone
cord into the fax accessory phone jack that is on the formatter. Push the connector until it clicks.

CAUTION Be sure to connect the phone line to the fax accessory port, which is located in
the center of the formatter. Do not connect the phone line to the HP Jetdirect port, which is
nearer the bottom of the formatter.
2.

Connect the other end of the phone cord into the phone jack on the wall. Push the connector until
it clicks or until it is securely seated. Because different types of connectors are used in different
countries/regions, the connector might not make an audible click.
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Configure and use the fax features
Before you can use the fax features, you must configure them in the control-panel menus. For complete
information about configuring and using the fax accessory, and for information about troubleshooting
problems with the fax accessory, see the HP LaserJet Analog Fax Accessory 300 User Guide. This
guide is provided with the fax accessory, and it is also available on the MFP software CD.
Use the Send Fax driver to send a fax from a computer without going to the MFP control panel. See the
HP LaserJet MFP Analog Fax Accessory 300 Send Fax Driver Guide for more information.
The HP LaserJet Analog Fax Accessory 300 User Guide and HP LaserJet MFP Analog Fax Accessory
300 Send Fax Driver Guide are both available on the MFP software CD.
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Digital fax
Digital faxing is available when you install the optional HP Digital Sending Software. For information
about ordering this software, go to http://www.hp.com/go/digitalsending.
With digital faxing, the MFP does not need to be connected directly to a phone line. Instead, the MFP
can send a fax in one of three ways:
●

LAN fax sends faxes through a third-party fax provider.

●

Microsoft Windows 2000 fax is a fax modem and Digital Sender Module on a computer that allows
the computer to operate as a turnkey gateway fax.

●

Internet fax uses an Internet fax provider to process faxes, and the fax is delivered on a traditional
fax machine or sent to the user’s e-mail.

For complete information about using digital faxing, see the documentation that is provided with the
HP Digital Sending Software.
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●

Information pages

●

Embedded Web server

●

HP Easy Printer Care software

●

HP Web Jetadmin software

●

HP Printer Utility for Macintosh

●
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Information pages
Information pages provide details about the device and its current configuration. The following table
provides the instructions for printing the information pages.
Page description

How to print the page from the MFP control panel

Menu map

1.

From the Home screen, touch Administration.

Shows the control-panel menus and
available settings.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Administration Menu Map.

5.

Touch Print.

The content of the menu map varies, depending on the options currently installed in
the device.
For a complete list of control panel menus and possible values, see Use the control
panel.
Configuration page

1.

From the Home screen, touch Administration.

Shows device settings and installed
accessories.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Configuration/status Pages.

5.

Touch Print.
NOTE If the device contains an HP Jetdirect print server or an optional hard
disk drive, additional configuration pages print that provide information about
those devices.

Supplies status page

1.

From the Home screen, touch Administration.

Shows print-cartridge toner levels.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Supplies Status Page.

5.

Touch Print.
NOTE If you are using non-HP supplies, the supplies status page might not
show the remaining life for those supplies.

Usage page

1.

From the Home screen, touch Administration.

Shows a page count for each size of
paper printed, the number of one-sided
(simplexed) or two-sided (duplexed)
pages, and the average percentage of
coverage.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Usage Page.

5.

Touch Print.

File directory

1.

From the Home screen, touch Administration.

Contains information for any mass
storage devices, such as flash drives,

2.

Touch Information.

3.

Touch Configuration/status Pages.
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Page description

How to print the page from the MFP control panel

memory cards, or hard disks, that are
installed in the device.

4.

Touch File Directory.

5.

Touch Print.

1.

From the Home screen, touch Administration.

Fax reports

Five reports show fax activity, fax calls, 2.
billing codes, blocked fax numbers, and
3.
speed-dial numbers.
NOTE Fax reports are
available only on device
models that have fax
capabilities.

4.

5.

Touch Information.
Touch Fax Reports.
Touch one of the following buttons to print the corresponding report:
●

Fax Activity Log

●

Fax Call Report

●

Billing Codes Report

●

Blocked Fax List

●

Speed Dial List

Touch Print.

For more information, see the fax guide that came with the device.
Font lists

1.

From the Home screen, touch Administration.

Shows which fonts are currently
installed in the device.

2.

Touch Information.

3.

Touch Sample Pages/Fonts.

4.

Touch either PCL Font List or PS Font List.

5.

Touch Print.
NOTE The font lists also show which fonts reside on a hard disk accessory
or DIMM.
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Embedded Web server
Use the embedded Web server to view MFP and network status and to manage printing functions from
your computer instead of from the MFP control panel. The following are examples of what you can do
using the embedded Web server:
NOTE When the printer is directly connected to a computer, use the HP Easy Printer Care
software to view the printer status.
●

View MFP status information.

●

Set the type of media that is loaded in each tray.

●

Determine the remaining life for all supplies and order new ones.

●

View and change tray configurations.

●

View and change the MFP control-panel menu configuration.

●

View and print internal pages.

●

Receive notification of MFP and supplies events.

●

View and change network configuration.

To use the embedded Web server, you must have Microsoft Internet Explorer 5.01 or later or Netscape
6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is required for
HP-UX 10 and HP-UX 11. The embedded Web server works when the MFP is connected to an IP-based
network. The embedded Web server does not support IPX-based MFP connections. You do not have
to have Internet access to open and use the embedded Web server.
When the MFP is connected to the network, the embedded Web server is automatically available.
NOTE For complete information about using the embedded Web server, see the Embedded
Web Server User Guide, which is on the HP Color LaserJet CM4730 MFP series software CD.

Open the embedded Web server
To open the embedded Web server, type the IP address or host name of the MFP in a supported Web
browser. If you do not know the IP address or host name, print a configuration page.
The embedded Web server has four tabs:
●

Information tab

●

Settings tab

●

Digital Sending tab

●

Networking tab

The embedded Web server also has other links that lead to external Web sites.

184 Chapter 14 Manage the MFP

ENWW

Information tab
The Information pages group consists of the following pages.
●

Device Status. This page shows the MFP status and shows the life remaining of HP supplies, with
0% representing that a supply is empty. The page also shows the type and size of print media set
for each tray. To change the default settings, click Change Settings.

●

Configuration page. This page shows the information that is found on the MFP configuration page.

●

Supplies Status. This page shows the life remaining of HP supplies, with 0% representing that a
supply is empty. This page also provides supplies part numbers. To order new supplies, click Order
Supplies in the Other Links area of the window. To visit any Web site, you must have Internet
access.

●

Event log. This page shows a list of all MFP events and errors.

●

Usage page. This page details the total usage of the MFP.

●

Device information. This page shows the MFP network name, address, and model information.
To change these entries, click Device Information on the Settings tab.

●

Control panel. View the current status of the MFP control panel.

●

Print. Select a file on your network or on the Web, and send it to the MFP to be printed. The
document must be a print-ready document, such as a .PS, .PDF, .PCL, or .TXT file.

Settings tab
Use this tab to configure the MFP from your computer. The Settings tab can be password protected. If
this MFP is networked, always consult with the system administrator before changing settings on this
tab.
The Settings tab contains the following pages.
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●

Configure Device. Configure all MFP settings from this page. This page contains the traditional
menus found on the control-panel display. These menus include Information, Paper Handling,
Configure Device, and Diagnostics.

●

e-mail Server. Use this page to set up the SMTP server that will be used to send MFP e-mail alerts
(set up on the Alerts page).

●

Alerts. Network only. Set up to receive e-mail alerts for various MFP and supplies events. These
alerts can be sent to a list of up to 20 e-mail, mobile-device, or Web-site destinations.

●

AutoSend. Use the AutoSend screen to send product-configuration and usage information
periodically to your service provider. This feature establishes a relationship with Hewlett-Packard
Company or another service provider to provide you with services that include support agreements
and usage tracking.

●

Security. Set a password that must be typed in order to gain access to the Settings, Digital
Sending, and Networking tabs. Turn on and off certain features of the EWS.

●

Edit Other Links. Add or customize a link to another Web site. This link is shown in the Other
Links area on all embedded Web server pages. These permanent links always appear in the Other
Links area: HP Instant Support, Order Supplies, and Product Support.

●

Device Information. Name the MFP and assign an asset number to it. Type the name of the
primary contact who will receive information about the MFP.
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●

Language. Determine the language in which to show the embedded Web server information.

●

Date & Time. Use this page to set the correct date and time for the device. Once the time is set,
the device's real-time clock maintains the accurate time.

●

Wake Time page. Wake Time can be set to wake the MFP at a certain time on a daily basis. Only
one wake time can be set per day; however, each day can have a different wake time. You can
also set the time delay for Sleep Mode on this page.

Digital Sending tab
Use the pages on the Digital Sending tab to configure the digital-sending features.
NOTE If the MFP is configured to use the optional HP Digital Sending Software, the options on
these tabs are not available. Instead, all digital-sending configuration is performed by using the
HP Digital Sending Software.
●

General page. Set up contact information for the system administrator.

●

Send to e-mail page. Configure the e-mail settings for digital sending. You can specify the SMTP
server, the default "From" address, and the default subject. You can also set the maximum file size
that is allowed for attachments.

●

Addressing page. Configure the LDAP server settings for digital sending. The LDAP server can
be used to retrieve e-mail addresses for digital sending. Select the check box at the top of this page
to enable this feature. Click Find Server to find the LDAP server on your network, then click
Test near the bottom of the page to test access to the server. Contact your network administrator
for more information about using the LDAP server.

●

Address Book page. Use this page to import e-mail addresses, in the form of a Comma-Separated
Value (CSV) file into the MFP internal address book. This process is necessary only if you are not
using an LDAP server to find e-mail addresses.

●

Activity Log page. View the digital-sending activity log for the MFP. The log contains digitalsending job information, including any errors that occur.

●

Preferences page. Configure digital-sending defaults such as the default page-size and the default
settings-reset delay. You can also configure these settings by using the MFP control-panel menus.

Networking tab
The network administrator can use this tab to control network-related settings for the MFP when it is
connected to an IP-based network. This tab does not appear if the MFP is directly connected to a
computer, or if the MFP is connected to a network with anything other than an HP Jetdirect print
server.

Other links
This section contains links that connect you to the Internet. You must have Internet access in order to
use any of these links. If you use a dial-up connection and did not connect when you first opened the
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embedded Web server, you must connect before you can visit these Web sites. Connecting might
require that you close the embedded Web server and reopen it.
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●

HP Instant Support. Connects to the HP Web site to help you find solutions. This service analyzes
your MFP error log and configuration information to provide diagnostic and support information
specific to your MFP.

●

Order Supplies. Connect to a Web site where you can order genuine HP supplies such as print
cartridges and media.

●

Product Support. Connects to the support site for the HP Color LaserJet CM4730 MFP series.
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HP Easy Printer Care software
HP Easy Printer Care software is a software program that you can use for the following tasks:
●

Check the printer status.

●

Check supplies status.

●

Set up alerts.

●

Gain access to troubleshooting and maintenance tools.

You can use the HP Easy Printer Care software when the printer is directly connected to your computer
or when it is connected to a network. You must perform a complete software installation to use the HP
Easy Printer Care software.
NOTE You do not have to have Internet access to open and use the HP Easy Printer Care
software. However, if you click a Web-based link, you must have Internet access to go to the site
associated with the link.
For more information on HP Easy Printer Care software, visit http://www.hp.com/go/easyprintercare.

Supported operating systems
The HP Easy Printer Care software is supported for Windows 2000 and Windows XP.

Open HP Easy Printer Care software
Use one of the following methods to open HP Easy Printer Care software:
●

In the Windows system tray/taskbar (in the lower right-hand corner of the desktop), select HP Easy
Printer Care software.

●

Double-click the HP Easy Printer Care software desktop icon.

HP Easy Printer Care software sections
The HP Easy Printer Care software contains the sections described in the following table.
Section

Description

Overview tab

●

Devices list: Shows the printers that you can select.

Contains basic status
information for the
printer.

●

Device Status section: Shows printer status information. This section indicates printer alert
conditions, such as an empty print cartridge. It also shows device-identification information,
control-panel messages, and print-cartridge levels. After you correct a problem with the printer,
(Refresh) button to update the section.
click the

●

Supplies Status section: Shows detailed supplies status, such as the percentage of toner
remaining in the print cartridges and the status of the media that is loaded in each tray.

●

Supplies Details link: Opens the supplies status page to view more detailed information about
printer supplies, ordering information, and recycling information.

Support tab

●

Provides device information, including alerts for items needing attention.

Provides help information
and links.

●

Provides links to troubleshooting information and tools.

●

Provides links to the HP Web site for registration, support, and for ordering supplies.
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Section

Description
NOTE If you use a dial-up connection and did not connect to the Internet when you
first opened the HP Easy Printer Care software, you must connect before you can visit
these Web sites.

Supplies Ordering
window

●

Ordering list: Shows the supplies that you can order for each printer. If you want to order a
certain item, click the Order check box for that item in the supplies list.

Provides access to online
or e-mail supplies
ordering.

●

Shop Online for Supplies button: Opens the HP supplies Web site in a new browser window.
If you have checked the Order check box for any items, the information about those items can
be transferred to the Web site.

●

Print Shopping List button: Prints the information for the supplies that have the Order check
box selected.

●

Email Shopping List button: Creates a text list of items that have the Order check box
selected. The list can be copied into an e-mail message that you send to your supplier.

Alert Settings window

●

Alerts on or off: Activates or deactivates the alerts feature for a certain printer.

Allows you to configure
the printer to
automatically notify you
of printer issues.

●

When alerts appear: Sets when you want alerts to appear—either when you are printing to
that particular printer, or anytime there is a printer event.

●

Alert event type: Sets whether you want alerts for only critical errors, or for any error, including
continuable errors.

●

Notification type: Sets what type of alert should appear (pop-up message or system tray alert,
and e-mail message).

Device List tab

●

Printer information, including printer name, make, and model

Shows information about
each printer in the
Devices list.

●

An icon (if the View as drop-down box is set to Tiles, which is the default setting)

●

Any current alerts for the printer

If you click a printer in the list, the HP Easy Printer Care software opens the Overview tab for that
printer.
Device List tab information includes the following:
Find Other Printers
window

Clicking the Find Other Printers link in the Devices list opens the Find Other Printers window.
The Find Other Printers window provides a utility that detects other network printers so that you
can add them to the Devices list and then monitor those printers from your computer.

Allows you to add more
printers to your printer
list.
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HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. The intuitive browser interface simplifies cross-platform
management of a wide range of devices, including HP and non-HP printers. Management is proactive,
allowing network administrators the ability to resolve printer issues before users are affected. Download
this free, enhanced-management software at http://www.hp.com/go/webjetadmin_software.
To obtain plug-ins to HP Web Jetadmin, click plug-ins, and then click the download link that is next to
the name of the plug-in that you want. The HP Web Jetadmin software can automatically notify you
when new plug-ins are available. On the Product Update page, follow the directions to automatically
connect to the HP Web site.
If installed on a host server, HP Web Jetadmin is available to any client through a supported Web
browser, such as Microsoft Internet Explorer 6.0 for Windows or Netscape Navigator 7.1 for Linux.
Browse to the HP Web Jetadmin host.
NOTE Browsers must be Java-enabled. Browsing from an Apple Macintosh computer is not
supported.
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HP Printer Utility for Macintosh
Use the HP Printer Utility to configure and maintain a printer from a Mac OS X V10.2, V10.3, or V10.4
computer. This section describes several functions that you can perform through the HP Printer Utility.

Open the HP Printer Utility
The process that you use to start the HP Printer Utility depends on the Macintosh operating system that
you are using.
Open the HP Printer Utility in Mac OS X V10.2
1.

Open the Finder, and then click Applications.

2.

Click Library, and then click Printers.

3.

Click hp, and then click Utilities.

4.

Double-click HP Printer Selector to open the HP Printer Selector.

5.

Select the printer that you want to configure, and then click Utilities.

Open the HP Printer Utility in Mac OS X V10.3 or Mac OS X V10.4
1.

In the Dock, click the Printer Setup Utility icon.
NOTE If the Printer Setup Utility icon does not appear in the Dock, open the Finder, click
Applications, click Utilities, and then double-click Printer Setup Utility.

2.

Select the printer that you want to configure, and then click Utilities.

Print a cleaning page
Print a cleaning page if the printer is not printing jobs at the expected quality level.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Color Cleaning.

3.

Click Print Cleaning Page to print the cleaning page.

Print a configuration page
Print a configuration page to view the printer settings.
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1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Configuration Page.

3.

Click Print Configuration Page to print the configuration page.
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View supplies status
View the status of the printer supplies (such as print cartridges, imaging drum, or print media) from a
computer.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Supplies Status.

3.

Click the Supplies tab to view the status of various replaceable supplies, and click the Media tab
to view the status of print media.
●

To view a more detailed status list, click Detailed Supplies Information. The Supplies
Information dialog box appears.

●

To order supplies online, click Order HP Supplies. You must have Internet access in order
to use the online ordering Web page. For more information about online ordering, see Order
supplies online and use other support features.

Order supplies online and use other support features
Use the HP Web site to order printer supplies, register the printer, get customer support, or learn about
recycling printer supplies. You must have Internet access in order to use the supplies and support Web
pages.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select HP Support.

3.

Click one of the following buttons:
●

Instant Support: Opens a Web page that you can use to seek technical assistance.

●

Order Supplies Online: Opens a Web page that you can use to order printer supplies.

●

Online Registration: Opens a Web page that you can use to register the printer.

●

Return & Recycle: Opens a Web page that you can use to find information about recycling
used supplies.

Upload a file to the printer
Send a file from the computer to the printer. The action that the printer takes depends on the type of file
that is being sent to it. For example, when a print-ready file (such as a .PS or .PCL file) is sent, the printer
prints the file.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select File Upload.

3.

Click Choose, navigate to the file that you want to upload, and then click OK.

4.

Click Upload to load the file.
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Update the firmware
Update the printer firmware by loading the new firmware file from the computer. You can find new
firmware files for your printer at http://www.hp.com/support/ljcm4730mfp.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Firmware Update.

3.

Click Choose, navigate to the firmware file that you want to upload, and then click OK.

4.

Click Upload to load the firmware file.

Activate the two-sided printing (duplexing) mode
Turn on the two-sided printing feature on printers equipped with automatic duplexers.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Duplex mode.

3.

Select Enable Duplex Mode to activate the two-sided printing mode, and then click Apply Now.

Lock or unlock printer storage devices
Manage access to printer storage devices from the computer.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Lock Resources.

3.

On the Control Panel Access Level pop-up menu, select the access level that you want to set
for the printer control panel.

4.

Select the devices that you want to lock, and clear any devices that you want to unlock.

5.

Click Apply Now.

Save or print stored jobs
Turn on the printer job-storing function, or print a stored job from the computer. You also can delete a
stored print job.
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1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Stored Jobs.

3.

Perform any of the following tasks:
●

To turn on the job-storing function, select Enable Job Storing, and then click Apply Now.

●

To print a stored job, select a stored job in the list, type the necessary personal identification
number (PIN) in the Enter Secure Job PIN box, type the number of copies that you want in
the Copies To Print box, and then click Print.

●

To delete a stored job, select a stored job in the list, and then click Delete.
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Configure trays
Change the default printer tray settings from the computer.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Tray Configuration.

3.

In the Trays list, select the tray to be configured.
NOTE To make the selected tray the default tray for printing, click Make Default.

4.

In the Default Media Size pop-up menu, select the default media size for the tray.

5.

In the Default Media Type pop-up menu, select the default media type for the tray.

6.

Click Apply Now.

Change network settings
Change the network internet protocol (IP) settings from the computer. You also can open the embedded
Web server to change additional settings. For more information, see Embedded Web server.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select IP Settings.

3.

Change any of the settings in the following pop-up menus or fields:
●

Configuration

●

Host Name

●

IP Address

●

Subnet Mask

●

Default Gateway

If you want to change more settings in the embedded Web server, click Additional Network
Settings. The embedded Web server opens with the Networking tab selected.
4.

Click Apply Now.

Open the embedded Web server
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select Additional Settings.

3.

Click Open Embedded Web Server.
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Set up e-mail alerts
Set up e-mail messages that alert you to certain events that occur with the printer, such as a low toner
level in a print cartridge.
1.

Open the HP Printer Utility.

2.

In the Configuration Settings list, select E-mail Alerts.

3.

Click the Server tab, and, in the SMTP Server box, type the server name.

4.

Click the Destination tab, click the add (+) button, and then type the e-mail addresses, mobile
device numbers, or Web site URLs to which you want the e-mail alerts sent.
NOTE If your printer supports e-mail lists, you can make alerts lists for specific events the
same way that you added e-mail addresses.
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5.

Click the Events tab, and, in the list, define the events for which an e-mail alert should be sent.

6.

To test the alerts setup, click the Server tab, and then click Test. A sample message is sent to the
defined e-mail addresses if the configuration is correct.

7.

Click Apply Now.
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Security features
This section explains important security features that are available for the MFP:
●

Secure the embedded Web server

●

Foreign Interface Harness (FIH)

●

Secure Disk Erase

●

DSS authentication

●

Lock the control-panel menus

Secure the embedded Web server
Assign a password for access to the embedded Web server so that unauthorized users cannot change
the MFP settings.
1.

Open the embedded Web server. See Embedded Web server.

2.

Click the Settings tab.

3.

On the left side of the window, click Security.

4.

Type the password next to New Password, and type it again next to Verify Password.

5.

Click Apply. Make note of the password and store it in a safe place.

Foreign Interface Harness (FIH)
The Foreign Interface Harness (FIH) provides a portal on the MFP. By using the FIH and third-party
equipment, you can track information about copies that are made on the MFP.

Requirements
●

Windows 9X, Windows Me, Windows 2000, or Windows XP

●

Access to third-party accounting hardware solutions, such as Equitrac or Copitrak devices

Use the FIH
To use the FIH, you must download and install the FIH software. The software is available from
http://www.hp.com/go/cljcm4730mfp_software. The software is used to enable or disable the FIH portal.
Use the software to set and change the administrator personal identification number (PIN).
Administrators can use the PIN option to configure the FIH to prevent any unauthorized changes.
Changes can be made only with the correct PIN authentication.
NOTE It is important to remember the PIN that is assigned to the FIH administration software.
The PIN is required to make any changes to the FIH.
Enable the FIH portal
1.

Double-click the FIH.EXE file. The Foreign Interface Harness dialog box appears.

2.

Click OK.
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3.

Click Enable.

4.

If you have not entered a PIN before, click No. If you have entered a PIN before, click Yes. If you
click No, type and confirm the PIN, and then click OK. If you click Yes, type the PIN and click
OK.
NOTE The PIN must be numeric.

5.

Click the appropriate button for the type of connection: Direct or Network. If Direct is selected,
type the MFP port. If Network is selected, type the IP address and port for the MFP.
NOTE The IP address for the MFP can be found on the Configuration page.

If you typed an incorrect IP address, you will receive an error message. Otherwise, the portal is enabled.
Disable the FIH portal
1.

Double-click the FIH.EXE file. The Foreign Interface Harness dialog box appears.

2.

Click OK.

3.

Click Disable.

4.

Type the PIN and click OK.

5.

Click the appropriate button for the type of connection: Direct or Network. If Direct is selected,
type the MFP port and click OK. If Network is selected, type the IP address and port for the MFP,
and then click OK. The portal is disabled.
NOTE If you lose the PIN number and the portal needs to be disabled, try using the default PIN
that is listed to disable it. For assistance, use the HP Instant Support service, which is available
through the embedded Web server or at http://instantsupport.hp.com. See
Embedded Web server.

Secure Disk Erase
To protect deleted data from unauthorized access on the MFP hard drive, use the Secure Disk Erase
feature. This feature can securely erase print and copy jobs from the hard drive.
Secure Disk Erase offers the following levels of disk security:
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●

Non-Secure Fast Erase. This is a simple file-table erase function. Access to the file is removed,
but actual data is retained on the disk until it is overwritten by subsequent data-storage operations.
This is the fastest mode. Non-Secure Fast Erase is the default erase mode.

●

Secure Fast Erase. Access to the file is removed, and the data is overwritten with a fixed identical
character pattern. This is slower than Non-Secure Fast Erase, but all data is overwritten. Secure
Fast Erase meets the U.S. Department of Defense 5220-22.M requirements for the clearing of disk
media.

●

Secure Sanitizing Erase. This level is similar to the Secure Fast Erase mode. In addition, data is
repetitively overwritten by using an algorithm that prevents any residual data persistence. This
mode will impact performance. Secure Sanitizing Erase meets the U.S. Department of Defense
5220-22.M requirements for the sanitization of disk media.
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Data affected
Data affected (covered) by the Secure Disk Erase feature includes temporary files that are created
during the print and copying process, stored jobs, proof and hold jobs, disk-based fonts, disk-based
macros (forms), stored fax files, address books, and HP and third-party applications.
NOTE Stored jobs will be securely overwritten only when they have been deleted through the
Retrieve Job menu on the MFP after the appropriate erase mode has been set.
This feature will not impact data that is stored on flash-based product non-volatile RAM (NVRAM) that
is used to store default settings, page counts, and similar data. This feature does not affect data that is
stored on a system RAM disk (if one is used). This feature does not impact data that is stored on the
flash-based system boot RAM.
Changing the Secure Disk Erase mode does not overwrite previous data on the disk, nor does it
immediately perform a full-disk sanitization. Changing the Secure Disk Erase mode changes how the
MFP cleans up temporary data for jobs after the erase mode has been changed.

Gain access to Secure Disk Erase
Use HP Web Jetadmin to gain access to and set the Secure Disk Erase feature.

Additional Information
For additional information about the HP Secure Disk Erase feature, see the HP support flyer or go to
http://www.hp.com/go/webjetadmin/.

DSS authentication
Optional Digital Sending Software (DSS) for the MFP is available for purchase separately. The software
provides an advanced sending program that contains an authentication process. This process requires
users to type a user identification and a password before they can use any of the DSS features that
require authentication.

Lock the control-panel menus
To prevent someone from changing the MFP configuration, you can lock the control-panel menus. This
prevents unauthorized users from changing the configuration settings such as the SMTP server. The
following procedure describes how to restrict access to the control-panel menus by using the HP Web
Jetadmin software. (See HP Web Jetadmin software.)
1.

Open the HP Web Jetadmin program.

2.

Open the DEVICE MANAGEMENT folder in the drop-down list in the Navigation panel. Navigate
to the DEVICE LISTS folder.

3.

Select the MFP.

4.

In the Device Tools drop-down list, select Configure.

5.

Select Security from the Configuration Categories list.

6.

Type a Device Password.

7.

In the Control Panel Access section, select Maximum Lock. This prevents unauthorized users
from gaining access to configuration settings.

198 Chapter 14 Manage the MFP

ENWW

Set the real-time clock
Use the real-time clock feature to set the date and time settings. The date and time information is
attached to stored print, fax, and digital-send jobs, so you can identify the most recent versions of stored
print jobs.

Set the date format
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Date Format.

5.

Touch the desired format.

6.

Touch Save.

Set the date
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Date.

5.

Touch the appropriate options to set the correct month, date of the month, and the year.

6.

Touch Save.

Set the time format
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Time Format.

5.

Touch the appropriate format.

6.

Touch Save.

Set the time
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1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Time.
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5.

Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

6.

Touch Save.
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Configure alerts
You can use HP Web Jetadmin or the MFP’s embedded Web server to configure the system to alert
you of problems with the MFP. The alerts take the form of e-mail messages to the e-mail account or
accounts that you specify.
You can configure the following:
●

The printer(s) you want to monitor

●

What alerts are to be received (for example, alerts for paper jams, paper out, supplies status, and
cover open)

●

The e-mail account to which the alerts should be forwarded

Software

Information location

HP Web Jetadmin

See the HP Web Jetadmin Help system for details on alerts
and how to set them up.

Embedded Web server

See Embedded Web server for general information about the
embedded Web server.
See the embedded Web server Help system for details on
alerts and how to set them up.
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Upgrade the firmware
The MFP has remote firmware update (RFU) capability. Use the information in this section to upgrade
the MFP firmware.

Determine the current firmware version
1.

From the control panel Home screen, scroll to and touch Administration.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Configuration/status Pages.

5.

Touch Print.

The firmware datecode is listed on the Configuration page in the section called Device Information.
The firmware datecode has this format: YYYYMMDD XX.XXX.X. The first string of numbers is the date,
where YYYY represents the year, MM represents the month, and DD represents the date. For example,
a firmware datecode of that begins with 20061125 represents November 25, 2006.

Download new firmware from the HP Web site
To find the most recent firmware upgrade for the MFP, go to http://www.hp.com/go/
cljcm4730mfp_software. This page provides instructions for downloading the new firmware version.

Transfer the new firmware to the MFP
NOTE The MFP can receive an .RFU file update when it is in a "ready" state.
The elapsed time for an update depends on the I/O transfer time, as well as the time that it takes for the
MFP to re-initialize. The I/O transfer time depends on a number of things, including the speed of the
host computer that is sending the update. If the remote firmware update process is interrupted before
the firmware is downloaded (while Receiving Upgrade appears on the control-panel display), the
firmware file must be sent again. If power is lost during the flash DIMM update (while the Performing
Upgrade message appears on the control-panel display), the update is interrupted and the message
Resend Upgrade appears (in English only) on the control-panel display. In this case, you must send
the upgrade by using the parallel port. Finally, any jobs that are ahead of the RFU job in the queue are
completed before the update is processed.

Use FTP to upload the firmware through a browser
NOTE The firmware update involves a change in the format of nonvolatile random-access
memory (NVRAM). Any menu settings that are changed from the default settings might return to
default settings and must be changed again if you want settings that are different from the
defaults.
1.

Print a configuration page and note the TCP/IP address shown on the EIO Jetdirect page.

2.

Open a browser window.

3.

In the address line of the browser, type ftp://<ADDRESS>, where <ADDRESS> is the address
of the MFP. For example, if the TCP/IP address is 192.168.0.90, type ftp://192.168.0.90.
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4.

Locate the downloaded .RFU file for the MFP.

5.

Drag and drop the .RFU file onto the PORT1 icon in the browser window.
NOTE The MFP turns off and then on automatically to activate the update. When the update
process is complete, a Ready message displays on the MFP control panel.

Use FTP to upgrade the firmware on a network connection
NOTE The firmware update involves a change in the format of nonvolatile random-access
memory (NVRAM). Any menu settings that are changed from the default settings might return to
default settings and must be changed again if you want settings that are different from the
defaults.
1.

Take note of the IP address on the HP Jetdirect page. The HP Jetdirect page is the second page
that prints when you print the configuration page.
NOTE Before upgrading the firmware, make sure that the MFP is not in Sleep mode. Also
make sure that any error messages are cleared from the control-panel display.

2.

Open an MS-DOS command prompt on your computer.

3.

Type: ftp TCP/IP ADDRESS>. For example, if the TCP/IP address is 192.168.0.90, type ftp
192.168.0.90.

4.

Go to the folder where the firmware file is stored.

5.

Press Enter on the keyboard.

6.

When prompted for the user name, press Enter.

7.

When prompted for the password, press Enter.

8.

Type bin at the command prompt.

9.

Press Enter. The message 200 Types set to I, Using binary mode to transfer files appears in
the command window.

10. Type put and then the file name (for example, if the file name is CM4730mfp.efn, type
CM4730mfp.efn).
11. The download process begins and the firmware is updated on the MFP. This can take
approximately five minutes. Let the process finish without further interaction with the MFP or
computer.
NOTE The MFP automatically turns off and then on again after processing the upgrade.
12. At the command prompt, type: bye to exit the ftp command.
13. At the command prompt, type: exit to return to the Windows interface.
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Use HP Web Jetadmin to upgrade the firmware
This procedure requires that you install HP Web Jetadmin Version 7.0 or later on your computer. See
HP Web Jetadmin software. Complete the following steps to update a single device through HP Web
Jetadmin after downloading the .RFU file from the HP Web site.
1.

Start HP Web Jetadmin.

2.

Open the Device Management folder in the drop-down list in the Navigation panel. Navigate to
the Device Lists folder.

3.

Expand the Device Lists folder and select All Devices. Locate the MFP in the list of devices, and
then click to select it.
If you need to upgrade the firmware for multiple HP Color LaserJet CM4730 MFP series MFPs,
select all of them by pressing the Ctrl key as you click the name of each MFP.

4.

Locate the drop-down box for Device Tools in the upper-right corner of the window. Select Update
Printer Firmware from the action list.

5.

If the name of the .RFU file is not listed in the All Available Images box, click Browse in the
Upload New Firmware Image dialog box and navigate to the location of the .RFU file that you
downloaded from the Web at the start of this procedure. If the filename is listed, select it.

6.

Click Upload to move the .RFU file from your hard drive to the HP Web Jetadmin server. After the
upload is complete, the browser window refreshes.

7.

Select the .RFU file from the Printer Firmware Update drop-down menu.

8.

Click Update Firmware. HP Web Jetadmin sends the selected .RFU file to the MFP. The control
panel shows messages that indicate the progress of the upgrade. At the end of the upgrade
process, the control panel shows the Ready message.

Use MS-DOS commands to upgrade the firmware
To update the firmware by using a network connection, follow these instructions.
1.

From a command prompt or in an MS-DOS window, type the following: copy /B FILENAME> \
\COMPUTERNAME>\SHARENAME>, where <FILENAME> is the name of the .RFU file (including the
path), <COMPUTERNAME> is the name of the computer from which the MFP is being shared, and
<SHARENAME> is the MFP share name. For example: C:\>copy /b C:\9200fW.RFU \
\YOUR_SERVER\YOUR_COMPUTER.
NOTE If the file name or path includes a space, you must enclose the file name or path in
quotation marks. For example, type: C:\>copy /b "C:\MY DOCUMENTS
\3500FW.RFU" \\YOUR_SERVER\YOUR_COMPUTER.

2.

Press Enter on the keyboard. The control panel shows a message that indicates the progress of
the firmware upgrade. At the end of the upgrade process, the control panel shows the Ready
message . The message One File Copied appears on the computer screen.

Use the HP Jetdirect firmware
The HP Jetdirect network interface in the MFP has firmware that can be upgraded separately from the
MFP firmware. This procedure requires that you install HP Web Jetadmin Version 7.0 or later on your
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computer. See HP Web Jetadmin software. Complete the following steps to update the HP Jetdirect
firmware by using HP Web Jetadmin.
1.

Open the HP Web Jetadmin program.

2.

Open the Device Management folder in the drop-down list in the Navigation panel. Navigate to
the Device Lists folder.

3.

Select the device that you want to update.

4.

In the Device Tools drop-down list, select Jetdirect Firmware Update.

5.

Under Jetdirect firmware version the HP Jetdirect model number and current firmware version
are listed. Make a note of these.

6.

Go to http://www.hp.com/go/wja_firmware.

7.

Scroll down to the list of HP Jetdirect model numbers and find the model number you wrote down.

8.

Look at the current firmware version for the model, and see if it is later than the version you wrote
down. If it is, right-click on the firmware link, and follow the instructions on the Web page to
download the new firmware file. The file must be saved into the <drive>:\PROGRAM FILES
\HP WEB JETADMIN\DOC\PLUGINS\HPWJA\FIRMWARE\JETDIRECT folder on the computer
that is running the HP Web Jetadmin software.

9.

In HP Web Jetadmin, return to the main device list and select the digital sender again.

10. In the Device Tools drop-down list, select Jetdirect Firmware Update again.
11. On the HP Jetdirect firmware page, the new firmware version is listed under Jetdirect Firmware
Available on HP Web Jetadmin. Click the Update Firmware Now button to update the Jetdirect
firmware.
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Manage memory
This MFP supports up to 544 MB of memory: 512 MB DDR plus 32 MB of additional memory on the
formatter board. You can add additional memory by installing dual data-rate (DDR) memory. To allow
for memory expansion, the MFP has two DDR slots, which accept 128 or 256 MB of RAM each. For
information about installing memory, see Install memory and print server cards.
The MFP features Memory Enhancement Technology (MEt), which automatically compresses page
data to provide the most efficient use of the MFP’s RAM.
The MFP uses DDR SODIMM. Extended data output (EDO) DIMMs are not supported.
NOTE If memory problems occur when you are printing complex graphics, you can make more
memory available by removing downloaded fonts, style sheets, and macros from MFP memory.
Reducing the complexity of a print job from within a software program can help avoid memory
problems.
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Manage supplies
Use genuine HP print cartridges for the best printing results.

HP print cartridges
When you use a genuine new HP print cartridge, you can obtain the following supplies information:
●

Percentage of supplies remaining

●

Estimated number of pages remaining

●

Number of pages printed
NOTE See Supplies and accessories for cartridge ordering information.

Non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured. Because they are not genuine HP products, HP cannot influence their design or control
their quality. Service or repair required as a result of using a non-HP print cartridge will not be covered
under the MFP warranty.
If the non-HP print cartridge was sold to you as a genuine HP product, see HP fraud hotline.

Print cartridge authentication
The HP Color LaserJet CM4730 MFP series automatically authenticates the print cartridges when the
cartridges are inserted into the MFP. During authentication, the MFP will let you know if a cartridge is a
genuine HP print cartridge.
If the MFP control panel message states that this is not a genuine HP print cartridge and you believe
you purchased an HP print cartridge, call the HP fraud hotline.
To override a non-HP print cartridge error message, touch OK.

HP fraud hotline
Call the HP fraud hotline (1-877-219-3183, toll-free in North America) when you install an HP print
cartridge and the MFP message says the cartridge is non-HP. HP will help determine if the product is
genuine and take steps to resolve the problem.
The following issues are signs that your print cartridge might not be a genuine HP print cartridge:
●

A high number of problems occur with the print cartridge.

●

The cartridge does not look like it usually does (for example, the packaging differs from HP
packaging).

Print cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.
CAUTION To prevent damage to the print cartridge, do not expose it to light for more than a
few minutes.
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Table 14-1 Print cartridge temperature specifications
Environmental condition

Recommended

Allowed

Storage/standby

Temperature (print cartridge)

17° to 25°C (62.6° to 77°F)

15° to 30°C (59° to 86°F)

-20° to 40°C (-4° to 104°F)

Print cartridge life expectancy
The life of the print cartridge depends on usage patterns and the amount of toner that print jobs require.
HP print cartridges last an average of 12,000 pages when printing on letter or A4-size paper at 5%
coverage for each print cartridge. Usage conditions and print patterns may cause actual results to vary.

Check the print cartridge life
You can check the print cartridge life on the MFP control panel, in the embedded Web server, MFP
software, HP Easy Printer Care software, or through the HP Web Jetadmin software.

On the MFP control panel
1.

From the Home screen, touch Administration.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Supplies Status Page.

5.

Touch Print.
NOTE If you are using non-HP supplies, the supplies status page might not show the remaining
life for those supplies.

In the embedded Web server
1.

In your browser, type the IP address or host name for the printer home page. This takes you to the
printer status page.

2.

On the left side of the screen, click Supplies Status. This takes you to the supplies status page,
which provides print cartridge information.

Through HP Easy Printer Care software
In the Overview tab in the Supplies Status section, click Supplies Details to open the supplies status
page.

Through HP Web Jetadmin
In HP Web Jetadmin, select the printer device. The device status page shows print cartridge information.
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Replace supplies

●

Clean the MFP

●

ADF maintenance kit

●

Calibrate the scanner
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Replace supplies
When you use genuine HP supplies, the MFP automatically notifies you when supplies are nearly
depleted. The notification to order supplies allows ample time to order new supplies before they need
to be replaced. For more information about ordering supplies, see Supplies and accessories

Locate supplies
Supplies are identified by their labeling and their blue plastic handles.
The following figure illustrates the location of each supply item.

Figure 15-1 Supply item locations
1

Fuser

2

Print cartridges

3

Transfer unit

Supply replacement guidelines
To facilitate the replacement of supplies, keep the following guidelines in mind when setting up the MFP.
●

Allow sufficient space above and in the front of the MFP for removing supplies.

●

The MFP should be located on a flat, sturdy surface.

For instructions on installing supplies, see the installation guides provided with each supply item or see
more information at http://www.hp.com/support/ljcm4730mfp. When you connect, select Solve a
Problem.
CAUTION Hewlett-Packard recommends the use of genuine HP products in this MFP. Use of
non-HP products may cause problems requiring service that is not covered by the HewlettPackard extended warranty or service agreements.

Approximate replacement intervals for supplies
The following table lists the estimated replacement intervals for supplies and the control panel messages
that prompt when to replace each item. Usage conditions and print patterns may cause results to vary.
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1
2

Item

Printer message

Page count

Approximate time period

Black cartridges

Replace Black Cartridge

12,000 pages1

3 months

Color cartridges

Replace <color> Cartridge

12,000 pages1

3 months

Image transfer kit

Replace Transfer Kit

120,000 pages2

40 months

Image fuser kit

Replace Fuser Kit

150,000 pages

50 months

Stapler cartridge

Replace Stapler Cartridge

5000 pages

ADF maintenance kit

Replace Document Feeder
Kit

90000 pages

Approximate average A4-/letter-size page count based on 5% coverage of individual colors.
Approximate life is based on 4,000 pages per month.

Change print cartridges
When a print cartridge approaches the end of its useful life, the control panel displays a message
recommending that you order a replacement. The MFP can continue to print using the current print
cartridge until the control panel displays a message instructing you to replace the cartridge.
The MFP uses four colors and has a different print cartridge for each color: black (K), magenta (M), cyan
(C), and yellow (Y).
Replace a print cartridge when the MFP control panel displays a Replace <color> Cartridge message.
The control panel display will also indicate the color that should be replaced (if a genuine HP cartridge
is currently installed). Replacement instructions are included in the print-cartridge box.
CAUTION If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold
water. Hot water sets toner into fabric.
NOTE For information about recycling used print cartridges, go to http://www.hp.com/go/
recycle.
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Clean the MFP
To maintain print quality, clean the MFP thoroughly every time you replace the print cartridge and
whenever print-quality problems occur.
WARNING! Avoid touching the fusing area when cleaning the MFP. It can be hot.
CAUTION To avoid permanent damage to the print cartridge, do not use ammonia-based
cleaners on or around the MFP except as directed.

Clean the outside of the MFP
●

Clean the outside of the MFP if it is visibly marked.

●

Use a soft, lint-free cloth dampened with water, or water and a mild detergent.

Clean the touchscreen
Clean the touchscreen whenever it is necessary to remove fingerprints or dust. Wipe the touchscreen
gently with a clean, water-dampened, lint-free cloth.
CAUTION Use water only. Solvents or cleaners can damage the touchscreen. Do not pour or
spray water directly onto the touchscreen.

Clean the scanner glass
●

Clean the scanner glass only if dirt is visible, or if you are experiencing a decrease in copy quality,
such as streaking.

●

Clean the scanner glass by wiping it gently with a clean, slightly damp, lint-free cloth. Use an
ammonia-based surface cleaner only when a water-dampened cloth does not clean the scanner
glass.

CAUTION Do not pour or spray liquids directly onto the scanner glass. Do not press hard on
the glass surface. (You could break the glass).
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Cleaning the ADF delivery system
Clean the ADF only if it is visibly marked or dirty, or if you are experiencing a decrease in copy quality
(such as streaking).

Clean the ADF delivery system

ENWW

1.

Open the scanner lid.

2.

Locate the white, vinyl ADF backing.

3.

Clean the ADF backing by wiping them with a clean, damp, lint-free cloth. Use an ammonia-based
surface cleaner only when a water-dampened cloth does not clean the ADF components.

4.

Clean the scanner glass by wiping it gently with a clean, slightly damp, lint-free cloth. Use an
ammonia-based surface cleaner only when a water-dampened cloth does not clean the scanner
glass.
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5.

Close the scanner lid.

Clean the ADF rollers
You should clean the rollers in the ADF if you are experiencing misfeeds or if your originals show marks
as they exit the ADF.
CAUTION Clean the rollers only if you experience misfeeds or marks on the originals, and you
notice dust on the rollers. Cleaning the rollers frequently could introduce dust into the device.
1.

Open the scanner lid.
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2.

Locate the rollers near the white vinyl ADF backing.

3.

Wipe the rollers gently with a clean, water-dampened, lint-free cloth.
CAUTION Do not pour water directly onto the rollers. Doing so might damage the device.

4.
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Close the scanner lid.
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5.

Pull the release lever to open the ADF cover.

6.

Locate the rollers.

7.

Wipe the rollers with a clean, water-dampened, lint-free cloth.
CAUTION Do not pour water directly onto the rollers. Doing so might damage the device.
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8.

Locate the separation pad.

9.

Wipe the pad with a clean, water-dampened, lint-free cloth.

10. Close the ADF cover.

Clean the mylar strip
Clean the mylar strips on the underside of the scanner lid only if you are experiencing a decrease in
copy quality (such as vertical lines) when copying using the ADF.
1.
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Open the scanner lid.
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2.

Locate the mylar strip (1).

NOTE Replacement mylar strips are stored in an envelope (2) that is underneath the white
vinyl ADF backing. Follow the instructions that are in the envelope.
3.

Clean the mylar strip with a clean, damp, lint-free cloth.

4.

Close the scanner lid.
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ADF maintenance kit
After feeding 90,000 pages through the ADF, a Replace Document Feeder Kit message appears on
the control-panel display. This message appears approximately one month before the kit needs to be
replaced. Order a new kit when this message appears. See Part numbers for information about ordering
a new ADF maintenance kit.
The ADF maintenance kit includes the following items:
●

One pick-up roller assembly

●

One separation pad

●

One mylar sheet kit

●

An instruction sheet

Follow the instructions that come with the kit to install it.
After replacing the kit, reset the ADF maintenance-kit count.
Reset the ADF maintenance-kit count

ENWW

1.

On the control panel, scroll to and touch Administration.

2.

Touch Resets.

3.

Touch Reset Supplies.

4.

Touch ADF Maintenance Kit.

5.

Touch Yes.

6.

Touch Save.
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Calibrate the scanner
Calibrate the scanner to compensate for offsets in the scanner imaging system (carriage head) for ADF
and flatbed scans. Because of mechanical tolerances, the scanner's carriage head might not read the
position of the image accurately. During the calibration procedure, scanner offset values are calculated
and stored. The offset values are then used when producing scans so that the correct portion of the
document is captured.
Scanner calibration should be carried out only if you notice offset problems with the scanned images.
The scanner is calibrated before it leaves the factory. It needs to be calibrated again only rarely.
Before calibrating the scanner, print the calibration target.
1.

Place letter- or A4-size paper in tray 1, and adjust the side guides.

2.

On the control-panel Home screen, scroll to and touch Administration.

3.

Touch Troubleshooting.

4.

Touch Calibrate Scanner.

5.

Touch Calibrate to print the first pass of the calibration target.

6.

Place the first pass of the calibration target face-down in tray 1 so that the arrows are facing into
the MFP.

7.

Touch Start to print the second pass. The final calibration target must look like the following figure.

CAUTION If the calibration target does not look like the figure shown here, the calibration
process will fail and the quality of scans will be degraded. The black areas must extend
completely to the short edges of the page. If they do not, use a black marker to extend the
black areas to the edge of the page. Ensure that the paper is loaded properly.
8.

Place the calibration target face-up into the ADF, and adjust the side guides.

9.

After the calibration target has passed through the ADF once, reposition it face down in the ADF
and touch Start.

10. Place the calibration target face-down on the scanner glass, touch Start, and scan the page. After
this pass, the calibration is complete.
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●

Determining MFP problems

●
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Solve network connectivity problems

●

Solve common Macintosh problems
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Solving general problems
If the MFP is not responding properly, complete the steps in the following checklist, in order. If the MFP
does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves the
problem, you can stop without performing the other steps on the checklist.

Troubleshooting checklist
1.

2.

Make sure the MFP Ready light is on. If no lights are on, complete these steps:
a.

Check the power-cable connections.

b.

Check that the power switch is on.

c.

Check the power source by plugging the MFP directly into the wall or into a different outlet.

d.

If none of these measures restores power, contact HP Customer Care.

Check the cabling.
a.

Check the cable connection between the MFP and the computer or network port. Make sure
that the connection is secure.

b.

Make sure that the cable itself is not faulty by using a different cable, if possible.

c.

Check the network connection. See Solve network connectivity problems.

3.

Ensure that the print media that you are using meets specifications.

4.

Print a configuration page (see Information pages. If the MFP is connected to a network, an
HP Jetdirect page also prints.)

5.

6.

a.

If the pages do not print, check that at least one tray contains print media.

b.

If the page jams in the MFP, see Jams.

If the configuration page prints, check the following items.
a.

If the page prints correctly, then the MFP hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

b.

If the page does not print correctly, the problem is with the MFP hardware. Contact
HP Customer Care.

Select one of the following options:
Windows: Click Start, click Settings, and then click Printers, or Printers and Faxes. Double click
HP Color LaserJet CM4730 MFP.
-orMac OS X: Open Print Center, (or Printer Setup Utility for Mac OS X v. 10.3), and double-click
the line for the HP Color LaserJet CM4730 MFP.

7.

Verify that you have installed the HP Color LaserJet CM4730 MFP series printer driver. Check the
program to make sure that you are using an HP Color LaserJet CM4730 MFP series printer driver.
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8.

9.
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Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print) complete these steps:
a.

Try printing the job from another computer that has the MFP software installed.

b.

If you connected the MFP to the network, connect the MFP directly to a computer with a
parallel cable. Redirect the MFP to the correct port, or reinstall the software, selecting the new
connection type that you are using.

If the problem is still not resolved, see Determining MFP problems.
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Determining MFP problems
Situation/Message

Solution

The control-panel display is blank, and internal fans are not
running.

Make sure that the MFP power is on. Press all the keys to see
if one is stuck. Contact your HP-authorized service
representative if these steps do not work.

The MFP is turned on, but the internal fans are not running.

Make sure that the line voltage is correct for the MFP power
configuration. (See the label that is inside the top cover on the
MFP for voltage requirements.) If you are using a power strip
and its voltage is not within specification, plug the MFP directly
into the power receptacle.

The MFP voltage is not correct.

Make sure that the line voltage is in the correct range. (See the
label that is inside the top cover on the MFP for voltage
requirements.)

Messages appear on the control-panel display.

See Electrical specifications.

Print media is jammed in the MFP.

Check for jams. For more information, see Jams.

The control-panel display shows the wrong language or
unfamiliar characters.

Reconfigure the control-panel display language.
1.

Turn the MFP off and then on.

2.

When XXX MB appears on the control-panel display,
press and hold 6 until all three LEDs flash once and then
stay on. (This might take up to 20 seconds.

3.

Release 6 and then press 6 again.

4.

Wait while the MFP completes its initialization sequence.
When it is finished, the Select a Language menu
appears on the control-panel display. Scroll to and touch
the correct language.

An error occurs during a Digital Send job. Job failed.

The MFP experienced an error during the digital sending job.
The administrator should check on the status of the SMTP
server. See Solve e-mail problems.

The e-mail gateway could not accept the job because the
attachment is too large.

Reduce the size of the e-mail attachment by setting the
maximum attachment size. Set the maximum attachment size
on the Digital Sending tab of the embedded Web server. See
Embedded Web server.
Try using a different file format or sending the document a few
pages at a time.

A network connection is required for digital sending
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The MFP cannot find a network connection. The administrator
should check to see if the MFP is connected to the network.
See Solve network connectivity problems.
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Control-panel message types
Four types of control-panel messages can indicate the status of or problems with the device.
Message type

Description

Status messages

Status messages reflect the current state of the device. They inform you of normal device operation
and require no interaction to clear them. They change as the state of the device changes. Whenever
the device is ready, not busy, and has no pending warning messages, the status message Ready
appears if the device is online.

Warning messages

Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you touch OK. Some warning messages are clearable.
If Clearable Warnings is set to Job on the device Device Behavior menu, the next print job clears
these messages.

Error messages

Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.
Some error messages are auto-continuable. If Auto-Continue is set on the menus, the device will
continue normal operation after an auto-continuable error message appears for 10 seconds.
NOTE Pressing any button during the 10-second auto-continuable error message overrides
the auto-continue feature, and the button function takes precedence. For example, pressing
the Stop button pauses printing and offers the option to cancel the print job.

Critical-error messages
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Critical error messages inform you of a device failure. Some of these messages can be cleared by
turning the device off and then on. These messages are not affected by the Auto-Continue setting.
If a critical error persists, service is required.
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Control-panel messages
Table 16-1 Control-panel messages
Control panel message

Description

Recommended action

10.32.00 Unauthorized Supply

An unauthorized print cartridge has been
installed.

1.

Install genuine HP supplies.

2.

If the message persists after loading
authorized cartridges, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

10.XX.YY SUPPLY MEMORY ERROR

The MFP cannot read or write to at least one
print cartridge e-label or an e-label is missing
from a print cartridge.

Reinstall the print cartridge, or install a new
HP print cartridge.

11.XX Internal clock error To continue
touch OK

The MFP real time clock has experienced an
error.

Whenever the MFP is turned off and then
turned on again, set the time and date at the
control panel. See Use the control panel.
If the error persists, you might need to replace
the formatter.

13.01.00 JAM IN TRAY 1

13.01.11 JAM INSIDE LOWER RIGHT
DOOR

13.02.00 JAM INSIDE RIGHT DOORS

13.05.00 JAM INSIDE RIGHT DOORS

13.06.00 JAM INSIDE UPPER RIGHT
DOOR
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Paper is jammed in tray 1.

There is a paper jam inside the lower right
door, or the paper did not feed from the paper
tray.

There is a paper jam inside the right doors.

There is a paper jam inside the right doors.

There is a paper jam inside the right doors.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

13.09.00 JAM INSIDE FRONT SMALL
DOOR

There is a paper jam in the small door of the
output accessory bridge.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

There is a paper jam in the output accessory
(stapler/stacker or 3-bin mailbox).

1.

Follow the onscreen instructions to find
and remove the jammed media.

Includes:

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

13.11.00 JAM INSIDE UPPER RIGHT
DOOR

13.12.XX JAM IN LEFT ACCESSORY

There is a paper jam in the small door of the
output accessory bridge.

13.12.07
13.12.08
13.12.09
13.12.10
13.12.11
13.13.00 JAM INSIDE RIGHT DOORS

13.20.00 JAM IN TRAY X

13.20.00 JAM INSIDE RIGHT DOORS

13.21.00 JAM IN TRAY X
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There is a paper jam in the right side of the
MFP.

There is a paper jam in the paper tray
indicated.

There is a paper jam in the right side of the
MFP.

There is a paper jam inside the upper right
door or inside the fusing unit.

Control-panel messages 227

Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

13.30.00 JAM INSIDE DRAWER BELOW
TRAY 1

There is a paper jam inside the lower right
door.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

1.

Follow the onscreen instructions to find
and remove the jammed media.

2.

If the message persists after clearing all
pages, contact HP Support at
http://www.hp.com/support/
ljcm4730mfp.

13.31.00 JAM INSIDE UPPER RIGHT
DOOR

13.XX.YY EXTERNAL OUTPUT DEVICE
PAPER JAM

13.XX.YY JAM IN OUTPUT AREA

13.XX.YY JAM IN OUTPUT DEVICE

13.XX.YY Jam In Stapler

13.XX.YY JAM INSIDE OUTPUT
ACCESSORY BRIDGE

There is a paper jam inside the upper right
door or inside the fusing unit.

There is a jam in the stapler/stacker.

There is a paper jam in the output area.

Paper is jammed in an external paper
handling device.

A staple is jammed in the stapler. Check the
stapler/stacker for jammed staples.

There is a paper jam inside the output
accessory bridge.

20 INSUFFICIENT MEMORY To continue
touch OK

The MFP received more data than can fit in
the available memory. You might have tried
to transfer too many macros, soft fonts, or
complex graphics.

Touch OK to print the transferred data (some
data might be lost), and then simplify the print
job or install additional memory.

21 PAGE TOO COMPLEX To continue
touch OK

The page formatting process was not fast
enough for the MFP.

Touch OK to print the transferred data.
(Some data might be lost.) If this message
appears often, simplify the print job.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

22 EIO X BUFFER OVERFLOW To
continue touch OK

Too much data was sent to the EIO card in
the specified slot (x). An incorrect
communications protocol might be in use.

Touch OK to print the transferred data.
(Some data might be lost.)
Check the host configuration. If this message
persists, contact an HP-authorized service or
support provider. (See the HP support flyer,
or go to http://www.hp.com/support/
ljcm4730mfp.)

22 EMBEDDED I/O BUFFER OVERFLOW
To continue touch OK

Too much data was sent to the embedded HP
Jetdirect print server.

Touch OK to print the transferred data.
(Some data might be lost.)

30.1.YY SCANNER FAILURE

An error has occurred in the scanner.

Check the scanner lock. Turn the MFP off and
then on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

40 BAD EIO X TRANSMISSION To
continue touch OK

The connection between the MFP and the
EIO card in the specified slot has been
broken.

Touch OK to clear the error message and
continue printing.

40 BAD SERIAL TRANSMISSION To
continue touch OK

A serial data error (parity, framing, or line
overrun) occurred as data was being sent by
the computer.

Touch OK to clear the error message. (Data
will be lost.)

40 EMBEDDED I/O BAD TRANSMISSION
To continue touch OK

A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

41.3 LOAD TRAY XX <TYPE> <SIZE>

This is typically caused if two or more sheets Reload the tray with the correct media size.
of media stick together in the MFP or if the
Reconfigure the size in a tray so that the MFP
tray is not adjusted correctly.
will use a tray that contains the size required
for the print job. Follow the instructions in the
onscreen dialog box.

41.3 LOAD TRAY XX <TYPE> <SIZE> To
use another tray touch OK

The specified tray is loaded with media that
is longer or shorter in the feed direction than
the size adjusted for the tray.

Touch OK to use another tray. Reconfigure
the size in a tray so that the MFP will use a
tray that is loaded with the size of media
required for the print job. If the message does
not clear automatically from the control-panel
display, turn the MFP off, and then turn the
MFP on.

41.X ERROR To continue touch OK

A temporary printing error occurred.

Touch OK to clear the error. If the error is not
cleared, turn the MFP off, and then turn the
MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

49.XXXXX ERROR To continue turn off
then on

A critical firmware error has occurred.

Remove third-party devices. Turn the MFP
off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

50.X FUSER ERROR

A fuser error has occurred.

Make sure you have the correct fuser. Reseat the fuser. Turn the MFP off, and then
turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

51.XY ERROR To continue turn off then on A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

52.XY ERROR To continue turn off then on A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

53.10.0X Unsupported DIMM

55.XX.YY DC CONTROLLER ERROR To
continue turn off then on

An unsupported DIMM is installed.

The print engine is not communicating with
the formatter.

1.

Turn the MFP off, and then replace the
DIMM that caused the error.

2.

If this message persists, contact an HPauthorized service or support provider.
(See the HP support flyer, or go to
http://www.hp.com/support/
ljcm4730mfp.)

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

56.X ERROR To continue turn off then on

A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

57.XX ERROR To continue turn off then on A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

58.XX ERROR To continue turn off then on A temporary printing error has occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

59.XY ERROR To continue turn off then on A temporary printing error has occurred.
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Turn the MFP off, and then turn the MFP on.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

60.X ERROR To continue turn off then on

The tray specified by X is not lifting correctly.

Follow the instructions in the onscreen dialog
box.

62 NO SYSTEM To continue turn off then
on

A problem exists with the MFP firmware.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

64 ERROR To continue turn off then on

A scan buffer error occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

66.12.34 OUTPUT ACCESSORY FAILURE

66.XY.ZZ OUTPUT DEVICE FAILURE

68.X PERMANENT STORAGE FULL To
continue touch OK
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An output accessory is not functioning
properly.

An error occurred in an external paperhandling accessory.

The MFP NVRAM is full. Some settings
saved in the NVRAM might have been reset
to the factory defaults. Printing can continue,
but some unexpected functions might occur
if an error occurred in permanent storage.

1.

Turn off the MFP.

2.

Verify that all external paper-handling
devices are securely connected.

3.

If the device uses cables, disconnect
and reconnect them.

4.

Turn on the MFP. If error reappears,
write down the message and contact HP
support.

1.

Turn the MFP power off.

2.

Check that the accessory is properly
seated on and connected to the MFP,
without any gaps between the MFP and
the accessory. If the accessory uses
cables, disconnect and reconnect them.

3.

Verify that there is no packaging
material in or around the output device.

4.

Turn the MFP power on.

5.

If this message persists, contact an HPauthorized service or support provider.
(See the HP support flyer, or go to
http://www.hp.com/support/
ljcm4730mfp.)

Touch OK to clear the message. If the
message is not cleared, turn the MFP off, and
then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

68.X PERMANENT STORAGE WRITE FAIL The MFP NVRAM is failing to write. Printing
To continue touch OK
can continue, but some unexpected functions
might occur if an error occurred in permanent
storage.

Recommended action
Touch OK to clear the message. If the
message is not cleared, turn the MFP off, and
then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

68.X STORAGE ERROR SETTINGS
CHANGED To continue touch OK

69.X ERROR To continue turn off then on

One or more MFP settings are invalid and
have been reset to the factory-default
settings. Printing can continue, but some
unexpected functions might occur if an error
occurred in permanent storage.

Touch OK to clear the message. If the
message is not cleared, turn the MFP off, and
then turn the MFP on.

A temporary printing error occurred.

Turn the MFP off, and then turn the MFP on.

If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)
79 ERROR To continue turn off then on

A critical hardware error occurred.

Turn the MFP off, and then turn the MFP on.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

8X.YYYY EIO ERROR

The EIO accessory card has encountered a
critical error, as specified by YYYY.

Try the following actions to clear the
message.
1.

Turn the MFP off, and then turn the MFP
on.

2.

Turn the MFP off, reseat the EIO
accessory, and then turn the MFP on.

3.

Replace the EIO accessory.

8X.YYYY EMBEDDED JETDIRECT ERROR The embedded HP Jetdirect print server has
encountered a critical error, as specified by
YYYY.

Turn the MFP off, and then turn the MFP on.

Access denied MENUS LOCKED

The control panel function that you are trying
to use has been locked to prevent
unauthorized access.

Contact the network administrator.

ACTION NOT CURRENTLY AVAILABLE
FOR TRAY X TRAY SIZE CANNOT BE ANY
SIZE/ANY CUSTOM

A duplexed (2-sided) document was
requested from a tray that is set to Any Size
or Any Custom. Duplexing is not allowed
from a tray configured to Any Size or Any
Custom.

Select another tray or reconfigure the tray.

Authentication information is incorrect.
Please re-enter information.

A user name or password is incorrect.

Type the information again.

232 Chapter 16 Problem solving

If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

Authentication required

Authentication has been enabled for this
feature or destination. A username and
password are required.

Type the user name and password, or contact
the network administrator.

Authentication required to use this
feature

A user name and password are required.

Type the user name and password, or contact
the network administrator.

Bad duplexer connection To continue turn
off then on

The duplex printing accessory is not
connected correctly to the MFP.

If this message persists, contact an HPauthorized service or support provider. See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.

Calibrating

The MFP is calibrating.

No action is necessary.

Check output device

An error has occurred with the output device.

Remove and reinstall the output device.

Chosen personality not available. To
continue touch OK.

A print job requested a MFP language
(personality) that is not available for this MFP.
The job will not print and will be cleared from
memory.

Print the job by using a printer driver for a
different printer language, or add the
requested language to the MFP (if possible).
To see a list of available personalities, print a
configuration page. (See Information pages.)

Close drawer below Tray 1

One or more of the drawers below tray 1 is
open.

1.

Close the drawers below tray 1.

2.

If the message persists, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

1.

Close the door.

2.

If the message persists, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

1.

Close the small front door.

2.

If the message persists, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

Close right doors

Close small front door

A door on the right side of the MFP is open.

The small front door is open.

Digital Send Communication Error

An error has occurred during a digital send
task.

Contact the network administrator.

Digital Send server is not responding
Contact administrator

The MFP cannot communicate with the
server.

Verify the network connection. Contact the
network administrator.

Document feeder bin full

The document feeder output bin holds 50
sheets of paper. The MFP stops when the bin
is full.

Remove the paper from the document feeder
output bin.

Document feeder cover open

The document feeder cover is open.

Close the document feeder cover. Follow the
instructions in the onscreen dialog box.

Document feeder pick error

The document feeder experienced an error
while picking media.

Make sure that you have not overloaded the
document feeder. Do not load more than 50
sheets of 20 lb paper in the document feeder.

E-mail Gateway did not accept the job
because the attachment was too large.

The scanned documents have exceeded the
size limit of the server.

Send the job again using a lower resolution,
smaller file size setting, or fewer pages.
Contact the network administrator to enable
sending the scanned documents by using
multiple e-mails.

E-mail Gateway did not respond. Job
failed.

A gateway has exceeded the time out value.

Validate the SMTP IP address.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

E-mail Gateway rejected the job because
of the addressing information. Job failed.

One or more of the e-mail addresses is
incorrect.

Send the job again with the correct
addresses.

Error executing Digital Send job. Job
failed.

A digital send job has failed and cannot be
delivered.

Try to send the job again.

Folder list is full. To add a folder, you must The MFP limits the number of folders that can
first delete a folder.
be established.

Delete an unused folder to add a new folder.

HP Digital Sending: Delivery Error

A digital send job has failed and cannot be
delivered.

Try to send the job again.

Incorrect <color> Cartridge

A print cartridge is in the incorrect color slot.

Verify that each color cartridge is in the
correct slot.

Incorrect Supplies

A print cartridge is in the incorrect color slot.

Verify that each color cartridge is in the
correct slot.

Insert or close tray XX

The specified tray is missing or open.

Insert or close the specified tray to continue.

Install <color> cartridge

The print cartridge has been removed or has
been installed incorrectly.

Replace or reinstall the print cartridge
correctly to continue printing.

Install supplies

At least one supply item is missing,
incorrectly placed, out, or low.

Insert the supply item or make sure the
installed supply item is fully seated.

Insufficient memory to load fonts/data
<device> To continue touch OK

The MFP does not have enough memory to
load the data (for example, fonts or macros)
from the location specified.

Touch OK to continue without this
information. If the message persists, add
more memory.

JAM IN DOCUMENT FEEDER

Media is jammed in the document feeder.

Remove jammed media from the document
feeder. Follow the instructions in the
onscreen dialog box.
If the message persists after all jams have
been cleared, a sensor might be stuck or
broken. Contact an HP-authorized service or
support provider. See the HP support flyer, or
go to http://www.hp.com/support/
ljcm4730mfp.

LDAP Server is not responding Contact
administrator

The LDAP server has exceeded the time out
value for an address request.

Verify the LDAP server address. Contact the
network administrator.

Load Tray 1 <type> <size>

The tray is empty or configured for a different
size than the size requested.

Follow the instructions in the onscreen dialog
box.

Manually feed <type> <size>

The specified job requires manual feed from
tray 1.

Load the requested media into tray 1.
To override the message, touch OK to use a
type and size of media that is available in
another tray.

Network connection required for Digital
Sending. Contact administrator.

A digital-sending feature has been
configured, but a network connection is not
detected.

Verify the network connection. See Solve
network printing problems. Contact the
network administrator.

Non-HP supply installed

A refilled color or a cloned color/mono
cartridge has been installed, and the printer
previously used all genuine HP supplies. It
can also appear when an unauthorized
cartridge has been installed, and the printer
previously used all genuine supplies.

Install a genuine HP cartridge, or touch OK to
override the condition.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

Novel login required

Novell authentication has been enabled for
this destination.

Enter Novell network credentials to access
the requested feature.

Order <color> Cartridge

The identified print cartridge is nearing the
end of its useful life. The MFP is ready and
will continue for the estimated number of
pages indicated. Estimated pages remaining
is based upon the historical page coverage of
this MFP.

Order a replacement print cartridge.

Printing will continue until a supply needs to
be replaced.
Order Fuser Kit

The fuser is near end of life. The MFP is ready
and will continue for the estimated number of
pages indicated. Printing will continue until a
supply needs to be replaced.

Order a replacement fuser kit.

Order staple cartridge

The staple cartridge needs to be replaced.

1.

Replace the staple cartridge.

Order Supplies

One or more supplies needs to be replaced.

1.

Replace the supply.

Order Transfer Kit

The transfer kit is near end of life. Printing can
continue.

Order a replacement transfer kit.

Output bin <x> full

The specified output bin is full and printing
cannot continue.

Empty the bin to continue printing.

Output paper path open

The paper path between the MFP and the
output device is open and must be closed
before printing can continue.

1.

If you have a 3-bin mailbox installed,
make sure the jam-access door is
closed.

2.

If you have a stapler/stacker installed,
make sure the staple cartridge is
snapped into position and that the
staple-cartridge door is closed.

Password or name is incorrect. Please
enter correct login.

The user name or password was typed
incorrectly.

Retype the user name and password.

Performing Color Band Test

The color-band test is being performed.

No action is necessary.

PIN is incorrect. Please re-enter PIN.

The PIN was typed incorrectly.

Retype the PIN.

Please turn device off and install hard
disk.

The requested job requires a hard disk, but
the MFP does not have a hard disk installed.

Turn the MFP off and install a hard disk.

Printing CMYK Samples

The CMYK-samples page is being
generated. The device will return to the ready
state upon completion of the page

No action is necessary.

Printing Color Usage Log

The color-usage-log page is being
No action is necessary.
generated. The printer will return to the ready
state upon completion of the page.

Printing Demo Page

This message displays while the demo page
is being generated. The device will return to
the ready state upon completion of the page.

No action is necessary.

Printing Diagnostics Page

This message displays while the diagnostics
page is being generated. The device will
return to the ready state upon completion of
the page.

No action is necessary.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

Printing PQ Troubleshooting

This message is displayed while the print
quality troubleshooting test is being
generated. The device will return to the ready
state upon completion of the test.

No action is necessary.

Printing RGB Samples

This message displays while the print-quality
troubleshooting test is being generated. The
device will return to the ready state upon
completion of the page

No action is necessary.

Reattach output bin

The standard output bin was detached when
the MFP was turned on, or the cable on the
stapler/stacker or the 3-bin mailbox is not
connected to the MFP.

Turn the MFP off. If you are using the stapler/
stacker or the 3-bin mailbox, make sure that
the cable is connected to the MFP. Reattach
the output bin, and then turn the MFP on.
Observe the LED on the output device. If it is
flashing or amber, see the Problem Solving
chapter of this document.

Reinstall Output Device

The output device has been removed or is not
attached.

Make sure the output bin, 3-bin mailbox, or
stapler/stacker is correctly installed on the
MFP.

Remove All Print Cartridges

The MFP is executing a component test and
the component selected is Belt Only.

Remove all print cartridges.

Remove At Least One Print Cartridge

The MFP is executing a disable-cartridge
check or component test where the
component selected is the cartridge motor.

Remove one print cartridge.

Replace <color> Cartridge

The identified print cartridge has reached the
end of life. Printing can continue.

Replace the specified color cartridge.

REPLACE DIMM <X> MEM TEST FAILURE The listed DIMM is not functioning properly
and must be replaced.

Replace the DIMM.

Replace Fuser Kit

Replace the fuser kit.

The fuser is nearing the end of its useful life.
Printing can continue.

1.

Open the right-side covers.

2.

Use the green handle to lift the fuser
cover.

3.

Grasp the purple handles on the fuser
unit.

4.

Remove the old fuser unit from the MFP.

5.

Install the new fuser unit.

6.

Close the top cover.

Replace staple cartridge

The stapler is out of staples.

Replace the staple cartridge.

Replace Supplies

If the device is configured to stop at out and
multiple print cartridges are out, this message
is displayed.

1.

Replace the empty cartridges.

2.

If the message persists, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

The MFP is set to continue printing even
though a print cartridge has reached end of
life.

From the control-panel Home screen, touch
Supplies Status and then touch the
Supplies tab so you can see which supplies
are out. Replace the necessary print
cartridge.

Replace Supplies - Override in use
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Recommended action

Replace Supplies - Using black

A color supply (or supplies) has reached the
out condition and the Color Supply Out
menu item is set to Autocontinue black.

No user input is required for printing to
continue. Printing continues in black.

Replace Transfer Kit

The transfer unit is at end of life. Printing can
continue, but print quality might be reduced.

Replace the transfer kit.
1.

Open the right-side covers.

2.

Lower the transfer unit by pulling
downward on the green handle at the
top of the unit.

3.

Depress the small blue latches located
on either side of the bottom of the
transfer unit and lift the unit out of the
MFP.

4.

Install the new transfer unit.

5.

Close the right-side covers.

Rotating <color> Motor

A component test is in progress; the
component selected is the <color> cartridge
motor.

Press Stop when ready to stop this test.

Rotating Motor - To exit press STOP

The MFP is executing a component test and
the component selected is a motor.

Press Stop when ready to stop this test.

SANITIZING DISK <X>% COMPLETE Do
not power off

The hard disk is being cleaned.

Contact the network administrator.

SCAN FAILURE Press 'Start' to rescan

The scan was unsuccessful and the
document needs to be rescanned.

If necessary, reposition the document to
rescan it, and then press Start.

Size mismatch in tray XX

The media in the listed tray does not match
the size specified for that tray.

1.

Load the correct media.

2.

If the message persists, contact HP
Support at http://www.hp.com/support/
ljcm4730mfp.

SMTP Gateway

The SMTP gateway has exceeded a time out
value.

Verify the e-mail server address. Contact the
network administrator.

The Digital Sending Service at <IP
Address> does not service this MFP.
Contact administrator.

The MFP cannot communicate with the
specified IP address.

Verify the IP address. Contact the network
administrator.

The Digital Sending Service must be
upgraded to support this version of the
MFP firmware. Contact administrator.

The Digital Sending Service is not supported
by the version of the firmware that is currently
installed for the MFP.

Check the firmware version. Contact the
network administrator.

The folder you have entered is not a valid The folder name was entered incorrectly, or
folder.
the folder does not exist.

Re-enter the folder name correctly, or add the
folder.

There might be a document on the glass.
If there is, remove it, then press “Start”.

A digital send or copy job has been performed
from the scanner glass, but the original
document needs to be removed.

Remove the original document from the
scanner glass and press Start.

TOO MANY PAGES IN JOB TO STAPLE

The maximum number of sheets the stapler
can staple is 30.

For print jobs that have more than 30 pages,
staple them manually.

Type Mismatch In Tray <XX>

The specified tray contains a media type that
does not match the configured type.

The specified tray will not be used until this
condition is addressed. Printing can continue
from other trays.
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Table 16-1 Control-panel messages (continued)
Control panel message

Description

Unable to connect

UNABLE TO COPY

To temporarily hide this message in order to
fax or send to e-mail, touch Hide. If this
message persists, contact an HP-authorized
service or support provider. (See the HP
support flyer, or go to http://www.hp.com/
support/ljcm4730mfp.)
The MFP was unable to copy the document.
If this message persists, contact an HPauthorized service or support provider. (See
the HP support flyer, or go to
http://www.hp.com/support/ljcm4730mfp.)

UNABLE TO SEND

Unable to send Fax. Please check fax
configuration.

Recommended action

To temporarily hide this message in order to
fax or send to e-mail, touch IGNORE.

To temporarily hide this message in order to
fax or send to e-mail, touch IGNORE. If this
message persists, contact an HP-authorized
service or support provider. (See the HP
support flyer, or go to http://www.hp.com/
support/ljcm4730mfp.)
The MFP was unable to send the fax.

UNABLE TO SEND JOB

Contact the network administrator.
To temporarily hide this message in order to
fax or send to e-mail, touch IGNORE. If this
message persists, contact an HP-authorized
service or support provider. (See the HP
support flyer, or go to http://www.hp.com/
support/ljcm4730mfp.)

Unauthorized supply in use

The MFP is using a non-HP supply.

If you believe you purchased a genuine HP
supply, go to http://www.hp.com/go/
anticounterfeit. Any printer repair required as
a result of using non-HP or unauthorized
supplies is not covered under warranty. HP
cannot ensure the accuracy or the availability
of certain features.

User name or password is incorrect.
Please re-enter.

The user name or password was typed
incorrectly.

Retype the user name and password.

User Name, Job Name, or PIN is missing.

One or more of the required items has not
been selected or typed.

Select the correct user name and job name,
and type the correct PIN.

238 Chapter 16 Problem solving

ENWW

Jams
Use this illustration to troubleshoot paper jams in the printer. For instructions on clearing paper jams,
see Jams.
NOTE All areas of the MFP that might need to be opened to clear jams are equipped with green
handles.

Figure 16-1 Paper jam locations
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1

ADF access cover

2

ADF input tray

3

ADF output tray

4

Duplexer cover

5

Upper right door

6

Fuser cover

7

Transfer unit

8

Duplex paper path

9

Middle right door

10

Tray 1 (multipurpose tray)

11

Drawer below tray 1
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12

Lower right door

13

Trays 2, 3 and 4

14

Paper path

15

Output area

Jam recovery
This MFP automatically provides jam recovery, a feature that you can use to automatically reprint
jammed pages. The following options are available:
●

Auto — The MFP attempts to reprint jammed pages.

●

Off — The MFP does not attempt to reprint jammed pages.
NOTE During the recovery process, the MFP might reprint several good pages that were printed
before the paper jam occurred. Be sure to remove any duplicated pages.

To improve print speed and increase memory resources, you might want to disable paper jam recovery.
If paper jam recovery is disabled, the pages involved in a jam will not be reprinted.
Disable paper jam recovery
1.

Scroll to and touch Administration.

2.

Touch Device Behavior.

3.

Touch Warning/Error Behavior.

4.

Touch Jam Recovery.

5.

Touch Off.

6.

Touch Save.

240 Chapter 16 Problem solving

ENWW

Clear jams behind the right covers

ENWW

1.

Using the handles, open the covers on the right side of the printer.

2.

If media is present in the upper area, grasp the media by both corners and pull down.
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3.

If media is present in the lower area, grasp the media by both corners and pull up.

NOTE If no media is present at these locations, continue to the next step.
4.

Grasp the green handle on the transfer unit and pull down to open it.

5.

If media is present in the upper area, grasp the media by both corners and pull down.
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6.

If media is present in the lower area, grasp the media by both corners and pull up.

7.

Lift the green handle on the fuser cover to open the cover.

8.

Grasp the purple handles and pull the fuser out. Remove any paper.
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9.

Lift the green handle on the duplexer cover to open it.

10. Remove any jammed paper.

11. Close the transfer unit.
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12. Close the covers on the right side of the printer.

13. If the jam has not cleared, open the drawer below tray 1 and remove any jammed paper.

14. Close the drawer.
15. If the jam still has not cleared, open the lower access door and remove any jammed paper.

16. Close the lower access door. If the jam has cleared, the print job will continue.
17. If the jam is still not cleared and you are printing from tray 1, see Clear jams in tray 2, 3, or 4.
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Clear jams in tray 1
NOTE If the protective insert does not eject properly when the printer is first installed, follow
this procedure to clear the jam.
1.

Perform the steps in Clear jams behind the right covers.

2.

Remove loaded media.

3.

Remove any jammed paper from the tray.

4.

Reload the media.

5.

Verify that the media is located correctly and is not above the fill tabs.

6.

Confirm that the guides are in the correct position.

Clear jams in tray 2, 3, or 4
1.

Perform the steps in Clear jams behind the right covers.

2.

Slide the indicated tray out and remove any jammed paper.

3.

Close the tray. If the jam is cleared, the print job will continue.
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4.

If the paper jam still does not clear, lift the tray and remove it from the MFP. The following diagram
shows an example of removing tray 2.

5.

Remove any paper jam behind the tray. The following diagram shows a possible paper jam behind
tray 2. Remove jams in trays 3 and 4 following the same procedure.

6.

Insert the paper tray.
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Clear jams in the stapler/stacker
1.

Push the release lever on the top of the stapler/stacker.

2.

Slide the stapler/stacker out.

3.

Remove any media between the stapler/stacker and the MFP.

4.

If the jam does not clear, see Clear jams in the output accessory bridge.

To clear staple jams, see Clear staple jams.
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Clear staple jams
Occasionally, staples become jammed in the stapler/stacker. If jobs are not being stapled correctly or
are not being stapled at all, use this procedure to clear staple jams.
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1.

Turn off the MFP.

2.

Press and hold the release button on the top of the stapler/stacker. Pull the stapler/stacker away
from the MFP.

3.

Open the staple cartridge cover.

4.

To remove the staple cartridge, pull up on the green handle and pull out the staple cartridge.

5.

Lift up on the small lever at the back of the staple cartridge.
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6.

Remove the staples that protrude from the staple cartridge.

7.

Close the lever at the back of the staple cartridge. Be sure that it snaps into place.

8.

Reinsert the staple cartridge into the staple-cartridge holder, and push down on the green handle
until it snaps into place.

9.

Close the staple-cartridge cover, and slide the stapler/stacker into the MFP.

Clear jams in the 3-bin mailbox
1.

Push the release button on the top of the 3-bin mailbox.
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2.

Slide the 3-bin mailbox out from the MFP.

3.

Open the cover on the top of the 3-bin mailbox.
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4.

Remove any media inside the cover.

5.

Close the door and remove any media between the MFP and the 3-bin mailbox.
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Clear jams in the output accessory bridge
If a 3-bin mailbox or a stapler/stacker is installed on the MFP, complete the following procedure to clear
a jam in the output accessory bridge.
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1.

Open the cover to the output accessory bridge.

2.

Push down on the green lever, remove any media inside the output accessory bridge, and push
the green lever up.

3.

Close the cover to the output accessory bridge.

4.

If the jam still does not clear, grasp the handle on the output accessory bridge and slide the output
accessory bridge away from the MFP.
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5.

Look for paper on top of the output accessory bridge.

6.

Slide the output accessory bridge back into the MFP.

7.

Slide the 3-bin mailbox or stapler/stacker back into the MFP.

Clear jams in the ADF
1.

Open the ADF cover.

NOTE A plastic sheet is placed on the electrostatic transfer belt to protect it during
shipping. When the MFP is powered up for the first time, the plastic sheet is sent to the
output tray.
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2.

Remove any jammed media.

3.

Close the ADF cover.
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Media-handling problems
Use only media that meets the specifications outlined in the HP LaserJet Printer Family Print Media
Guide.

Printer feeds multiple sheets
Printer feeds multiple sheets
Cause

Solution

The input tray is overfilled.

Remove excess media from the input tray.

Print media is sticking together.

Remove media, flex it, rotate it 180 degrees or flip it over, and
then reload it into the tray.
NOTE Do not fan media. Fanning can cause static
electricity, which can cause media to stick together.

Media does not meet the specifications for this MFP.

Use only media that meets HP media specifications for this
MFP.

Trays are not properly adjusted.

Make sure that the rear media-length guide indicates the
length of media being used.

Printer feeds incorrect page size
Printer feeds incorrect page size
Cause

Solution

The correct size media is not loaded in the input tray.

Load the correct size media in the input tray.

The correct size media is not selected in the software program
or printer driver.

Confirm that the settings in the software program and printer
driver are appropriate, since the software program settings
override the printer driver and control panel settings, and the
printer driver settings override the control panel settings. For
more information, see Select the correct printer driver.

The correct size media for tray 1 is not selected in the MFP
control panel.

From the control panel, select the correct size media for tray
1.

The media size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the rear and width media guides are touching the
paper.

Printer pulls from incorrect tray
Printer pulls from incorrect tray
Cause

Solution

You are using a driver for a different printer. For more
information.

Use a driver for this printer.

The specified tray is empty.

Load media in the specified tray.
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Printer pulls from incorrect tray
Cause

Solution

Tray behavior for the requested tray is set to First in the Tray Change the setting to Exclusively.
Behavior sub-menu of the Device Behavior menu.
The media size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the guides are touching the paper.

Media does not feed automatically
Media does not feed automatically
Cause

Solution

Manual feed is selected in the software program.

Load tray 1 with media, or, if the media is loaded, touch OK.

The correct size media is not loaded.

Load the correct size media.

The input tray is empty.

Load media into the input tray.

Media from a previous jam has not been completely removed.

Open the MFP and remove any media in the paper path.
Closely inspect the fuser area for jams.

The media size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the rear and width media guides are touching the
paper.

Media does not feed from tray 2, 3, or 4
Media does not feed from tray 2, 3, or 4

ENWW

Cause

Solution

The correct size media is not loaded.

Load the correct size media.

The input tray is empty.

Load media in the input tray.

The correct media type for the input tray is not selected in the
MFP control panel.

From the MFP control panel, select the correct media type for
the input tray.

Media from a previous jam has not been completely removed.

Open the MFP and remove any media in the paper path.
Closely inspect the fuser area for jams.

None of the optional trays appear as input tray options.

The optional trays only display as available if they are installed.
Verify that any optional trays are correctly installed. Verify that
the printer driver has been configured to recognize the optional
trays.

An optional tray is incorrectly installed.

Print a configuration page to confirm that the optional tray is
installed. If not, verify that the tray is correctly attached to the
MFP.
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Media does not feed from tray 2, 3, or 4
Cause

Solution

The media size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the media size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the guides are touching the paper.

Transparencies or glossy paper will not feed
Transparencies or glossy paper will not feed
Cause

Solution

The correct media type is not specified in the software or printer
driver.

Verify that the correct media type is selected in the software or
printer driver.

The input tray is overfilled.

Remove excess media from the input tray. Do not load more
than 200 sheets of glossy paper or glossy film, or more than
100 transparencies in tray 2, 3, or 4. Do not exceed the
maximum stack height for tray 1.

Media in another input tray is the same size as the
transparencies, and the MFP is defaulting to the other tray.

Make sure that the input tray containing the transparencies or
glossy paper is selected in the software program or printer
driver. Use the MFP control panel to configure the tray to the
media type loaded.

The tray containing the transparencies or glossy paper is not
configured correctly for type.

Make sure that the input tray containing the transparencies or
glossy paper is selected in the software program or printer
driver. Use the MFP control panel to configure the tray to the
media type loaded.

Transparencies or glossy paper might not meet supported
media specifications.

Use only media that meets the HP media specifications for this
MFP.

Envelopes jam or will not feed in the MFP
Envelopes jam or will not feed in the MFP
Cause

Solution

Envelopes are loaded in an unsupported tray. Only tray 1 can
feed envelopes.

Load envelopes into tray 1.

Envelopes are curled or damaged.

Try using different envelopes. Store envelopes in a controlled
environment.

Envelopes are sealing because the moisture content is too
high.

Try using different envelopes. Store envelopes in a controlled
environment.

Envelope orientation is incorrect.

Verify that the envelope is loaded correctly.

This MFP does not support the envelopes being used.

Refer to the HP LaserJet Printer Family Print Media Guide.

Tray 1 is configured for a size other than envelopes.

Configure tray 1 size for envelopes.
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Output is curled or wrinkled
Output is curled or wrinkled
Cause

Solution

Media does not meet the specifications for this MFP.

Use only media that meets the HP media specifications for this
MFP.

Media is damaged or in poor condition.

Remove media from the input tray and load media that is in
good condition.

Printer is operating in an excessively humid environment.

Verify that the printing environment is within humidity
specifications.

You are printing large, solid-filled areas.

Large, solid-filled areas can cause excessive curl. Try using a
different pattern.

Media used was not stored correctly and might have absorbed
moisture.

Remove media and replace it with media from a fresh,
unopened package.

Media has poorly cut edges.

Remove media, flex it, rotate it 180 degrees or turn it over, and
then reload it into the input tray. Do not fan media. If the
problem persists, replace the media.

The specific media type was not configured for the tray or
selected in the software.

Configure the software for the media (see the software
documentation). Configure the tray for the media, see Load
paper and print media.

Printer will not duplex or duplexes incorrectly
Printer will not duplex or duplexes incorrectly
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Cause

Solution

You are trying to duplex on unsupported media.

Verify that the media is supported for duplex printing.

The printer driver is not set up for duplex printing.

Set up the printer driver to enable duplex printing.

The first page is printing on the back of preprinted forms or
letterhead.

Load preprinted forms and letterhead in tray 1 with the
letterhead or printed side up and the bottom of the page
feeding into the MFP. For tray 2, 3, and 4, load these media
printed side down with the top of the page toward the back of
the MFP.
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Understand accessory lights for the 3-bin mailbox and
stapler/stacker
Light

Explanation and solution

Solid green

●

The accessory is receiving power and is ready.

●

The stapler is low on staples. Stapler Low On Staples appears on the controlpanel display. Fewer than 20 staples remain in the staple cartridge. Replace
the staple cartridge.

●

The number of pages in the job exceeds the 30-page limit for stapling. TOO
MANY PAGES IN JOB TO STAPLE appears on the MFP control-panel display.
For jobs that have more than 30 pages, staple the pages manually.

Solid amber

●

The accessory is experiencing a hardware malfunction. 66.X.X OUTPUT
DEVICE FAILURE appears on the control-panel display.

Blinking amber

●

The accessory has a staple jam. Stapler Jam appears on the control-panel
display.

●

The accessory has a paper jam, or a sheet needs to be removed from the unit,
even if the sheet is not jammed. 13.XX.YY JAM IN TOP OUTPUT BIN appears
on the control-panel display.

●

The bin is full. Stacker Bin Full appears on the control-panel display.

●

The stapler is out of staples. Replace Stapler Cartridge appears on the
control-panel display.

●

The jam-access cover is open. Output paper path open appears on the
control-panel display.

●

The stapler unit is open. Output paper path open appears on the control-panel
display. Make sure the staple-cartridge cover is completely closed.

●

The firmware is corrupt. Corrupt Firmware In External Accessory appears
on the control-panel display.

●

The MFP might be in sleep mode. Press any button on the control panel.

●

The accessory is not receiving power. Turn the MFP power off. Check that the
accessory is properly seated on and connected to the MFP, without any gaps
between the MFP and the accessory. Turn the MFP power on.

●

The accessory might have been disconnected and reconnected while the MFP
power was on. Reinstall Output Device appears on the control-panel display.
Reconnect the cable on the accessory.

●

The job might have stalled between the MFP and the accessory.
Processing... appears on the control-panel display. Turn the MFP power off
and then on.

Off
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Understand lights on the formatter
Three LEDs on the formatter indicate that the MFP is functioning correctly.

1

Heartbeat LED

2

HP Jetdirect LEDs (This LED exists only if HP Jetdirect is installed.)

HP Jetdirect LEDs
The embedded HP Jetdirect print server has two LEDs. The yellow LED indicates network activity, and
the green LED indicates the link status. A blinking yellow LED indicates network traffic. If the green LED
is off, a link has failed.
For link failures, check all of the network cable connections. In addition, you can try to manually configure
the link settings on the embedded print server by using the MFP control-panel menus.
1.

Scroll to and touch Administration.

2.

Touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect or EIO <X> Jetdirect.

5.

Touch Link Speed.

6.

Select the appropriate link speed.

7.

Touch Save.

Heartbeat LED
The heartbeat LED indicates that the formatter is functioning correctly. While the MFP is initializing after
you turn it on, the LED blinks rapidly, and then turns off. When the MFP has finished the initialization
sequence, the heartbeat LED pulses on and off.
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If the heartbeat LED is off, the formatter might have a problem. Contact an HP-authorized service or
support provider. See the HP support flyer, or go to http://www.hp.com/support/ljcm4730mfp.
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Correct print quality and copy quality problems
This section helps you define print quality problems and what to do to correct them. Often print quality
problems can be handled easily by making sure that the MFP is properly maintained, using print media
that meets HP specifications, or running a cleaning page.

Print quality problems associated with media
Some print quality problems arise from use of inappropriate media.
●

Use paper that meets HP paper specifications.

●

The surface of the media is too smooth. Use media that meets HP paper specifications.

●

The printer driver setting might be incorrect. Be sure that you have selected the correct driver setting
for the paper that you are using.

●

The print mode might be set incorrectly, or the paper might not meet recommended specifications.

●

The transparencies you are using are not designed for proper toner adhesion. Use only
transparencies designed for HP Color LaserJet printers.

●

The moisture content of the paper is uneven, too high, or too low. Use paper from a different source
or from an unopened ream of paper.

●

Some areas of the paper reject toner. Use paper from a different source or from an unopened ream
of paper.

●

The letterhead you are using is printed on rough paper. Use a smoother, xerographic paper. If this
solves your problem, consult with the printer of your letterhead to verify that the paper used meets
the specifications for this MFP.

Color printing problems
Printout color error
Table 16-2 Printing black instead of color
cause and solution
Cause

Solution

Color mode is not selected in the software program or printer Select Color mode instead of Grayscale or Monochrome
driver.
mode in the software program or printer driver.
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The correct printer driver is not selected in your software
program.

Select the correct printer driver.

No color appears on the configuration page.

Consult your service representative.

Correct print quality and copy quality problems 263

Incorrect shade
Table 16-3 Incorrect shade
cause and solution
Cause

Solution

The media does not meet the specifications for this MFP.

Use media that meets HP media specifications.

You are operating the MFP in excessively humid conditions.

Verify that the MFP’s environment is within humidity
specifications.

Missing color
Table 16-4 Missing color
cause and solution
Cause

Solution

Defective HP print cartridge.

Replace the cartridge.

A non-HP cartridge might be installed.

Ensure that you are using a genuine HP print cartridge.

Cartridge error
Table 16-5 Inconsistent colors after installing a print cartridge
cause and solution
Cause

Solution

Another print cartridge might be low.

Check the supplies gauge on the control panel or print a
supplies status page.

Print cartridges might be improperly installed.

Verify that each print cartridge is installed properly.

A non-HP cartridge might be installed.

Ensure that you are using a genuine HP print cartridge.

Color match error
Table 16-6 Printed colors do not match screen colors
cause and solution
Cause

Solution

Extremely light screen colors are not being printed.

The software program might interpret extremely light colors as
white. If so, avoid using extremely light colors.

Extremely dark screen colors are being printed in black.

The software program might interpret extremely dark colors as
black. If so, avoid using extremely dark colors.

The colors on the computer screen differ from the MFP output. On the printer driver’s Color Control tab, select Screen
Match.
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Table 16-6 Printed colors do not match screen colors (continued)
cause and solution
Solution

Cause

NOTE Several factors can influence your ability to
match printed colors to those on your screen. These
factors include print media, overhead lighting,
software programs, operating system palettes,
monitors, and video cards and drivers.

Overhead transparency defects
Overhead transparencies might display any of the image quality problems that any other type of media
could display, as well as defects specific to transparencies. In addition, because transparencies are
pliable while in the print path, they are subject to being marked by the media-handling components.
NOTE Allow transparencies to cool at least 30 seconds before handling them.
●

On the printer driver’s Paper tab, select Transparency as the media type. Also, make sure that
the tray is correctly configured for transparencies.

●

Check that the transparencies meet the specifications for this MFP.

●

Handle transparencies by the edges. Skin oil on the surface of transparencies can cause spots
and smudges.

●

Small, random dark areas on the trailing edge of solid fill pages might be caused by transparencies
sticking together in the output bin. Try printing the job in smaller batches.

●

The selected colors are undesirable when printed. Select different colors in the software program
or printer driver.

●

If you are using a reflective overhead projector, use a standard overhead projector instead.

Print quality problems associated with the environment
The MFP is operating in excessively humid or dry conditions. Verify that the printing environment is
within specifications. See Environmental specifications.

Print quality problems associated with jams
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●

Make sure that all media is cleared from the paper path.

●

The MFP recently jammed. Print two to three pages to clean the MFP.

●

The media does not pass through the fuser causing image defects to appear on subsequent
documents. Print two to three pages to clean the MFP. However, if the problem persists see the
next section.

Correct print quality and copy quality problems 265

Print quality troubleshooting pages
The print quality troubleshooting pages provide information on aspects of the MFP that affect print
quality.
1.

Scroll to and touch Administration.

2.

Scroll to and touch Troubleshooting.

3.

Touch PQ Troubleshooting.

4.

Touch Print.

The message Printing... PQ troubleshooting appears on the display until the MFP finishes printing
the print quality troubleshooting information. The MFP returns to the Ready state after printing the print
quality troubleshooting information.
The print quality troubleshooting information includes one page for each color (black, magenta, cyan,
and yellow), MFP statistics related to print quality, instructions on interpreting the information, and
procedures to solve print quality problems.
If following the procedures recommended by the print quality troubleshooting pages do not improve print
quality, go to http://www.hp.com/support/ljcm4730mfp.

Print quality troubleshooting tool
The print quality troubleshooting tool helps you identify and troubleshoot print quality issues for the
HP Color LaserJet CM4730 MFP. The tool includes solutions for many print quality issues, using
standard images to provide a common diagnostic environment. It is designed to provide intuitive, stepby-step directions for printing troubleshooting pages that are used to isolate print quality problems and
provide possible solutions.
To find the print quality troubleshooting tool, go to the following quick URL: http://www.hp.com/go/
printquality/ljcm4730mfp

Image defect examples
Horizontal lines or streaks

Defect description
Horizontal lines or streaks appear on the page.
Possible causes
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The device needs to be cleaned. Operating environment or media in use does not meet HP
specifications.
Troubleshooting and suggestions

ENWW

1.

Make sure that the environmental specifications for the device are being met.

2.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Misaligned color

Defect description
Color does not appear in the correct area on the page.
Possible causes
The device needs to be calibrated.
Troubleshooting and suggestions
Calibrate the MFP.
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Vertical lines

Defect description
Vertical lines appear on the page.
Possible causes
The device needs to be cleaned. Operating environment or media in use does not meet HP
specifications.
Troubleshooting and suggestions
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1.

Make sure that the environmental specifications for the device are being met.

2.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Repetitive defects

Defect description
Defect appear at regular intervals on the page.
Possible causes
The device needs to be cleaned. Operating environment or media in use does not meet HP
specifications.
Troubleshooting and suggestions
1.

Make sure that the environmental specifications for the device are being met.

2.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Color fade in all colors

Defect description
All colors are faded in one or more locations on the page.
Possible causes
The device needs to be calibrated. Operating environment or media in use does not meet HP
specifications.
Troubleshooting and suggestions
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1.

Calibrate the MFP.

2.

Make sure that the environmental specifications for the device are being met.
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Color fade in one color

Defect description
One color is faded in one or more locations on the page.
Possible causes
The device needs to be calibrated. Operating environment or media in use does not meet HP
specifications.
Troubleshooting and suggestions
1.

Make sure that the environmental specifications for the device are being met.

2.

Calibrate the MFP.

3.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Fingerprints and media dents

Defect description
Fingerprints or media dents appear on the page.
Possible causes
Operating environment or media in use does not meet HP specifications. Dents or wrinkles are from
handling.
Troubleshooting and suggestions

ENWW

1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that the media you are using does not have any wrinkles or dents from handling, and
that the media is not contaminated with visible fingerprints or other foreign substances.

3.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Loose toner

Defect description
Toner can be rubbed off the page.
Possible causes
Operating environment or media in use does not meet HP specifications.
Troubleshooting and suggestions
1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that type and quality of the media you are using meet HP specifications.

3.

Make sure that the media type and size for the tray are set correctly in the control panel for the
media that you are using.

4.

Make sure that the media is loaded correctly and that the size guides are touching the edges of
the stack of media.

5.

Make sure that the media you are using does not have any wrinkles or dents from handling, and
that the media is not contaminated with visible fingerprints or other foreign substances.
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Smeared toner

Defect description
Toner smears on the page.
Possible causes
Media in use does not meet HP specifications.
Troubleshooting and suggestions
Make sure that type and quality of the media you are using meet HP specifications.
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White areas on page

Defect description
White areas (dropouts) appear on the page.
Possible causes
Operating environment or media in use does not meet HP specifications.
Troubleshooting and suggestions
1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that type and quality of the media you are using meet HP specifications.

3.

Make sure that the media you are using does not have any wrinkles or dents from handling, and
that the media is not contaminated with visible fingerprints or other foreign substances.

4.

Make sure that the media type and size for the tray are set correctly in the control panel for the
media that you are using.
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Media damage

Defect description
The media has wrinkles, curls, creases, or tears.
Possible causes
Operating environment or media in use does not meet HP specifications. Trays are not configured
properly, or settings are not correct for media in use. There are undetected jams.
Troubleshooting and suggestions
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1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that type and quality of the media you are using meet HP specifications.

3.

Make sure that the media is loaded correctly.

4.

Make sure that the media type and size for the tray are set correctly in the control panel for the
media that you are using.

5.

Make sure that the media you are using does not have any wrinkles or dents from handling, and
that the media is not contaminated with visible fingerprints or other foreign substances.

6.

Make sure that the fuser and transfer belt are seated correctly.

7.

Inspect the jam areas and remove any undetected jammed or torn media.

Correct print quality and copy quality problems 277

Specs or stray toner

Defect description
Toner specs or stray toner appear on the page.
Possible causes
Operating environment or media in use does not meet HP specifications. Trays are not configured
properly, or settings are not correct for media in use. There are undetected jams.
Troubleshooting and suggestions
1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that type and quality of the media you are using meet HP specifications.

3.

Make sure that the media type and size for the tray are set correctly in the control panel for the
media that you are using.

4.

Calibrate the MFP.

5.

Print the Print Quality Troubleshooting Pages and follow the diagnostic procedure listed on the first
page to help isolate the defect to a particular component.
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Skewed, stretched, or off-center page

Defect description
The image is skewed, stretched, or off-center on the page.
Possible causes
Operating environment or media in use does not meet HP specifications. Media is not loaded correctly.
Troubleshooting and suggestions
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1.

Make sure that the environmental specifications for the device are being met.

2.

Make sure that type and quality of the media you are using meet HP specifications.

3.

Make sure that the media is loaded correctly.

4.

For problems with page skew, turn over the stack of media and rotate the stack 180 degrees.

5.

Make sure that the fuser and transfer belt are seated correctly.

6.

Inspect the jam areas and remove any undetected jammed or torn media.

7.

If printing from the multipurpose tray, make sure that the side guides are set correctly.
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Blank page

Defect description
The printed page is blank.
Possible causes
The page was not inserted into the ADF properly. The ADF separation pad is not functioning properly.
Troubleshooting and suggestions
1.

Remove and then reinsert the original page into the ADF, making sure it is placed face-up.

2.

If several pages are feeding at the same time, check the ADF separation pad and rollers for
damage. If the rollers are dirty, clean them. If the ADF separation pad or rollers are worn, replace
them.
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Horizontal lines

Defect description
Horizontal lines appear on the page.
Possible causes
The ADF is dirty. Paper is stuck to the scanner glass or lid. The mylar strip is dirty.
Troubleshooting and suggestions

ENWW

1.

Clean the ADF.

2.

Verify that no paper is on top of the scanner glass or stuck to the bottom of the scanner lid.

3.

If the mylar strip is dirty or worn, replace it. Replacement mylar strips are stored in an envelope
that is underneath the white, vinyl ADF backing. Follow the instructions that are in the envelope.

Correct print quality and copy quality problems 281

Page skew

Defect description
The printing is skewed on the page.
Possible causes
The ADF tray guides are not adjusted properly. The mylar strip is dislodged, folded, misinstalled, or
worn. The ADF rollers are dirty.
Troubleshooting and suggestions
1.

Make sure the ADF input tray guides are adjusted so that they are lightly touching the sides of the
paper stack.

2.

If the mylar strip is dislodged, folded, or misinstalled, verify it is correctly installed. If the mylar strip
is worn, replace it. Replacement mylar strips are stored in an envelope that is underneath the white,
vinyl ADF backing. Follow the instructions that are in the envelope.

3.

Clean the ADF rollers.

4.

If the problem persists, calibrate the scanner.
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Vertical lines

Defect description
Vertical lines appear on the page.
Possible causes
The ADF is dirty. Paper is stuck to the scanner glass or lid. The mylar strip is dirty.
Troubleshooting and suggestions
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1.

Clean the ADF.

2.

Verify that no paper is on top of the scanner glass or stuck to the bottom of the scanner lid.

3.

If the mylar strip is dirty or worn, replace it. Replacement mylar strips are stored in an envelope
that is underneath the white, vinyl ADF backing. Follow the instructions that are in the envelope.
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Image shifted

Defect description
The printed image is shifted horizontally, vertically, or both ways.
Possible causes
The scanner is not calibrated properly.
Troubleshooting and suggestions
Calibrate the scanner.
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Unexpected image

Defect description
The copy does not look like the original document.
Possible causes
There is media on the flatbed glass from a previous copy job.
Troubleshooting and suggestions
Remove any media from the flatbed glass.

Calibrate the MFP
The MFP automatically calibrates and cleans at various times to maintain the highest level of print
quality. The user might also request the MFP to calibrate via the MFP’s control panel, using Quick
Calibration or Full Calibration located in the Print Quality > Calibration/Cleaning menu. Quick
Calibration is used for D-Half color tone calibration. If color density or tone seems wrong, Quick
Calibration can be run. Full Calibration includes the Quick Calibrate routines and adds Drum Phase
Calibration, Color Plane Registration (CPR), and copy parameter calibration routines. If color layers
(black, magenta, cyan, and yellow) on the printed page seem to be shifted from one another, Full
Calibration should be run.
The HP Color LaserJet CM4730 MFP incorporates a new feature to skip calibration when appropriate,
thereby making the MFP available more quickly. For example, if the MFP is powered off and on quickly
(within 20 seconds), calibration is not needed and will be skipped. In this case, the MFP will reach the
ready state approximately one minute sooner.
While the MFP is calibrating and cleaning, the MFP will pause printing for the amount of time it takes to
complete the calibration or cleaning. For most calibrations and cleaning, the MFP will not interrupt a
print job, but will wait for the job to complete before calibrating or cleaning.
1.

Scroll to and touch Administration.

2.

Scroll to and touch Troubleshooting.

3.

Touch Quick Calibration, or touch Full Calibration.

4.

Touch Calibrate.

Repetitive defect ruler
If defects repeat at regular intervals on the page, use this ruler to identify the cause of the defect. Place
the top of the ruler at the first defect. The marking that is beside the next occurrence of the defect
indicates which component needs to be replaced.
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1

First occurrence of the defect (the distance from the top of the page to the defect) might vary.

2

Black print cartridge 34.3 mm (1.35 inches)

3

Print cartridge or transfer roller (if the defect occurs in only one color, the defective part is the print cartridge; if the defect
occurs in all colors, the defective part is the ETB) 37.7 mm (1.48 inches)

4

Cyan, magenta, and yellow print cartridges 38.5 mm (1.52 inches)

5

Print cartridge 42.7 mm (1.68 inches)

6

ETB 75 mm (2.95 inches)

7

Fuser 76.0 mm (2.99 inches)

8

Fuser 81.0 mm (3.19 inches)

9

Print cartridge 94.2 mm (3.71 inches)

To identify if the print cartridge is the problem, insert a print cartridge from another HP Color LaserJet
CM4730 MFP series, if one is available, before ordering a new print cartridge.
If the defect repeats at 94.0 mm (3.75 inch) intervals, try replacing the print cartridge before replacing
the fuser.
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Solve fax problems
For help solving fax problems, go to http://www.hp.com/go/mfpfaxaccessory300.
You can also refer to the Analog Fax Accessory 300 Fax Guide and the Analog Fax Accessory 300
Send Fax Driver Guide, which are included on the MFP software CD.
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Solve e-mail problems
If you are unable to send e-mails by using the digital-send feature, you might need to reconfigure the
SMTP gateway address or the LDAP gateway address. Print a configuration page to find the current
SMTP and LDAP gateway addresses. See Information pages. Use the following procedures to check if
the SMTP and LDAP gateway addresses are valid.

Validate the SMTP gateway address
NOTE This procedure is for Windows operating systems.
1.

Open an MS-DOS command prompt: click Start, click Run, and then type cmd.

2.

Type telnet followed by the SMTP gateway address and then the number 25, which is the port
over which the MFP is communicating. For example, type telnet 123.123.123.123 25 where
"123.123.123.123" represents the SMTP gateway address.

3.

Press Enter. If the SMTP gateway address is not valid, the response contains the message Could
not open connection to the host on port 25: Connect Failed.

4.

If the SMTP gateway address is not valid, contact the network administrator.

Validate the LDAP gateway address
NOTE This procedure is for Windows operating systems.
1.

Open Windows Explorer. In the address bar, type LDAP:// immediately followed by the LDAP
gateway address. For example, type LDAP://12.12.12.12 where "12.12.12.12" represents the
LDAP gateway address.

2.

Press Enter. If the LDAP gateway address is valid, the Find People dialog box opens.

3.

If the LDAP gateway address is not valid, contact the network administrator.
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Solve problems with output accessories
When the 3-bin mailbox or the stapler/stacker is installed correctly with the output accessory bridge, the
LED at the top of the accessory is green. If the LED is off, is blinking, or is amber, a problem exists. See
Understand accessory lights for the 3-bin mailbox and stapler/stacker. For information about clearing
jams, see Jams.
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1

LED for the stapler/stacker

2

LED for the 3-bin mailbox
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Solve network connectivity problems
If the MFP is having problems communicating with the network, use the information in this section to
resolve the problem.

Solve network printing problems
NOTE HP recommends that you use the MFP CD to install and set up the MFP on a network.
●

Make sure that the network cable is securely seated into the MFP's RJ45 connector.

●

Make sure that the Link LED on the formatter is lit. See Understand lights on the formatter.

●

Make sure that the I/O card is ready. Print a configuration page (see Information pages). If an
HP Jetdirect print server is installed, printing a configuration page also prints a second page that
shows the network settings and status.
NOTE The HP Jetdirect print server supports various network protocols (TCP/IP, IPX/
SPX, Novell NetWare, AppleTalk, and DCL/LLC). Make sure that the correct protocols and
network parameters are set correctly.
On the HP Jetdirect configuration page, verify the following items for your protocol:
●

Under HP Jetdirect Configuration, the status is "I/O Card Ready".

●

Protocol status is "Ready".

●

An IP address is listed.

●

The configuration method (Config by:) is listed correctly. See the network administrator if you
are not sure which method is correct.

●

Try printing the job from another computer.

●

To verify that a MFP works with a computer, use a parallel cable to connect it directly to a computer.
You will have to reinstall the printing software. Print a document from a program that has printed
correctly in the past. If this works, a problem with the network might exist.

●

Contact your network administrator for assistance.

Verify communication over the network
If the HP Jetdirect configuration page shows an IP address for the MFP, use this procedure to verify
that you can communicate with the MFP over the network.
1.

Windows: Click Start, click Run, and then type cmd. An MS-DOS command prompt opens.
-orMac: Click Applications, click Utilities, and then open the Terminal application. The terminal
window opens.

2.

Type ping followed by the IP address. For example, type ping XXX.XXX.XXX.XXX where
"XXX.XXX.XXX.XXX" is the IPv4 address that is shown on the HP Jetdirect configuration page. If
the MFP is communicating over the network, the response is a list of replies from the MFP.

290 Chapter 16 Problem solving

ENWW

ENWW

3.

Verify that the IP address is not a duplicate address on the network by using the address resolution
protocol (arp -a) command. At the prompt, type arp -a. Find the IP address in the list and compare
its physical address to the hardware address that is listed on the HP Jetdirect configuration page
in the section called HP Jetdirect Configuration. If the addresses match, all network
communications are valid.

4.

If you cannot verify that the MFP is communicating over the network, contact the network
administrator.
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Solve common Macintosh problems
This section lists problems that can occur when using Mac OS X.
Table 16-7 Problems with Mac OS X
The printer driver is not listed in the Print Center or Printer Setup Utility.
Cause

Solution

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The printer name, IP address, or Rendezvous/Bonjour host name does not appear in the printer list in the Print Center or Printer
Setup Utility.
Cause

Solution

The printer might not be ready.

Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong connection type might be selected.

Make sure that USB, IP Printing, or Rendezvous is selected,
depending on the type of connection that exists between the printer
and the computer.

The wrong printer name, IP address, or Rendezvous/Bonjour host
name is being used.

Print a configuration page in order to check the printer name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.

The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.
Cause

Solution

The printer might not be ready.

Make sure that the cables are connected correctly, the printer is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The printer software might not have been installed or was installed
incorrectly.

Make sure that the printer PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where <lang> is the two-letter language code for
the language that you are using. If necessary, reinstall the software.
See the getting started guide for instructions.
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Table 16-7 Problems with Mac OS X (continued)
The printer driver does not automatically set up your selected printer in the Print Center or Printer Setup Utility.
Cause

Solution

The Postscript Printer Description (PPD) file is corrupt.

Delete the PPD file from the following hard-drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.

A print job was not sent to the printer that you wanted.
Cause

Solution

The print queue might be stopped.

Restart the print queue. Open print monitor and select Start Jobs.

The wrong printer name or IP address is being used. Another printer
with the same or similar name, IP address, or Rendezvous host name
might have received your print job.

Print a configuration page in order to check the printer name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
printer name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

An encapsulated PostScript (EPS) file does not print with the correct fonts.
Cause

Solution

This problem occurs with some programs.

●

Try downloading the fonts that are contained in the EPS file to
the printer before printing.

●

Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.
Cause

Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

When connected with a USB cable, the printer does not appear in the Print Center or Printer Setup Utility after the driver is selected.
Cause

Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting

ENWW

●

Check that your Macintosh supports USB.

●

Verify that your Macintosh operating system is Mac OS X v10.1
or later.

●

Ensure that your Macintosh has the appropriate USB software
from Apple.
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Table 16-7 Problems with Mac OS X (continued)
When connected with a USB cable, the printer does not appear in the Print Center or Printer Setup Utility after the driver is selected.
Cause

Solution
Hardware troubleshooting
●

Check that the printer is turned on.

●

Verify that the USB cable is connected correctly.

●

Check that you are using the appropriate high-speed USB cable.

●

Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

●

Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.
NOTE The iMac keyboard is a nonpowered USB hub.
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Supplies and accessories

This section provides information about ordering parts, supplies, and accessories. Use only parts and
accessories that are specifically designed for this MFP.
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●

Order parts, accessories, and supplies

●

Optional output devices

●

Part numbers

295

Order parts, accessories, and supplies
●

Order directly from HP

●

Order through service or support providers

●

Order directly through the embedded Web server

Order directly from HP
You can obtain the following directly from HP:
●

Replacement parts. To order replacement parts in the U.S. see http://www.hp.com/buy/parts.
Outside the United States, order parts by contacting your local authorized HP service center.

●

Supplies and accessories. To order supplies in the U.S., see http://www.hp.com/go/ljsupplies.
To order supplies worldwide, see http://www.hp.com/ghp/buyonline.html. To order accessories,
see http://www.hp.com/support/ljcm4730mfp.

Order through service or support providers
To order a part or accessory, contact an HP-authorized service or support provider.

Order directly through the embedded Web server
1.

In the Web browser on the computer, type the IP address for the MFP. The MFP status window
appears.

2.

In the Other links area, double-click Order Supplies. This provides a URL from which to purchase
consumables. Supplies information with part numbers and MFP information is provided.

3.

Select the part numbers that you want to order and follow the instructions on the screen.
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Optional output devices

1 Output accessory bridge
2 Stapler/stacker
3 3-bin mailbox

Output accessory bridge
The output accessory bridge is required if a 3-bin mailbox or a stapler/stacker is installed on the MFP.
The output accessory bridge is a pathway between the MFP and the output device. For more information
about installing the output accessory bridge, see the installation guide that comes with the product.

3-bin mailbox
The optional 3-bin mailbox has one bin that stacks up to 500 sheets and two bins that stack up to
100 sheets each, for a total capacity of 700 sheets.
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The 3-bin mailbox has three operating modes:
●

Mailbox mode. The bins can be assigned to a user or to a group of users. All print, copy, and fax
jobs that an assigned user or group of users sends are delivered to the designated bin. Each user
can select the bin in the printer driver or at the control panel.
When the designated bin is full, the MFP stops printing. Printing continues only when you empty
the bin.

●

Stacker mode. The 3-bin mailbox can combine the bins to act as a stacker. It can stack up to
700 sheets of 75 g/m2 (20 lb bond) paper. Jobs are sent to the bottom bin first, then to the middle
bin, and then to the top bin. Print jobs that require more than 500 sheets fill the bottom bin and
continue stacking into the middle and top bins.
When all three bins are full, the MFP stops printing. Printing continues only when you remove paper
from the top bin. The MFP does not resume printing if you remove paper from the bottom bin or
the middle bin before you remove paper from the top bin.
When the 3-bin mailbox is in stacker mode, you cannot designate that a job be sent to a particular
bin.
NOTE Do not remove paper from the top bin and then attempt to put it in place again. This
causes the pages to stack in the incorrect order.

●

Function-separator mode. You can configure the bins to receive jobs that come from a specific
MFP function, such as printed jobs, copy jobs, or faxes. For instance, you can specify that all copy
jobs are sent to the top bin.
The MFP stops functioning when the designated bin is full. Printing, copying, or faxing can continue
only when you empty the bin.

See 3-bin mailbox output bins for information on configuring and using the optional 3–bin mailbox.

Stapler/stacker
The optional stapler/stacker provides automatic stapling and stacking functionality for printed or copied
jobs. See Staple documents for information on configuring and using the optional stapler/stacker.
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Part numbers
Ordering information and availability might change during the life of the MFP.

Accessories
Item

Description

Part number

3-bin mailbox

Provides three output bins that hold a
total of 700 sheets. It is included with the
HP Color LaserJet CM4730fm MFP.

Q7520A

NOTE The 3–bin mailbox
comes with an output accessory
bridge.
500-sheet stapler/stacker

Allows for high-volume output with
automatic job finishing. Staples up to
30 sheets of paper. It is included with the
HP Color LaserJet CM4730fsk MFP.

Q7519A

NOTE The stapler/stacker
comes with an output accessory
bridge.
5,000-staple cartridge

Provides one staple cartridge.

C8091A

HP LaserJet analog fax accessory 300

Provides fax capability for the MFP. This
is included with the HP Color LaserJet
CM4730f MFP, CM4730fsk MFP, and
CM4730fm MFP models.

Q3701A

Item

Description

Part number

HP LaserJet black print cartridge

12,000-page black cartridge

Q6460A

HP LaserJet cyan print cartridge

12,000-page cyan cartridge

Q6461A

HP LaserJet yellow print cartridge

12,000-page yellow cartridge

Q6462A

HP LaserJet magenta print cartridge

12,000-page magenta cartridge

Q6463A

Description

Part number

Print cartridges

Maintenance kits
Item
Image transfer (ETB) kit
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Q7504A

Image fuser kit

110 volt

Q7502A

Image fuser kit

220 volt

Q7503A

ADF mylar maintenance kit

Q4696–67901

ADF maintenance kit

Q5997A

Part numbers 299

Customer replaceable units
Item

Description

Part number

Cassette pick-up roller replacement kit

CB480-67902

Control panel replacement kit

CB480-67901

Formatter replacement kit

CB480-67905

MP pick-up roller kit

CB480-67903

MP pick-up unit replacement kit

CB480-67904

Fax assembly replacement kit

CB480-67906

Memory
Item

Description

Part number

100-pin DDR memory DIMM (dual inline
memory module)

128 MB

Q7721AA

256 MB

Q7722A

512 MB

Q7723A

Item

Description

Part number

Enhanced I/O (EIO) card

HP Jetdirect 635n IPv6/IPsec Print
Server

J7961G

Parallel cable

2 meter IEEE 1284-C cable

C2950A

3 meter IEEE 1284-C cable

C2951A

2-meter standard USB-compatible
device connector

C6518A

Boosts the ability of the MFP to handle
large or complex print jobs.

Cables and interfaces

USB cable
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Hewlett-Packard limited warranty statement
HP PRODUCT

DURATION OF LIMITED WARRANTY

HP LaserJet CM4730 Series MFP

One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials
and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects
during the warranty period, HP will, at its option, either repair or replace products which prove to be defective.
Replacement products may be either new or equivalent in performance to new.
HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase,
for the period specified above, due to defects in material and workmanship when properly installed and used. If
HP receives notice of such defects during the warranty period, HP will replace software which does not execute
its programming instructions due to such defects.
HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a
reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of
the purchase price upon prompt return of the product.
HP products may contain remanufactured parts equivalent to new in performance or may have been subject to
incidental use.
Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b)
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation
outside of the published environmental specifications for the product, or (e) improper site preparation or
maintenance.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or
provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might
not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from
country/region to country/region, state to state, or province to province. HP's limited warranty is valid in any country/
region or locality where HP has a support presence for this product and where HP has marketed this product. The
level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function
of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory
reasons.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR
SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL
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(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR
OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Customer self repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.
Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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HP customer care
Online services
For 24-hour access to information by using a modem or Internet connection
World Wide Web: Updated HP printer software, product and support information, and printer drivers in
several languages can be obtained from http://www.hp.com/support/ljcm4730mfp. (The site is in
English.)
Online troubleshooting tools
HP Instant Support Professional Edition (ISPE) is a suite of Web-based troubleshooting tools for desktop
computing and printing products. ISPE helps you quickly identify, diagnose, and resolve computing and
printing problems. The ISPE tools are available at http://instantsupport.hp.com.
Telephone support
Hewlett-Packard Company provides free telephone support during the warranty period. When you call,
you will be connected to a responsive team that is waiting to help you. For the telephone number for
your country/region, see the flyer that came in the box with the product, or visit http://www.hp.com/
support. Before calling HP, have the following information ready: the product name and serial number,
the date of purchase, and a description of the problem.
You can also find support on the Internet at http://www.hp.com. Click the support & drivers block.
Software utilities, drivers, and electronic information
Go to http://www.hp.com/go/cljcm4730mfp_software. (The site is in English, but printer drivers can be
downloaded in several languages.)
For information over the telephone, see the flyer that came in the box with the MFP.
Fax accessory support
Go to http://www.hp.com/go/mfpfaxaccessory300.
HP direct ordering for accessories or supplies
Order supplies from the following Web sites:
United States: http://www.hp.com/sbso/product/supplies
Canada: http://www.hp.ca/catalog/supplies
Europe: http://www.hp.com/go/supplies
Asia-Pacific: http://www.hp.com/paper/
Order accessories from http://www.hp.com/support/ljcm4730mfp.
To order supplies or accessories over the telephone, call the following numbers:
United States businesses: 800-282-6672
United States small and medium businesses: 800-888-9909
United States home and home offices: 800-752-0900
Canada: 800-387-3154
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To find the phone numbers for other countries/regions, see the flyer that came in the box with the MFP.
HP service information
To locate HP-Authorized Dealers in the United States or Canada, call 800-243-9816 (United States) or
800-387-3867 (Canada). Or, go to http://www.hp.com/go/cposupportguide.
For service for your HP product in other countries/regions, call the customer support number for your
country/region. See the flyer that came in the box with the MFP.
HP service agreements
Call: 800-HPINVENT [800-474-6836 (U.S.)] or 800-268-1221 (Canada).
Out-of-Warranty Service: 800-633-3600.
Extended Service: Call: 800-HPINVENT [800-474-6836 (U.S.)] or 800-268-1221 (Canada). Or, go to
the HP Care Pack Services Web site at http://www.hpexpress-services.com.
HP support and information for Macintosh computers
Visit: http://www.hp.com/go/macosx for Mac OS X support information and HP subscription service for
driver updates.
Visit: http://www.hp.com/go/mac-connect for products designed specifically for the Macintosh user.

ENWW

HP customer care 305

Limited warranty for print cartridges and image drums
This HP Print Cartridge is warranted to be free from defects in materials and workmanship.
This warranty does not apply to print cartridges that (a) have been refilled, refurbished, remanufactured
or tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.
To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP’s option, HP will either replace
products that prove to be defective or refund your purchase price.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Image Fuser Kit and Image Transfer Kit
Limited Warranty Statement
This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.
This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.
To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Availability of support and service
Around the world, HP provides a variety of service and support options for purchase. Availability of these
programs will vary depending upon your location.
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HP maintenance agreements
HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

On-site service agreements
To provide you with the level of support best suited to your needs, HP has on-site service agreements
with three response times:

Priority onsite service
This agreement provides 4-hour service response to your site for calls made during normal HP business
hours.

Next-day onsite service
This agreement provides support by the next working day following a service request. Extended
coverage hours and extended travel beyond HP’s designated service zones are available on most onsite agreements (for additional charges).

Weekly (volume) on-site service
This agreement provides scheduled weekly on-site visits for organizations with many HP products. This
agreement is designated for sites using 25 or more workstation products, including printers, plotters,
computers, and disk drives.
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MFP specifications

This section provides the following specifications:
●

Physical specifications

●

Electrical specifications

●

Acoustic specifications

●

Environmental specifications

Specifications for the Analog Fax Accessory are available in the HP LaserJet Analog Fax Accessory
300 User Guide. An electronic version of this guide is located on the CD that comes with the HP Color
LaserJet CM4730f MFP, HP Color LaserJet CM4730fsk MFP, and HP Color LaserJet CM4730fm
MFP.
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Physical specifications
Table C-1 Product dimensions

1

Product

Height

Depth

Width

Weight1

HP Color LaserJet CM4730 MFP

1153 mm
(45.4 inches)

639 mm
(25.2 inches)

788 mm (31 inches)

124 kg (273 lb)

HP Color LaserJet CM4730f MFP

1153 mm
(45.4 inches)

639 mm
(25.2 inches)

788 mm (31 inches)

124 kg (298 lb)

HP Color LaserJet CM4730fsk MFP

1153 mm
(45.4 inches)

639 mm
(25.2 inches)

1106 mm
(43.5 inches)

136 kg (298 lb)

HP Color LaserJet CM4730fm MFP

1153 mm
(45.4 inches)

639 mm
(25.2 inches)

1106 mm
(43.5 inches)

136 kg (298 lb)

Without print cartridge

Table C-2 Product dimensions, with all doors and trays fully opened
Product

Height

Depth

Width

HP Color LaserJet CM4730 MFP

1580 mm (62.2 inches)

980 mm (38.6 inches)

1160 mm (45.7 inches)

HP Color LaserJet CM4730f MFP

1580 mm (62.2 inches)

980 mm (38.6 inches)

1160 mm (45.7 inches)

HP Color LaserJet CM4730fsk MFP

1580 mm (62.2 inches)

980 mm (38.6 inches)

1588 mm (62.5 inches)

HP Color LaserJet CM4730fm MFP

1580 mm (62.2 inches)

980 mm (38.6 inches)

1588 mm (62.5 inches)
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Electrical specifications
WARNING! Power requirements are based on the country/region where the MFP is sold. Do
not convert operating voltages. This can damage the MFP and void the product warranty.
Table C-3 Power requirements (HP LaserJet CM4730 MFP series)
Specification

110-volt models

230-volt models

Power requirements

100 to 127 volts (± 10%)

220 to 240 volts (± 10%)

50/60 Hz (± 2 Hz)

50/60 Hz (± 2 Hz)

9.0 Amps

4.5 Amps

Rated current

Table C-4 Power consumption HP LaserJet CM4730 MFP series (average, in watts)1, 2

1
2
3

4
5
6

ENWW

Product model

Copying3

Printing3

Ready4

Sleep5, 6

Off

HP Color LaserJet CM4730 MFP

615

604

83

24

0.5

HP Color LaserJet CM4730f MFP

615

604

83

24

0.5

HP Color LaserJet CM4730fsk
MFP

615

604

83

24

0.5

HP Color LaserJet CM4730fm
MFP

640

626

86

25

0.5

Values subject to change. See http://www.hp.com/support/ljcm4730mfp for current information.
Power numbers are the highest values measured using all standard voltages.
HP Color LaserJet CM4730 MFP series printing and copying speeds are 31 ppm Letter size and
30 ppm A4 size.
Heat dissipation in Ready mode = 288 BTU/hour.
Default time from Ready mode to Sleep mode = 45 minutes.
Recovery time from Sleep mode = less than 20 seconds
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Acoustic specifications
Table C-5 Sound power and pressure level1 (HP LaserJet CM4730 MFP series)

1
2

3

Sound power level

Declared per ISO 9296

Printing2

LWAd= 6.7 Bels (A) [67 dB(A)]

Copying3

LWAd= 6.8 Bels (A) [68 dB(A)]

Ready

LWAd= 5.8 Bels (A) [58 dB(A)]

Sound pressure level

Declared per ISO 9296

Printing2

LpAm=50 dB (A)

Copying3

LpAm=52 dB (A)

Ready

LpAm=37 dB (A)

Values subject to change. See http://www.hp.com/support/ljcm4730mfp for current information.
HP Color LaserJet CM4730 MFP series speed is 30 ppm A4 size. Configuration tested (HP Color
LaserJet CM4730 MFP): Base model, simplex printing with A4 paper size.
Configuration tested (HP Color LaserJet CM4730 MFP) Base model, simplex copying from ADF with
A4 paper size.)
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Environmental condition

Recommended

Allowed

Storage/standby

Temperature (MFP and print
cartridge)

17° to 25°C (62.6° to 77°F)

15° to 30°C (59° to 86°F)

-20° to 40°C (-4° to 104°F)

Relative humidity

30% to 70% relative humidity
(RH)

10% to 80% RH

10% to 90%

Altitude

N/A

0 meters (0 feet) to 2600
meters (8530 feet)

N/A
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Compliance with FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.
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Declaration of Conformity
Declaration of Conformity
according to ISO/IEC 17050–1 and EN 17050–1
Manufacturer's Name:
Manufacturer's Address:

Hewlett-Packard Company
DoC#: BOISB-0503–00–rel. 2.0
11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares that the product
Product Name:

HP Color LaserJet CM4730 MFP series

Accessories

Q7521A, Q7522A, Q7523A, BOISB-0308–003)

Regulatory Model Number:2)
Product Options:

BOISB-0503-00
ALL
Toner Cartridges: Q6460A, Q6461A, Q6462A, Q6463A, Q7504A, Q7503A, Q7502A

conforms to the following Product Specifications:
Safety:

IEC 60950-1:2001 / EN60950-1: 2001 + A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC:

CISPR 22:1993 A1+A2 / EN 55022:1994 +A1 +A2 – Class A1,4)
EN 61000-3-2:2000
EN 61000-3-3:1995 + A1:2001
EN 55024:1998+A1:2001 + A2:2003
FCC Title 47 CFR, Part 15 Class A / ICES-003, Issue 4
GB9254-1998, GB17625.1–2003

Supplementary Information:
The product herewith complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage Directive 73/23/EEC, and carries
the CE-Marking accordingly.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).
3) All worldwide modular approvals for analog fax accessory obtained by Hewlett-Packard under the regulatory model number BOISB-0308–
00 incorporate the Multi-Tech Systems MT5634SMI Socket Modem Module.
4) The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a class A
product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate
measures”.
Boise, Idaho , USA
October 17, 2006
For regulatory topics only:
European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe, Herrenberger Straße 140, D-71034 Böblingen, Germany, (FAX: +49-7031-14-3143)
USA Contact:
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Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015, USA,
(Phone: 208-396-6000)
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Environmental product stewardship program
Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves
money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:
http://www.hp.com/hpinfo/globalcitizenship/environment/productdesign/ecolabels.html

Toner consumption
Economode uses significantly less toner, which might extend the life of the print cartridge.

Paper use
This product’s manual/optional automatic duplex feature (two-sided printing) and N-up printing (multiple
pages printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.
HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!
NOTE Use the return label to return original HP LaserJet print cartridges only. Please do not
use this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges
or warranty returns. For information about recycling your HP inkjet cartridges please go to
http://www.hp.com/recycle.
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Return and recycling instructions
United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.
Multiple returns (two to eight cartridges)
1.

Package each HP LaserJet print cartridge in its original box and bag.

2.

Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).

3.

Use a single pre-paid shipping label.

OR
1.

Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2.

Use a single pre-paid shipping label.

Single returns
1.

Package the HP LaserJet print cartridge in its original bag and box.

2.

Place the shipping label on the front of the box.

Shipping
For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Non-US returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product contains a battery that may require special handling at end-of-life.
The battery contained in this product includes:
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Type

Carbon monofluoride lithium battery

Weight

0.8 grams

Location

Formatter board

User removable

No

This product contains mercury in the fluorescent lamp of the control panel liquid crystal display that
might require special handling at end-of-life.
For recycling information you can visit http://www.hp.com/go/recycle or contact your local authorities or
the Electronics Industry Alliance (http://www.eiae.org).

Disposal of waste equipment by users in private households in the
European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.
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For more information
To obtain information about these environmental topics:
●

Product environmental profile sheet for this and many related HP products

●

HP’s commitment to the environment

●

HP’s environmental management system

●

HP’s end-of-life product return and recycling program

●

Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Certificate of volatility
This is a statement regarding the volatility of customer data stored in memory. It also outlines how to
erase secure data from the device.

Types of memory
Volatile memory
The MFP utilizes volatile memory (64MB on the board and 256MB installed, for a total of 320MB) to
store customer data during the printing and copying process. When the MFP is powered off, this volatile
memory is erased.

Non-volatile memory
The MFP utilizes non-volatile memory (EEPROM) to store system control data and user preference
settings. No customer print or copy data is stored in non-volatile memory. This non-volatile memory can
be cleared and restored to factory defaults by performing a Cold Reset or Restore Factory Defaults from
the control panel.

Hard-disk-drive memory
The MFP contains an internal hard disk drive (40GB or larger) that may retain data after the MFP is
powered off. The MFP also may contain additional optional compact flash storage, or an external EIO
hard disk. Data stored in these devices may be from incoming/outgoing fax or email files, stored copy
or print jobs, fax or email address books, or third-party solutions. Some of this data can be erased from
the control panel of the MFP, but most must be erased using the Secure Storage Erase features
available within HP Web Jetadmin. Secure Storage Erase features comply with U.S. Department of
Defense (DOD) specification 5220–22.M.
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Safety statements
Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.
WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.
« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord statement (Japan)

EMI statement (Korea)

EMI statement (Taiwan)
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General telecom statement
The HP Color LaserJet CM4730f, CM4730fsk, and CM4730fm models have the HP LaserJet Analog
Fax Accessory 300 already installed to provide communication to the public switch telephone network
(PSTN) for fax functionality. See the HP LaserJet Analog Fax Accessory 300 User Guide for all
regulatory approval information and regulatory notices associated with the fax functionality and that
device.
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Laser statement for Finland
LASERTURVALLISUUS
LUOKAN 1 LASERLAITE
KLASS 1 LASER APPARAT
HP Color LaserJet CM4730 MFP, CM4730f MFP, CM4730fsk MFP, and CM4730fm MFPlaserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa käytössä
kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle.
Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.
VAROITUS!
Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.
VARNING!
Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren
utsättas för osynlig laserstrålning, som överskrider gränsen för laserklass 1.
HUOLTO
HP Color LaserJet CM4730 MFP, CM4730f MFP, CM4730fsk MFP, and CM4730fm MFPkirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa
ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota
väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa
lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman
erikoistyökaluja.
VARO!
Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömälle lasersäteilylle laitteen
ollessa toiminnassa. Älä katso säteeseen.
VARNING!
Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för
osynlig laserstrålning. Betrakta ej strålen.
Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 785-800 nm
Teho 5 mW
Luokan 3B laser
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Install memory and print server cards

The MFP has two 200-pin DDR SDRAM slots. One slot is filled; a 128 or 256 MB DDR memory module
can be inserted in the open slot.
The MFP also has three flash memory card slots for MFP firmware, fonts, and other solutions.
●

The first flash memory card is reserved for MFP firmware. The slot is marked "Firmware Slot".

●

The two additional flash memory card slots are for font cards or third-party solutions, such as
signatures and personalities. The slots are marked "Slot 2" and "Slot 3."
CAUTION Do not insert a flash memory card that is designed for use with a digital camera. The
MFP does not support photo printing directly from a flash memory card. If you install a cameratype flash memory card, the control panel displays a message asking if you want to reformat the
flash memory card. If you choose to reformat the card, all data on the card will be lost.

You might want to add more memory to the MFP if you print complex graphics or PS documents, or if
you use many downloaded fonts. Additional memory also allows the MFP to print multiple collated copies
at the maximum speed.
NOTE Single in-line memory modules (SIMMs) / dual in-line memory modules (DIMMs) used
on previous HP LaserJet printers are not compatible with the MFP.
Before ordering additional memory, see how much memory is currently installed by printing a
configuration page.
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Install memory and fonts
You can install more memory for the MFP, and you can also install a font card to allow the MFP to print
characters for languages such as Chinese or the Cyrillic alphabet.
CAUTION Static electricity can damage DIMMs. When handling DIMMs, either wear an
antistatic wrist strap, or frequently touch the surface of the DIMM antistatic package and then
touch bare metal on the MFP.

Install DDR memory DIMMs
1.

Turn the MFP off.

2.

Disconnect all power and interface cables.
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3.

Locate the gray formatter pressure release tabs on the formatter board in the rear of the MFP.

4.

Gently squeeze the tabs and pull them out of the formatter.

5.

Gently pull on the black tabs to pull the formatter board from the MFP. Place the formatter board
on a clean, flat, grounded surface.
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6.

To replace a DDR DIMM that is currently installed, spread the latches apart on each side of the
DIMM slot, lift the DDR DIMM up at an angle, and pull it out.

7.

Remove the new DIMM from the antistatic package. Locate the alignment notch on the bottom
edge of the DIMM.

8.

Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle and firmly press the DIMM into the slot until it is fully seated. When installed correctly, the
metal contacts are not visible.
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9.

Push down on the DIMM until both latches engage the DIMM.

NOTE If you have difficulty inserting the DIMM, make sure the notch on the bottom of the
DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure you are
using the correct type of DIMM.
10. Align the formatter board in the tracks at the bottom of the slot, and then slide the board back into
the MFP.
NOTE To prevent damage to the formatter board, ensure the formatter board is aligned in
the tracks.
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11. Reinsert the formatter pressure release tabs by squeezing them together and pushing them into
place.

12. Reconnect the power cable and interface cables, and turn the MFP on.

13. If you installed a memory DIMM, go to Enabling memory.

Install a flash memory card
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CAUTION Do not insert a flash memory card that is designed for use with a digital camera into
the MFP. The MFP does not support photo printing directly from a flash memory card. If you
install a camera-type flash memory card, the control panel displays a message asking if you want
to reformat the flash memory card. If you choose to reformat the card, all data on the card will be
lost.
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1.

Turn the MFP off.

2.

Disconnect all power and interface cables.
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3.

Locate the gray formatter pressure release tabs on the formatter board in the rear of the MFP.

4.

Gently squeeze the tabs and pull them out of the formatter.

5.

Gently pull on the black tabs to pull the formatter board from the MFP. Place the formatter board
on a clean, flat, grounded surface.

336 Appendix E Install memory and print server cards

ENWW

6.

Align the groove on the side of the flash memory card with the notches in the connector and push
it in the slot until it is fully seated.

CAUTION Do not insert the flash memory card at an angle.
NOTE The first flash memory slot marked "Firmware Slot" is reserved for firmware only.
Slots 2 and 3 should be used for all other solutions.
7.

Align the formatter board in the tracks at the top and bottom of the slot, and then slide the board
back into the MFP.
NOTE To prevent damage to the formatter board, ensure the formatter board is aligned in
the tracks.
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8.

Reinsert the formatter pressure release tabs by squeezing them together and pushing them into
place.

9.

Reconnect the power cable and interface cables, and turn the MFP on.

Enabling memory
If you installed a memory DIMM, set the MFP driver to recognize the newly added memory.

Enable memory for Windows 98 and Me
1.

On the Start menu, point to Settings, and click Printers.

2.

Right-click the printer and select Properties.

3.

On the Configure tab, click More.

4.

In the Total Memory field, type or select the total amount of memory that is now installed.

5.

Click OK.
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Enable memory for Windows 2000 and XP

ENWW

1.

On the Start menu, point to Settings, and click Printers or Printers and Faxes.

2.

Right-click the printer and select Properties.

3.

On the Device Settings tab, click Printer Memory (in the Installable Options section).

4.

Select the total amount of memory that is now installed.

5.

Click OK.
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Install an HP Jetdirect or EIO print server card
The HP Color LaserJet CM4730 MFP is equipped with an embedded HP Jetdirect print server port. If
desired, you can install an additional I/O card in the available EIO slot.
1.

Turn the MFP off.

2.

Disconnect all power and interface cables.
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3.

Locate an open EIO slot. Loosen and remove the two retaining screws holding the cover for the
EIO slot, and then remove the cover. You will not need these screws and the cover again. They
can be discarded.

4.

Firmly insert the HP Jetdirect print server card into the EIO slot.

5.

Insert and tighten the retaining screws that came with the print server card.
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6.

Connect the network cable.

7.

Reconnect the power cable, and turn the MFP on.

8.

Print a configuration page. In addition to an MFP configuration page and a Supplies Status page,
an HP Jetdirect configuration page that contains network configuration and status information
should also print.
If it does not print, uninstall and reinstall the print server card to ensure that it is completely seated
in the slot.

9.

Perform one of these steps:
●

Choose the correct port. See the computer or operating system documentation for
instructions.

●

Reinstall the software, choosing the network installation this time.
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Symbols/Numerics
2-sided printing 119, 127
3-bin mailbox
capacity 7
configuring 102
light status 260
models including 4
modes 297
part number 299
reattach error message 236
selecting 101
specifications, physical 311
500-sheet input tray
models including 2
500-sheet trays
insert or close error
message 234
specifications, physical 311
unexpected size or type error
message 229
A
access denied message 232
accessories
lights 260
ordering 296
part numbers 299
accounting hardware 196
acoustic specifications 314
activity log, fax 183
address book, e-mail
deleting addresses 172
address books, e-mail
adding addresses 171
clearing 54
importing 186
LDAP server errors 234
recipient lists 171
recipient lists, creating 171
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address books, e-mail
auto-complete function 170
LDAP support 166
address, printer
Macintosh,
troubleshooting 292
ADF
blank pages 280
capacity 6
cleaning delivery system 213
image shift,
troubleshooting 284
lines on copies 281, 283
maintenance kit 219
sizes supported 169
skewed pages 282
unexpected image,
troubleshooting 285
ADF input tray
locating 9
ADF output bin
capacity 7
selecting 101
Administration menu, control
panel 17
agreements, maintenance 309
AppleTalk setting 84
AppleTalk settings 34
Attention light
locating 14
authentication error
messages 232
autoconfiguration, drivers 64
Automatic Configuration feature,
drivers 65
automatic media sensing 99
automatic two-sided printing path
copying documents 158
AUX connection 7

auxiliary connection
configuration 80
B
billing codes report, fax 183
bins
capacities 7
full, error messages 235
locating 9
reattach error message 236
selecting 101
blank pages
printing 117
blank pages, troubleshooting 280
blocked fax list, printing 183
booklet printing 122
booklet settings
Windows 123
books
copying 162
both sides, copying 158
both sides, printing on
error messages 232, 233
browser requirements
embedded Web server 184
HP Web Jetadmin 190
buffer overflow errors 229
buttons, control panel
locating 14
touchscreen 16
C
cabinet/stand
models including 3
specifications, physical 311
cable, parallel
part number 300
cable, USB
part number 300
calibrating scanner 50, 220
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call report, fax 183
Canadian DOC regulations 325
canceling
copy jobs 164
printing 136
canceling a print request 136
capacity
3-bin mailbox 7
ADF 6
output bins 7
stapler/stacker 7
cartridges
management menu 29
recycling 320
status, viewing with embedded
Web server 185
cartridges, print
error messages 234
Macintosh status 132
ordering 304
part numbers 299
warranty 306
cartridges, staple
empty, stop or continue
settings 134
loading 134
part numbers 299
checking toner level
HP Easy Printer Care
software 208
chosen personality not
available 233
cleaning
about 212, 214
ADF delivery system 213
ADF rollers 214
glass 212
mylar strip 217
outside of MFP 212
touchscreen 212
clock
error message 226
setting 199
collating copies 161
color
adjusting 148
CMYK ink set emulation 144
edge control 148, 151
four-color printing 143
halftone options 149, 150
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HP ImageREt 3600 138
managing options 147, 150
matching 145
neutral grays 149, 151
options 141
Pantone® matching 145
printed vs. monitor 145
printing color samples 146
printing in grayscale 147, 150
sample book matching 145
sRGB 142
using 137
color fade 271, 272
color fade, problem-solving 271,
272
Color tab settings 124, 132,
147, 150
configuration page
Information menu 18
printing 182
configurations, models 2
connectivity
auxiliary 80
network utilities 85
parallel 78
USB 79
connectivity features 7
contracts, maintenance 309
control panel
access denied 232
Administration menu 17
buttons 14
cleaning touchscreen 212
copy-screen 154
E-mail Setup menu 42
e-mail screen 168
Fax Setup menu 39
help 16
Home screen 15
Information menu 18
Initial Setup menu 31
lights 14
locating 9
locking menus 198
Management menu 29
messages, alphabetical
list 226
messages, numerical
list 226
messages, types of 225

Resets menu 54
Send Setup menu 42
Service menu 55
settings 66
Time/Scheduling menu 27
touchscreen buttons 16
troubleshooting 224
controlling print jobs 100
Copitrak devices 196
copying
books 162
canceling 164
collating 161
control-panel navigation 154
error messages 238
features 6, 153
Job Mode 163
multiple originals 163
photos 162
quality, troubleshooting 263
speed specifications 5
two-sided documents 158
cover pages 116, 126
covers, locating 9
crooked pages 282
custom paper sizes 91
custom-size paper settings
Macintosh 126
Windows 116
customer support
embedded Web server
links 187
HP Instant Support Professional
Edition (ISPE) 304
Macintosh 305
maintenance agreements 309
online 304
service dealers 305
telephone 304
D
Data light
locating 14
date, setting 27, 199
Declaration of Conformity 319
default settings
Resets menu 54
defects, repeating 285
delay, sleep 106
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device status
Macintosh Services tab 132
diagnostics
networks 34
digital faxing 180
digital sending
about 165, 169
address books 171
configuring e-mail 166
control-panel settings 168
embedded Web server
settings 186
error messages 233, 234,
237, 238
folders 174
job settings 173
LDAP support 166
loading documents 169
recipient lists 171
sending documents 169
Setup menu 42
SMTP support 166
troubleshooting 224
validating gateway
addresses 288
workflow 175
Digital Sending tab, embedded
Web server 186
DIMMs (dual inline memory
modules)
installing 330
DIMMs (dual inline memory)
part numbers 300
Disk Erase feature 197
DLC/LLC settings 34
Document feeder
error messages 233
document feeder
copying two-sided
documents 158
document feeder kit,
replacing 219
double-sided copying 158
double-sided printing
error messages 232, 233
downloading software 304
drivers
Automatic Configuration 65
downloading 304
Macintosh 305
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Macintosh settings 126
Macintosh,
troubleshooting 292
Services tab 125
settings 66, 67
shortcuts (Macintosh) 126
shortcuts (Windows) 116
supported 62
universal 64
Windows settings 116
duplex printing
binding options 121, 131
control panel settings 120,
129
manual 122, 131
duplex printing accessory
error messages 232, 233
locating 9
specifications, physical 311
duplex-printing accessory
loading 120, 130
duplexing
copying documents 158
duty cycle 5
E
e-mail
about 165, 169
address books 171
configuring 166
embedded Web server
settings 186
error messages 233, 234,
237, 238
LDAP errors 234
sending documents 169
troubleshooting 224
validating gateway
addresses 288
E-mail Setup menu 42
economy settings 106
EIO accessory
settings 31
EIO card
part number 300
EIO cards
buffer overflow 229
errors 232
installing 340
electrical specifications 313

embedded Web server
assigning a password 196
checking toner level 208
Digital Sending tab 186
features 184
Information tab 185
Networking tab 186
opening 184
Other Links tab 187
Settings tab 185
energy specifications 313
Enhanced I/O card
part number 300
enlarging documents 117
envelope feeder
specifications, physical 311
envelopes
jams 258
loading in tray 1 93
environment, specifications 208,
315
Environmental Product
Stewardship Program 320
EPS files, troubleshooting 293
Equitrac devices 196
erasing hard disk 197
Error button, control panel
touchscreen 16
error messages
alphabetical list 226
numerical list 226
types of 225
Ethernet cards 7
European Union, waste
disposal 322
Explorer, versions supported
embedded Web server 184
HP Web Jetadmin 190
Extended Service 305
extended warranty 309
e-mail
address books 171
auto-complete function 170
control-panel settings 168
job settings 173
LDAP support 166
loading documents 169
recipient lists 171
sending documents 169
SMTP support 166
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F
fans, troubleshooting 224
fax accessory
connecting phone line 178
models including 3
part number 299
printing schedule 28
Fax Activity Log
clearing 54
fax reports, printing 18, 183
Fax Setup menu 39
faxing, digital 180
features 2, 5
file directory, printing 182
fingerprints 273
fingerprints, problem-solving 273
firmware, upgrading 202
first page
blank 117
use different paper 116, 126
flash memory card
installing 334
folders
error messages 234
sending to 174
fonts
EPS files, troubleshooting 293
included 6
list, printing 19, 183
Foreign Interface Harness
(FIH) 7, 11, 196
formatter cover, locating 9
formatter lights 261
FTP, sending to 175
function-separator mode, 3-bin
mailbox 298
fuser
error messages 230
G
gateways
configuring 166
error messages 233
testing 167
validating addresses 288
glass
cleaning 212
sizes supported 169
graphical display, control
panel 14
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grayscale printing 147, 150
H
hard disk
erasing 197
heartbeat LED 261
held jobs 108
Help button, control panel
touchscreen 16
help, control panel 16
Home button, control panel
touchscreen 16
Home screen, control panel 15
Horizontal lines 266
horizontal lines, problemsolving 266
HP Easy Printer Care Software
using 188
HP Easy Printer Care software
using 188, 208
HP fraud hotline 207
HP Instant Support Professional
Edition (ISPE) 304
HP Jetdirect print server
configuring 84
error messages 232
firmware updates 205
installing 340
lights 261
models including 2
settings 31
HP Jetdirect print servers
installing 340
HP Printer Utility, Macintosh 70
HP Universal Print Driver 64
HP Web Jetadmin
browsers supported 190
checking toner level 208
downloading 190
firmware updates 204
HP-Authorized Dealers 305
humidity requirements 208, 315
I
I/O configuration
network configuration 81
settings 31
image fuser kit, 110 volt
part number 299

image fuser kit, 220 volt
part number 299
image transfer (ETB) kit
part numbers 299
Information menu 18
information pages 182
Information tab, embedded Web
server 185
Initial Setup menu 31
insert tray error messages 234
install cartridge error
message 234
installers, Windows 86
installing
EIO cards 340
insufficient memory 228, 234
interface ports
included 7
locating 11
internal clock errors 226
Internet Explorer, versions
supported
embedded Web server 184
HP Web Jetadmin 190
Internet fax 180
IP address
changing 81
Macintosh,
troubleshooting 292
IPX/SPX setting 34, 83
ISPE (HP Instant Support
Professional Edition) 304
J
jam-access lever, locating 9
jams
envelopes 258
recovery 240
Japanese VCCI statement 325
Jetadmin
browsers supported 190
downloading 190
firmware updates 204
Jetadmin, HP Web 85
Jetdirect print server
configuring 84
error messages 232
firmware updates 205
installing 340
lights 261
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models including 2
settings 31
Job Mode, copying 163
job storage
accessing 107
features 107
personal 109
proof and hold 108
QuickCopy 110
settings 29
stored 111
K
keys, control panel
locating 14
touchscreen 16
Korean EMI statement 325
L
LAN fax 180
LAN-connector 7
language, control panel 224
languages, printer 6
laser safety statements 325
LDAP servers
connecting to 166
embedded Web server
settings 186
error messages 234
validating gateway
addresses 288
lights
accessories 260
control panel 14
formatter 261
lines, troubleshooting 281, 283
link speed settings 37
links
embedded Web server 187
Linux drivers 62
loading
documents, sizes
supported 169
error messages 234
scanner glass 169
sizes supported 169
staples 134
tray 1 93
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trays 2, 3, 4 94
unexpected size or type error
message 229
loading media
configuring 93
locking
control panel menus 198
loose toner 274
loose toner, problem-solving 274
M
Macintosh
AppleTalk settings 34
driver settings 67, 126
drivers supported 62
drivers, troubleshooting 292
problems,
troubleshooting 292
removing software 71
resize documents 126
software 70
software components 86
support Web sites 305
USB card,
troubleshooting 293
Macintosh driver settings
custom-size paper 126
Services tab 132
watermarks 127
mailbox mode 298
mailbox, 3-bin
capacity 7
configuring 102
light status 260
models including 4
modes 297
part number 299
reattach error message 236
selecting 101
specifications, physical 311
maintenance agreements 305,
309
maintenance kit 299
Management menu 29
Material Safety Data Sheet
(MSDS) 322
Media 87
media
custom-size, Macintosh
settings 126

custom-size, Windows
settings 116
document size, selecting 118
first page 116, 126
loading tray 2 97
loading tray 2, 3, and 4 96
loading tray 2, 3, or 4 94
pages per sheet 118, 127
supported sizes 89
media damage 277
media damage, problemsolving 277
memory
adding 206, 329
autoconfiguration 64
enabling 338
features 5
included 2, 70
insufficient 228, 234
managing 206
part numbers 300
permanent storage error
messages 231
supply errors 226
Menu button 14
menu map
Information menu 18
printing 182
menus, control panel
access denied 232
Administration 17
E-mail Setup 42
Fax Setup 39
Information 18
Initial Setup 31
locking 198
Management 29
Resets 54
Send Setup 42
Service 55
Time/Scheduling 27
messages
alphabetical list 226
numerical list 226
types of 225
misaligned colors 268
misaligned colors, problemsolving 268
models, features 2
monthly duty cycle 5
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multiple pages per sheet 118,
127
mylar strip
cleaning 217
N
n-up printing 118, 127
Netscape Navigator, versions
supported
embedded Web server 184
HP Web Jetadmin 190
Network Folder, scan to 174
Networking tab, embedded Web
server 186
networks
AppleTalk settings 34
configuring 81
configuring gateway
addresses 166
connectivity features 7
default gateway 82
diagnostics 34
disabling DLC/LLC 84
disabling protocols 83
DLC/LLC settings 34
HP Jetdirect print server error
messages 232
installing EIO cards 340
IP address 81
IPX/SPX settings 34
link speed settings 37
print servers included 2
protocol configuration page,
printing 38
security 34
SMTP servers 166
subnet mask 82
TCP/IP parameters 81
TCP/IP settings 31
testing SMTP settings 167
troubleshooting printing 290
validating gateway
addresses 288
noise specifications 314
Novell login required 235
NVRAM errors 231
O
on/off switch, locating 9
online customer support 304
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online help, control panel 16
operating environment
specifications 208, 315
ordering
part numbers for 299
supplies and accessories 296
ordering supplies 304
other links
embedded Web server 187
output bins
capacities 7
full, error messages 235
locating 9
reattach error message 236
selecting 101
output path open error
message 235
output quality
troubleshooting 263
P
pages per minute 5
pages per sheet 118, 127
paper
custom sizes 91
custom-size, Macintosh
settings 126
custom-size, Windows
settings 116
document size, selecting 118
first page 116, 126
load 93
pages per sheet 118, 127
supported sizes 89
paper jams
3–bin mailbox 250
ADF 254
output accessory bridge 253
right covers 241
staple jams 249
stapler/stacker 248
tray 1 246
trays 2, 3, 4 246
parallel configuration 78
parallel port
features 7
locating 11
part numbers
memory 300
print cartridges 299

pausing a print request 136
PCL drivers
universal 64
permanent storage errors 231
personal jobs 109
phone line, connecting fax
accessory 178
phone numbers
ordering supplies 304
service agreements 305
support 304
photos
copying 162
loading 169
physical specifications 311
PINs, personal jobs 109
plastic sheet 254
ports
included 7
locating 11
troubleshooting
Macintosh 293
PostScript Printer Description
(PPD) files
included 70
power
specifications 313
troubleshooting 222
power switch, locating 9
PPDs
included 70
print cartridge
authentication 207
checking toner levels 208
genuine HP 207
life expectancy 208
managing 207
non-HP 207
replacing 211
storing 207
print cartridges
error messages 234
Macintosh status 132
management menu 29
ordering 304
part numbers 299
recycling 320
status, viewing with embedded
Web server 185
warranty 306

ENWW

Print Document On 118
print media
for color printing 140
loading in tray 1 93
print quality
color fade 271, 272
fingerprints 273
horizontal lines 266
loose toner 274
media damage 277
misaligned colors 268
repetitive defects 270
skewed page 279
smeared toner 275
specs 278
troubleshooting 263
vertical lines 269
white areas 276
print server card
installing 340
print tasks 113
printer languages 6
printing
booklets 122
output bin, selecting 101
speed specifications 5
printing from tray 2, 3, or 4 94
priority onsite service 309
priority, settings 66
problem-solving
color fade 271, 272
Error button, control panel
touchscreen 16
fingerprints 273
horizontal lines 266
loose toner 274
media damage 277
messages, types of 225
misaligned colors 268
networks 34
repetitive defects 270
skewed page 279
smeared toner 275
specs 278
vertical lines 269
white areas 276
processor speed 5
product info 1
proof and hold jobs 108
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protocol configuration page,
printing 38
PS Emulation drivers 62

rollers
cleaning ADF 214
ruler, repetitive defect 285

Q
quality
troubleshooting 263

S
safety statements 325
scale documents
Macintosh 126
scaling documents 117
scanner calibration 50, 220
scanner glass
cleaning 212
scanning
speed specifications 5
scanning e-mail
validating gateway
addresses 288
scanning to e-mail
about 165, 169
address books 171
configuring 166
embedded Web server
settings 186
error messages 233, 234,
237, 238
sending documents 169
troubleshooting 224
scanning to e-mail
address books 171
control-panel settings 168
job settings 173
LDAP support 166
loading documents 169
recipient lists 171
sending documents 169
SMTP support 166
scanning to folder 174
scanning to workflow 175
Secure Disk Erase 197
security
disk erase 197
Foreign Interface Harness
(FIH) 196
locking control panel
menus 198
settings 34
security features 7
Send Setup menu 42
Send to Folder 174
Send to Workflow 175

R
Ready light
locating 14
real-time clock 199
reattach output bin error
message 236
recipient lists 171
recycling
HP printing supplies returns and
environmental program 321
reducing documents 117
regulatory statements
Declaration of Conformity 319
environmental product
stewardship program 320
laser statement for
Finland 327
remote firmware update
(RFU) 202
removing Macintosh software 71
repeating defects,
troubleshooting 285
repetitive defects 270
repetitive defects, problemsolving 270
replacing
staple cartridges 134
reset button 14
Resets menu, control panel 54
resize documents
Macintosh 126
resizing documents 117
resolution
specifications 5
troubleshooting quality 263
retention, job
accessing 107
features 107
personal 109
proof and hold 108
QuickCopy 110
stored 111
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sending to e-mail
about 165, 166, 169
address books 171
embedded Web server
settings 186
error messages 233, 234,
237, 238
sending documents 169
troubleshooting 224
validating gateway
addresses 288
sending to e-mail
address books 171
job settings 173
LDAP support 166
loading documents 169
recipient lists 171
sending documents 169
settings 168
SMTP support 166
service
agreements 305, 309
HP-authorized dealers 305
Service menu, control panel 55
Services tab
Macintosh 132
settings
driver shortcuts
(Macintosh) 126
drivers 67
priority 66
shortcuts (Windows) 116
Settings tab, embedded Web
server 185
shortcuts 116
shortcuts (Macintosh) 126
size, media
unexpected, error
message 229
skewed page 279
skewed page, problemsolving 279
skewed pages 282
Sleep button 14
Sleep mode
settings 27, 29
sleep settings
delay 106
power specifications 313
wake time 106
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smeared toner 275
smeared toner, problemsolving 275
SMTP gateways
error messages 237
SMTP servers
configuring gateway
address 166
connecting to 166
testing 167
validating gateway
addresses 288
software
downloading 304
embedded Web server 85
HP Easy Printer Care
software 86
HP Web Jetadmin 85
installing 59
Macintosh 70, 86, 305
settings 66
uninstalling Macintosh 71
Windows 86
space requirements 311
special media
guidelines 92
special paper
guidelines 92
specifications
acoustic 314
electrical 313
features 5
operating environment 208,
315
physical 311
skew 282
specs 278
specs, problem-solving 278
speed dial list, printing 183
speed specifications 5
stacker mode, 3-bin mailbox 298
standard output bin
capacity 7
locating 9
reattach error message 236
selecting 101
staple cartridges
empty, stop or continue
settings 134

loading 134
part numbers 299
staple jams 249
stapler/stacker
capacity 7
empty, stop or continue
settings 134
light status 260
loading staples 134
models including 3
part number 299
reattach error message 236
selecting 101
specifications, physical 311
stapling 133
too many pages error
message 237
stapling 133
Start button 14
Start button, control panel
touchscreen 16
status
Home screen, control
panel 15
Information tab, embedded Web
server 185
lights 260
Macintosh services tab 132
messages, types of 225
Status button 14
Stop button 14
Stop button, control panel
touchscreen 16
stopping a print request 136
storage cabinet
models including 3
specifications, physical 311
storage, job
accessing 107
features 107
personal 109
proof and hold 108
QuickCopy 110
settings 29
stored 111
stored jobs 111
subnet mask 82
supplies
locating 210
management menu 29
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memory errors 226
ordering 296, 304
part numbers 299
recycling 320
replacement intervals 210
replacing 210
Resets menu 54
status page, printing 182
status, viewing with embedded
Web server 185
supply-status, Services tab
Macintosh 132
support
embedded Web server
links 187
HP Instant Support Professional
Edition (ISPE) 304
Macintosh 305
maintenance agreements 309
online 304
service dealers 305
telephone 304
supported media 89
system requirements
embedded Web server 184
HP Web Jetadmin 190
T
Taiwan EMI statement 325
TCP/IP settings 31
technical support
embedded Web server
links 187
HP Instant Support Professional
Edition (ISPE) 304
Macintosh 305
maintenance agreements 309
online 304
service dealers 305
telephone 304
telephone numbers
ordering supplies 304
service agreements 305
support 304
temperature
requirements 208
temperature requirements 315
tests
networks 34
time, setting 27, 199
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Time/Scheduling menu, control
panel 27
timeout settings 31
top cover
locating 9
touchscreen, cleaning 212
tray 1
insert or close error
message 234
load error message 234
locating 9
unexpected size or type error
message 229
trays
automatic media sensing 99
configure 98
double-sided printing 131
included 2
insert or close error
message 234
load 93
specifications, physical 311
unexpected size or type error
message 229
troubleshooting
accessories 260
ADF output quality 280
blank pages 280
checklist 222
color printing problems 263
control panel 224
control panel messages,
numerical 226
digital sending 224
duplexing 259
EPS files 293
error messages, alphabetical
list 226
error messages, numerical
list 226
gateway addresses 288
lines 281, 283
Macintosh problems 292
media handling problems 256
network printing 290
overhead transparencies 265
quality 263
repeating defects 285
skewed pages 282
transparencies 258

TrueType fonts included 6
two-sided copying 158
two-sided printing
control panel settings 120,
129
error messages 232, 233
typefaces
included 6
U
unable to connect, copy, or
send 238
unexpected size or type error
messages 229
uninstalling Macintosh
software 71
universal print driver 64
upgrading firmware 202
usage page, printing 182
USB configuration 79
USB port
troubleshooting
Macintosh 293
Use different paper/covers 116
V
validating gateway
addresses 288
vertical lines 269
vertical lines, problemsolving 269
voltage specifications 313
voltage, troubleshooting 224
W
wake time, setting 27, 106
Warning button, control panel
touchscreen 16
warranty
Customer self repair 303
extended 305, 309
print cartridge 306
product 301
watermarks 117, 127
Web browser requirements
embedded Web server 184
Web Jetadmin
browsers supported 190
downloading 190
firmware updates 204
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Web sites
customer support 304
downloading software 304
HP Web Jetadmin,
downloading 190
Linux support 62
Macintosh support 305
Material Safety Data Sheet
(MSDS) 322
ordering supplies 296, 304
service agreements 305
universal print driver 64
white areas 276
white areas, problem-solving 276
Windows
driver settings 67, 116
drivers supported 62
software components 86
universal print driver 64
Windows 2000 fax 180
Windows driver settings
booklets 123
custom-size paper 116
workflow, send to 175
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